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Chapter 1. About Sterling External Authentication Server

IBM® Sterling External Authentication Server allows you to implement extended
authentication and validation services for IBM products, called client applications.
Sterling External Authentication Server includes a server that client applications
connect to and a GUI to configure Sterling External Authentication Server
requirements.

For SSL or TLS authentication, the connection between Sterling External
Authentication Server and the client application is authenticated. Then, the client
application sends a request with a certificate chain and/or a user ID and
password. Sterling External Authentication Server uses the certificate validation or
authentication definition referenced in the request to perform the requested
operations.

For SSH authentication, the client application sends a request to Sterling External
Authentication Server that contains a profile name, user ID, or SSH public key.
Sterling External Authentication Server uses the configuration information in the
profile to bind to an LDAP directory and look up the SSH key assigned to the user.
It also performs an attribute assertion to match the key provided against the list of
keys found in the LDAP directory.

After you install Sterling External Authentication Server, configure it for operation
in your environment. Sterling External Authentication Server supports a flexible
configuration to meet a variety of certificate validation and user authentication and
authorization needs. You can configure:
v TCP ports (listeners)
v SSL/TLS protocol operation
v System-wide server connections
v Logging operation
v Other global system parameters

After you configure the system, create certificate validation and user authentication
definitions.
v A certificate validation definition specifies validation of certificates against

certificate revocation lists (CRLs) and allows validation using attribute queries
and assertions. It can include validation using a custom exit to a Java™ class or
an operating system command (for running a program or script).

v Authentication definitions configure multifactor authentication using SSL client
certificates, SSH keys, user IDs and passwords, client IP addresses, and RSA
SecurID as factors. They also enable application outputs to allow you to map
attributes, such as login credentials that are returned to a query, to outputs you
specify.

Sterling External Authentication Server Operation
Sterling External Authentication Server responds to a request from a client
application and performs certificate validation and user authentication.

© Copyright IBM Corp. 2005, 2013 1



Certificate Validation Steps
The following diagram illustrates interaction between a client application, Sterling
External Authentication Server, and directories in the LDAP server, followed by an
explanation of the steps:

Step Description

1 A client application sends a request to Sterling External Authentication Server and
a certificate chain from a user connected to it. The client authenticates itself to
Sterling External Authentication Server and specifies the certificate validation (CV).
If the connection is made, mutual authentication and encryption secure messages
through the connection.

2 The CV definition specified by the client application performs validation steps.
The definition can include LDAP server connection definitions, certificate
revocation list (CRL) definitions, attribute query definitions, and attribute assertion
definitions. If a custom exit is defined, a Java class or operating system command
validates a certificate.

3 For definitions that include attribute queries and CRL definitions, Sterling External
Authentication Server connects to the LDAP server to download CRLs, verify
certificate subject and group entries, or perform attribute queries.

4 Sterling External Authentication Server verifies attribute query results, attributes
from the end-user certificate, and requested data specified in the CV definition.

5 Sterling External Authentication Server sends a response message to indicate the
success or failure of a CV.

User Authentication and Authorization Steps
The following diagram illustrates interaction between a client application, Sterling
External Authentication Server components, and directories accessed through
LDAP servers, followed by an explanation of the steps. End users connect securely
to the application that acts as a client to Sterling External Authentication Server.
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Step Description

1 A client application sends a user ID and password to Sterling External
Authentication Server, from a user logging in to an application or accessing a
destination service. The client authenticates itself to Sterling External Authentication
Server and specifies the definitions. If the connection is made, mutual
authentication and encryption secure messages through the connection.

2 Sterling External Authentication Server references the authentication definition
specified by the client application. It includes the LDAP connection definitions,
attribute query definitions, attribute assertion definitions, and/or application output
definitions required to authenticate and/or authorize the connection.

3 Sterling External Authentication Server connects to the LDAP server specified in the
authentication definition. The user ID and password from the request is validated
and tasks, such as LDAP attribute queries and assertions, are performed to respond
to the request. For example, attribute query definitions can include information to
locate a user ID entry, validate group membership, and look up login credentials.

4 Sterling External Authentication Server uses results to determine if the user should
be authenticated to an application or authorized for access to a destination service.
When Sterling External Authentication Server authenticates a user as a continuation
of certificate validation, information established during certificate validation are
available for authentication.

5 An authentication definition can include application output definitions to specify
how return attributes from a query map to outputs that are passed to the client
application. When an application output definition is included, the mapping of
return attributes is performed.

6 Sterling External Authentication Server sends a response with the results of user
authentication. If authentication is successful, the response can include credentials.
For example, Sterling External Authentication Server can provide the user ID and
password returned from a query in an application output definition as part of the
response message.

7 If the client application is a proxy for the destination service, it logs in to the
destination service with the credentials retrieved by Sterling External Authentication
Server.

Chapter 1. About Sterling External Authentication Server 3



Interaction with Sterling Secure Proxy and Sterling Connect:Direct
Secure Plus

Sterling External Authentication Server enhances the security of IBM Sterling
Secure Proxy and IBM Sterling Connect:Direct® Secure Plus. For example, Sterling
External Authentication Server can extract data from the certificate chain and use
the CV definition to connect to an LDAP server. It then can validate the certificate
subject and determine that a digital certificate has not been revoked. Sterling
External Authentication Server uses authentication definitions to authenticate and
authorize users. After receiving an authentication or authorization request, Sterling
External Authentication Server can access an LDAP directory to determine that a
user ID and password are valid to access a destination service or application.

The server component of the Sterling External Authentication Server application
receives and performs processing requests from Sterling Secure Proxy to validate
certificates and authenticate users, in LDAP or Active Directory; it validates
certificates for Sterling Connect:Direct Secure Plus client requests. The server
accepts requests on a secure and nonsecure listener port. All SSL/TLS connections
are established through the secure listener port. The nonsecure port is used for
testing, or when Sterling External Authentication Server is installed behind the
DMZ and the connection request originates from a client that is deployed in the
trusted zone of your network. The nonsecure port can be disabled after the secure
port is set up.

In a typical scenario, Sterling Secure Proxy establishes a secure session with
Sterling External Authentication Server to validate the identity of an external client
attempting to connect to a Web application, destination service, or a Sterling
Connect:Direct node using a proxy connection and to validate that the connection
is authorized. Based on whether the Sterling Secure Proxy client references a CV
definition (referred to as profile in the Sterling Secure Proxy application) or an
authentication definition, the server initiates a secure client connection to an LDAP
server and queries the directory to verify any or all of the following information
specified for the proxy connection:
v The digital certificate presented belongs to an organization listed in the LDAP

directory, has not expired or been revoked, and has a valid signature.
v The certificate contains specific X.509 v3 extensions.
v The key meets minimum length requirements.
v The password and login ID of the connecting user match the UID attribute

specified for the user account on the LDAP server.
v Attribute queries or attribute assertions defined in the definition referenced in

the request can be validated using information stored in the LDAP directory.
v The originating IP address of the connection request is valid for initiating a

proxy connection and that the client connection to Sterling Secure Proxy actually
originated from an IP address valid for the organization.

If Sterling External Authentication Server confirms that the credentials and
documents submitted for verification are valid, it returns a success message to the
Sterling Secure Proxy client and Sterling Secure Proxy completes the connection
request; otherwise, the connection fails.

Sterling Connect:Direct Secure Plus can initiate a connection to Sterling External
Authentication Server to request extended CV functions. Either the Sterling
Connect:Direct PNODE or SNODE negotiating the session can initiate a direct
connection to Sterling External Authentication Server, if Sterling External
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Authentication Server has a remote node record defined in the Sterling
Connect:Direct Secure Plus parameters file of the node. See the IBM Sterling
Connect:Direct Secure Plus Implementation Guide for your platform for instructions.

Definition Configuration with the Sterling External Authentication
Server GUI

Use the Sterling External Authentication Server GUI to configure how to process a
request from Sterling Connect:Direct Secure Plus or Sterling Secure Proxy.

File Naming Guidelines
Definition names can be up to 255 alphanumeric characters, and can include space,
underscore (_), and period (.). They cannot begin or end with a space. Sterling
External Authentication Server discards names that begin or end with a space. The
following examples demonstrate valid use of special characters in definition
names:
v Routing Names
v corpnet.ldap.home_server234
v Cert_Subject_Romuli8Query

Administration and Navigation from the GUI
After creating a definition, you can edit, copy, and delete the definition, or
definitions that comprise it. The following icons direct your progress as you create
or change definitions:

Button Description

+ Add a definition or component.

- Delete the selected definition or component from the list.

Copy the definition or components listed on the screen above the icon.

Review or change properties of the definition or component. For an
authentication or CV definition, clicking this button displays a tabbed list of
components or areas of functionality.

Display help.

Display a dialog box for entering related details, such as property name and
value pairs, for JNDI properties or for the match attributes used with an attribute
query.

Security Terms
Following are security terms used in Sterling External Authentication Server:
v Self-signed certificate—Digital document that is signed and authenticated by its

owner. Its authenticity is not validated by the digital signature and trusted key
of a third-party certificate authority (CA). To use self-signed certificates,
exchange certificates with all trading partners.

v Simple authentication—Authentication by sending the fully-qualified DN and
clear-text password of the user. Simple authentication can be used on an
encrypted channel.
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v CA-Signed certificate—Digital document issued by a certificate authority (CA)
that binds a public key to the identity of the certificate owner for authentication.
An identity certificate issued by a CA is digitally signed with its private key.

v Certificate Authority (CA)—An organization that issues digitally-signed X.509
certificates. The CA authenticates the certificate owner identity and services they
are authorized to use, issues new certificates, renews certificates, and revokes
certificates that are no longer authorized. The CA digital signature is assurance
that anybody who trusts the certificate signed by the CA can also trust that the
certificate is a representation of the certificate owner.

v Certificate Signing Request (CSR)—Message sent from an applicant to a CA to
apply for a CA-signed certificate. Before creating a CSR, you first generate a key
pair, keeping the private key secret. The CSR contains information that identifies
the applicant (such as a distinguished name in the case of an X.509 certificate)
and the public key chosen by the applicant.

v Certificate chain—An ordered list of certificates containing an end-user
subscriber certificate and issuing authority certificates. Sterling External
Authentication Server uses each certificate in the chain to identify the
subsequent certificate and checks the trust store for any missing certificates.

v Certificate Revocation List (CRL)—List of certificates that have been suspended
or revoked before the expiration date. A CRL defines the CRL issuers name, date
of issue, when the CRL will be reissued, serial numbers of revoked or suspended
certificates, and times and reasons certificates were revoked or suspended.

v Distinguished Name (DN)—Unique name for a directory entry that includes the
list of names of parent entries back to the root for the directory.

v Public key—Public part of a complementary public-private key pair. The
asymmetric cipher of the public key encrypts data for the session key that is
exchanged between server and client during negotiation for an SSL/TLS session.
In Sterling External Authentication Server, public keys are always associated
with a subject name in the form of a certificate in a Java key store.

v Private key—Private part of a complementary public-private key pair. The
asymmetric cipher of the private key is used to decrypt data that is encrypted
with its public key. Data that is encrypted with a public key can only be
decrypted using its private key. The private key is never transmitted. In Sterling
External Authentication Server, a public-private key pair is always created
directly into a Java key store; the private key never leaves the key store.

v Session key—Asymmetric cipher used by the client and server to encrypt data. It
is generated by the SSL software.

v Trusted root key—Digitally signed public key of the CA, used to validate the
public key received during a SSL/TLS session is signed by the CA to verify the
identity of the client.

v Keystore—File that contains the private keys and matching key certificates
Sterling External Authentication Server uses for SSL and TLS sessions. Each
key/certificate pair in the keystore has an associated alias. The secure listener
and connection definitions use the alias to reference the key/certificate.

v Trust store—The trust store includes the following digital certificates:
– Trusted CA or self-signed certificates of the client applications Sterling

External Authentication Server communicates with over the secure listener
– Trusted CA or self-signed certificates of the secure servers Sterling External

Authentication Server communicates with, including HTTPS, LDAPS, and
LDAP v3 Start TLS

– Trusted CA certificates needed by the Certificate Validation Service when
validating requests from client applications
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v Principal—Name that identifies a user or service and the name Sterling External
Authentication Server needs to authenticate. Principal can also refer to the name
Sterling External Authentication Server uses when authenticating to another
server. For example, Sterling External Authentication Server uses a principal to
authenticate to an LDAP server to search for a user entry.
Requests from client applications reference the name assigned to a CV definition
or an authentication definition in Sterling External Authentication Server. For
example, Sterling Secure Proxy uses a profile name that must exactly match the
name of the CV definition; because Proxy_User_CertVal is the name of the
profile in Sterling Secure Proxy, Sterling External Authentication Server uses the
CV definition Proxy_User_CertVal to process the CV request from Sterling
Secure Proxy. An Sterling External Authentication Server definition can process
requests from multiple client applications.

v LDAP—Lightweight Directory Access Protocol. An open industry standard that
defines a set of rules for the messages used by directory clients and directory
servers. LDAP is used to locally or remotely access and update information in a
directory. Sterling External Authentication Server can operate as a client of an
LDAP directory as it provides a requested service, performing actions such as
authenticating user credentials, validating the certificate subject or checking for
the certificate in a list of certificates revoked before expiration.

v Certificate Validation (CV) Definitions and Authentication Definitions—Sterling
External Authentication Server uses definitions you create to process requests to
validate certificates and authenticate or authorize users. Certificate validation
(CV) definitions are configuration files that define how Sterling External
Authentication Server validates certificates. Authentication definitions are
configuration files that define how Sterling External Authentication Server
authenticates users and verifies authorization to access an application or
destination service.
Requests from client applications reference the name assigned to a CV definition
or an authentication definition in Sterling External Authentication Server. For
example, Sterling Secure Proxy uses a profile name that must exactly match the
name of the CV definition; because Proxy_User_CertVal is the name of the
profile in Sterling Secure Proxy, Sterling External Authentication Server uses the
CV definition Proxy_User_CertVal to process the CV request from Sterling
Secure Proxy. An Sterling External Authentication Server definition can process
requests from multiple client applications.

Elements of CV Definitions
v A certificate validation (CV) definition specifies how to validate a digital

certificate presented by a client application on behalf of an end user. It can
include the following optional elements:

v Attribute query definition—Specifies an LDAP search operation to locate
directory entries and optionally return attributes from those entries. The search
must succeed for certificate validation to succeed. The query is composed by
specifying all query parameters in a Uniform Resource Locator (URL), or by
specifying parameters individually on the Query Parameters screen. Attribute
query definitions can include variables as described in CV and Authentication
Definition Variables.

v Attribute assertion definition—Specifies a Boolean statement that must evaluate
as true in order for certificate validation to succeed. Attribute assertions allow
the specification of additional conditions and can compare details from the
request (such as an IP address or attributes from a certificate) to fixed data or to
attributes returned from queries.
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v Attribute assertion definitions can include variables as described in CV and
Authentication Definition Variables.
Custom exit—Specifies details for exiting from an Sterling External
Authentication Server or authentication definition to perform related tasks using
a Java class running an operating system command.

v Certificate revocation list (CRL) definition—Specifies how to access the list of
certificates that have been suspended or revoked before the scheduled expiration
date. After creating a CRL definition, the defined CRLs can be referenced to
check them during certificate validation. A CRL defines the CRL issuer's name,
date of issue, date that the CRL is next scheduled to be reissued, the serial
numbers of revoked or suspended certificates, and the number of times and
reasons certificates were revoked or suspended. When Sterling External
Authentication Server is validating a certificate, if that certificate is found on a
CRL, certificate validation fails. Certificate revocation list definitions can be
created independently of the CV definition and referenced in multiple CV
definitions.

v Supported extensions—Defines processing instructions for the set of X.509 v3
extensions directly supported for Sterling External Authentication Server.

v Custom extensions—Registers and defines processing instructions for X.509 v3
extensions that are unknown to Sterling External Authentication Server.

When you create a CV definition, you can configure optional elements within it.
You can also add optional elements later. For more information on configuring and
adding optional elements at a later time, see Creation and Management of
Certificate Validation (CV) Definitions to Validate Certificates.

Elements of Authentication Definitions
An authentication definition specifies how Sterling External Authentication Server
authenticates a user of a destination service. The authentication definition specifies
how to use attributes associated with the user specified in a request. In particular,
it specifies a user ID and password to use to authenticate and optionally authorize
the user. An authentication definition can include the following optional elements:
v Attribute query—Specifies an LDAP search to locate directory entries and

returning attributes from those entries. The search must succeed for
authentication to succeed. Create the query by specifying query parameters in a
Uniform Resource Locator (URL), or by specifying parameters on the Query
Parameters screen. Attribute query definitions can include variables as described
in CV and Authentication Definition Variables.

v Attribute assertion—Specifies a Boolean statement that must evaluate as true for
authentication to succeed. Attribute assertions allow the specification of
additional conditions and compare details from the request, such as a user ID or
destination service, to fixed data or to attributes returned from queries. Attribute
assertion definitions can include variables as described in CV and Authentication
Definition Variables.

v Applications outputs—Enables use of a directory object with an attribute query
to map the query return attributes to an output name known by the client
application. This is used to look up login credentials to pass to the client
application, to log in to the destination service.

v Custom exit—Specifies details for exiting from a Sterling External Authentication
Server generic authentication definition to perform related tasks using a Java
class or a script or program executed by running an operating system command.
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An authentication definition authenticates users by accessing an LDAP server, a
Tivoli® Access Manager authorization server, or a generic authentication
configuration you customize with a custom exit, attribute query, or attribute
assertion. Within an authentication definition you can create any or none of the
optional elements. For more information on authentication definitions, see Creation
and Management of LDAP Authentication Definitions, Generic Authentication
Definitions, or Creation and Management of Tivoli Access Manager (TAM)
Authentication Definitions.

Prerequisite Tasks for Secure Connection Establishment
As a prerequisite to establishing secure communications sessions using the Secure
Sockets Layer (SSL) protocol or the Transport Layer Security (TLS) protocol
between the entities that Sterling External Authentication Server communicates
with as server and as client, your security administrator should determine whether
your security policy requires using self-signed certificates, CA-issued certificates, or
a combination of both.

Refer to the following lists for a summary of the tasks related to using self-signed
and CA-issued X.509 digital certificates. See System Certificate Creation and
Management, for instructions on generating and storing both types of certificates
using the keytool utility.

Tasks Required for CA-Issued Certificate Usage
To use certificates issued by a certificate authority, you must complete the
following tasks:
v Generate your public-private key pair directly into the keystore of Sterling

External Authentication Server or the GUI.
v Generate the certificate signing request (CSR), which contains your public key,

and submit it to your certificate authority (CA) for authentication.
v Import the certificate issued by the CA into the server or GUI keystore.
v Provide the CA root certificate (the digitally signed public key of the CA) to

your communication peers.
v Import the CA root certificate, or import copies of the X.509 digital certificates

containing the public key and digital signature of all the entities that Sterling
External Authentication Server communicates with as server and as client in the
server trust store, if you are using self-signed certificates.

v To establish a secure connection to Sterling External Authentication Server from
the GUI when it is running on a remote computer, you must complete all the
procedures listed here for using CA-issued certificates for both the GUI and the
server.

Tasks Required for Self-Signed Certificate Usage
To use self-signed certificates, you must complete the following tasks:
v Generate your public-private key pair directly into the keystore of Sterling

External Authentication Server or the GUI.
v Export the Sterling External Authentication Server self-signed certificate to a file

and distribute a copy to all entities that Sterling External Authentication Server
communicates with as server and as client.

v Store copies of the X.509 digital certificates containing the public key and digital
signature of all the entities that Sterling External Authentication Server
communicates with as server and as client in the server trust store, or import the
CA root certificate.
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v To establish a secure connection to Sterling External Authentication Server from
the GUI when it is running on a remote computer, you must complete all the
procedures listed here for using self-signed certificates for both the GUI and the
server.

v Certificate Validation Steps
v User Authentication and Authorization Steps

10 Sterling External Authentication Server: Implementation Guide



Chapter 2. System Resources Configuration

After you install Sterling External Authentication Server, configure the system.

Configure a Listener Port

Modifying the Non-Secure Listener Port
About this task

The non-secure listener defines how a client application connects to Sterling
External Authentication Server without requiring a certificate for an SSL or TLS
handshake. The non-secure listener port is configured initially during installation.

To change the non-secure listener port:

Procedure
1. From the Manage menu, select System Settings.
2. Click the Listeners tab.
3. In the Non-Secure Listener section, specify the following parameters:

v IP Address
v Port
v Enabled

4. Click OK.

Disabling the Non-Secure Listener Port
After you set up the secure listener port, you can disable the non-secure listener.

About this task

To disable the non-secure listener port:

Procedure
1. From the Manage menu, select System Settings.
2. From the Listener tab, disable the Enabled box.
3. Click OK.

Changing the Port Number of the Servlet Container
About this task

You may require the use of a different port number for the servlet container
specified at installation. To change the port number, edit two XML files. XML files
are in Unicode format with UTF-8 encoding (backwards compatible with ASCII).
When you use a line editor such as Microsoft Windows Notepad or UNIX vi to
update these XML files, save them in the appropriate format.

To change the port number specified for the servlet container:
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Procedure
1. Open the XML document file, install_dir/conf/jetty/JettyConfigDef.xml, where

install_dir is the installation directory.
2. Locate the XML tag: <port>servlet_port</port>, where servlet_port is the servlet

port you specified during installation, such as 9080.
3. Change servlet_port to the new port you want to use for the servlet container.
4. Save the file.
5. Open the Java Network Launching Protocol definition file,

install_dir/conf/jetty/docroot/webstart/EA_GUI.jnlp.
6. Locate the XML tag,
7. <jnlp spec="0.2 1.0" codebase="http://host_info:servlet_port/

webstart"href="EA_GUI.jnlp">, where servlet_port is the servlet port you
specified during installation, and host_info is the name of the host used for the
installation.

8. Change servlet_port to the new port you want to use for the servlet container.
9. Save the file.

Changing the Admin Password
To secure the application after installation, you should change the admin
password.

About this task

To change the password for the admin user:

Procedure
1. From the Manage menu, select Users.
2. Select the user definition for admin and click .
3. Type the new password in the Password and Confirm Password fields.
4. Click OK.

Logging Options Configuration
Sterling External Authentication Server supports multiple levels of logging to
capture operational messages reported for certificate validation and authentication
definitions.

About this task

Sterling External Authentication Server logging has the following default
configuration:
v Logging to the console is disabled for the server and the GUI.
v INFO logging level captures errors, warnings, and informational messages.
v The installation log called

Sterling_External_Authentication_Server_V2.4.1.0_InstallLog.log file is saved in
the install_dir directory.

v The server log called seas.log is in stored in the install_dir/logs file.
v The GUI log called seasgui.log is stored in the /install_dir/bin directory.
v The default maximum log file size allowed before archiving is 1000 KB.
v The maximum number of log files kept in the system is 20.
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Procedure
1. Configure the logging level and logging details by editing the log4j properties

file in the install_dir/conf directory to change logging for the server.
2. Edit the guilog4j.properties file to change logging for the GUI.

Note: You can also change the logging level for the server from the GUI. For
more information about changing the logging level, see Setting Listener
Connection Settings (Backlog and Timeout).

Changing the Logging Level from the GUI
About this task

To change the level of detail captured in the Sterling External Authentication
Server log files, using the GUI:

Procedure
1. From the Manage menu, select System Settings.
2. Click the Globals tab.
3. Select the logging level in the Logging Level field.
4. Click OK.

Turning Logging to the Console On or Off
About this task

To turn logging to the console on or off.

Note: Do not enable logging to the console if Tivoli Access Manager (TAM)
authentication definitions are used. Logging data conflicts with interprocess
communications.

Procedure
1. Navigate to the install_dir/conf directory, where install_dir is where Sterling

External Authentication Server is installed:
2. Do one of the following:

v Open the log4j.properties file to modify logging for the server.
v Open the guilog4j.properties file to change logging for the GUI.

3. Identify the logging output parameters, as illustrated in the following
log4j.properties file:
#log4j.appender.stdout=org.apache.log4j.ConsoleAppender
log4j.appender.stdout=org.apache.log4j.varia.NullAppender

The first line ending in ConsoleAppender turns on the console output. The line
ending in varia.NullAppender suppresses console output.

4. Comment out the logging option you do not want to use by adding the pound
symbol (#) at the beginning of the line. By default, output to the console is
turned off.

Note: Either the ConsoleAppender or the NullAppender must be commented
out.

5. Save the logging properties file.
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Changing the Log File Size
About this task

To change the maximum size that a log file reaches before it is archived:

Procedure
1. Navigate to the install_dir/conf directory, where install_dir is where Sterling

External Authentication Server is installed.
2. Do one of the following:

v Open the log4j.properties file to modify logging for the server.
v Open the guilog4j.properties file to change logging for the GUI.

3. Define how large you want the log file to reach before archiving in the
MaxFileSize parameter. Default=1000 KB and size is defined in kilobytes.
log4j.appender.R.MaxFileSize=1000KB

4. Save the logging properties file.

Changing the Number of Archive Log Files
About this task

To change the maximum number of log files to archive:

Procedure
1. Navigate to the install_dir/conf directory, where install_dir is where Sterling

External Authentication Server is installed.
2. Do one of the following:

v Open the log4j.properties file to modify logging for the server.
v Open the guilog4j.properties file to change logging for the GUI.

3. Type how many archive log files to keep in the MaxBackupIndex parameter.
Default=20.
log4j.appender.R.MaxBackupIndex=20

4. Save the logging properties file.

Changing the Logging Level in a Logging Properties File
About this task

To change the logging level in Sterling External Authentication Server log files to
determine what server-related performance details are written in a log:

Procedure
1. Navigate to the install_dir/conf directory.
2. Do one of the following:

v Open the log4j.properties file to modify logging for the server.
v Open the guilog4j.properties file to change logging for the GUI.

3. Define the logging level to report in the LEVEL parameter.
log4jrootLogger=LEVEL,R,stdout

4. Save the logging properties file.
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Refreshing the GUI List from the Server
More than one administrator can use the same Sterling External Authentication
Server GUI to configure Sterling External Authentication Server. When more than
one administrator changes Sterling External Authentication Server definitions, you
may need to update the GUI windows that list certificate revocation list, certificate
validation, authentication, user definitions, and role definitions.

Procedure

To refresh lists with updated configuration information from the server:

From the Manage menu, click Refresh Lists. When the progress message dialog
box closes, the GUI lists Sterling External Authentication Server configuration
definitions added since the last refresh.

Setting Listener Connection Settings (Backlog and Timeout)
Leave the listener connection fields blank to accept the default connection settings
for Sterling External Authentication Server. To change the listener connection
settings, you specify parameters to control the backlog of connections, set the
timeout for accepting an inbound connection, and set the timeout for outbound
connections and read operations.

About this task

To change listener connection settings:

Procedure
1. From the Manage menu, click System Settings.

2. Click the Globals tab.
3. To customize the listener settings, set the following connection parameters:

v Listen Backlog
v Accept Timeout
v SSL Handshake Timeout
v Session Idle Timeout
v Connect Timeout
v Read Timeout

4. Click OK.

Creating a System-Wide LDAP or HTTP Connection Definition
Create system-wide connection definitions to perform attribute queries or
download certificate revocation lists. When you create a CV definition, CRL
definition, or AD definition in Sterling External Authentication Server, you can
select a system-wide definition that is created.

About this task

Creating system-wide connection definitions before you create the definitions is
helpful when the same connection information is required for multiple uses. For
example, you save time by selecting a system-wide LDAP connection when several
attribute query definitions require a connection to the same LDAP server. By
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creating system-wide connection definitions, you ensure that required changes to
connection details can be made in one place, and login credentials for connections
are entered only once. Specifying system-wide server connections saves time and
reduces errors that may occur when entering connections manually.

To create an LDAP or HTTP connection definition:

Procedure
1. From the Manage menu, click System Settings and click the Connection

Definitions tab.
2. Click the + icon to add a new connection definition and name the connection

definition.
3. In the Protocol field, select the protocol as follows:

v For an LDAP connection definition:
Specify ldap:// to connect using the Lightweight Directory Access Protocol.
Specify ldaps:// to connect using the Lightweight Directory Access Protocol
over SSL/TLS.

v For an HTTP connection definition:
Specify http:// to connect using the HTTP protocol without using SSL/TLS.
Specify https:// to connect using the HTTP protocol using SSL/TLS. When
the protocol is https:// you can specify a client key certificate alias to select
a certificate from the system SSL key store for use with the SSL/TLS
protocol.
Continue with step 5.

4. For an LDAP connection, specify the following parameters:
v Name
v Description
v Host
v Port
v Authentication Method
v Principal Name
v Principal Password
v Client Key Certificate Alias
v LDAP Version
v Start TLS
v Referral Action
v Advanced options

5. For an HTTP connection, specify the following parameters and click Next.
v Name
v Description
v Protocol
v Host
v Port
v Client Key Certificate Alias
v Advanced options

6. Click Next and click Save.
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Configuring the Kerberos API
Sterling External Authentication Server uses Kerberos to allow users to change a
password in Active Directory. Configure Kerberos using Sterling External
Authentication Server system settings. In Active Directory, realm names are to
domain names.

About this task

Note: Kerberos cannot be used on AIX®.

To configure Sterling External Authentication Server to identify each Kerberos
realm:

Procedure
1. From System Settings, click Kerberos Configuration.
2. Click the + icon.
3. Define the realm by providing information in the following fields:

v Name
v Kdsc

4. Click OK.
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Chapter 3. System Certificate Creation and Management

Before you configure SSL or TLS secure connections, you create, exchange, and
store certificates for Sterling External Authentication Server and the entities with
which you communicate. Depending on your security policy, how you deploy
Sterling External Authentication Server, and the client applications that you
communicate with, you may have to distribute your public key to entities and
store certificates from client applications, LDAP servers, and end users.

This section explains how to generate and store self-signed and CA-signed
certificates for the server, import certificates, configure the secure listener port,
configure access to the keystore and trust store, and configure a secure connection
between a remote GUI and server.

Certificate Generation and Usage
Whether you are using self-signed certificates or CA-issued certificates determines
the procedures you complete to generate and use certificates. In addition, the
connections you are securing determine what procedures to complete. Identify the
type of certificate you are generating and the connection you are securing, and
then complete the procedures outlined in the following topics:

“Procedures to Generate a Self-Signed Certificate to Secure the Sterling External
Authentication Server Connection”

“Procedures to Generate a CA-Issued Certificate to Secure the Connection to
Sterling External Authentication Server” on page 20

“Procedures to Generate a Self-Signed Certificate for the Connection between the
GUI and the Sterling External Authentication Server” on page 20

“Procedures to Generate a CA Certificate to Secure the Connection between the
GUI and Sterling External Authentication Server” on page 21

Procedures to Generate a Self-Signed Certificate to Secure the
Sterling External Authentication Server Connection

Complete the following procedures to configure a self-signed certificate to secure
Sterling External Authentication Server:

Task Procedure

Generate a self-signed-certificate to authenticate
Sterling External Authentication Server to a client.

Generating a Self-Signed Certificate
for the Sterling External
Authentication Server .

A self-signed certificate is stored in the keystore. You
must export it and send it to the entity with which
you are communicating.

Exporting a Self-Signed Certificate
for the Sterling External
Authentication Server .

For each secure server that Sterling External
Authentication Server connects to, obtain a copy of
the root certificate and import it into the trust store.

Importing a Certificate into the
Sterling External Authentication
Server Trust Store .
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Task Procedure

After you obtain a CA certificate and import it into
the keystore, allow Sterling External Authentication
Server to access the SSL keystore.

Configuring Sterling External
Authentication Server to Access the
SSL Keystore .

After you import client and secure server certificates
to the server trust store, enable the Sterling External
Authentication Server trust store.

Configuring Sterling External
Authentication Server to Access the
SSL Trust Store .

Configure the secure listener. Configuring the Secure Connection
Listener .

Procedures to Generate a CA-Issued Certificate to Secure the
Connection to Sterling External Authentication Server

Complete the following procedures to generate CA certificates for the Sterling
External Authentication Server:

Task Procedure

To use a CA certificate to authenticate Sterling External
Authentication Server to a client application, first
generate the self-signed-certificate for the server. This
procedure generates the information needed to create a
Certificate Signing Request (CSR).

Generating a Self-Signed
Certificate for the Sterling
External Authentication Server .

After you create a self-signed certificate, you are ready
to create and send a certificate signing request.

Creating a PKCS#10 Certificate
Signing Request for the Server .

Obtain a copy of the root certificate from the CA.
Distribute this information to the servers that require
client authentication, the GUI, and client applications.

When you receive the certificate from the CA, import it
into the Sterling External Authentication Server
keystore. This replaces the self-signed certificate.

Importing the CA-Issued
Certificate into the Server
Keystore .

For each secure server that Sterling External
Authentication Server connects to, obtain the root
certificate and import it into the trust store.

Importing a Certificate into the
Sterling External Authentication
Server Trust Store .

After you obtain a CA certificate and import it into the
keystore, configure Sterling External Authentication
Server to access the SSL keystore.

Configuring Sterling External
Authentication Server to Access
the SSL Keystore .

After you import client and secure server certificates to
the server trust store, enable the Sterling External
Authentication Server trust store.

Configuring Sterling External
Authentication Server to Access
the SSL Trust Store .

Configure the secure listener. Configuring the Secure
Connection Listener .

Procedures to Generate a Self-Signed Certificate for the
Connection between the GUI and the Sterling External
Authentication Server

Complete the following procedures to set up self-signed certificates between the
server and GUI:
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Task Procedure

To use a self-signed certificate to authenticate the
Sterling External Authentication Server to the Sterling
External Authentication Server GUI, generate a
self-signed-certificate for the server.

Generating a Self-Signed
Certificate for the Sterling
External Authentication Server .

To use a self-signed certificate to authenticate the
connection between Sterling External Authentication
Server and the GUI, create a key certificate on the
computer where the GUI is running.

Generating a Self-Signed
Certificate for the GUI .

Export the self-signed certificate you created at the
GUI.

Exporting a Self-Signed
Certificate for the GUI .

Import the certificate from the GUI into the Sterling
External Authentication Server trust store.

Importing a Certificate into the
Sterling External Authentication
Server Trust Store .

The GUI trust store must contain public keys from the
Sterling External Authentication Server.

Importing the Server Certificate
into the GUI Trust Store

Procedures to Generate a CA Certificate to Secure the
Connection between the GUI and Sterling External
Authentication Server

Complete the following procedures to configure CA-issued certificates to secure a
connection between the Sterling External Authentication Server and the GUI:

Task Procedure

To use a self-signed certificate to authenticate the
Sterling External Authentication Server to the
Sterling External Authentication Server GUI, use this
procedure to generate the self-signed-certificate.

Generating a Self-Signed Certificate
for the Sterling External
Authentication Server .

After you create a self-signed certificate, create a
certificate signing request for the server.

Creating a PKCS#10 Certificate
Signing Request for the Server .

When you receive the certificate from the CA,
import the certificate into the Sterling External
Authentication Server keystore. This replaces the
self-signed certificate.

Importing the CA-Issued Certificate
into the Server Keystore .

To use a CA certificate to authenticate the
connection between Sterling External Authentication
Server and the GUI, generate a self-signed-certificate
for the GUI.

Generating a Self-Signed Certificate
for the GUI .

Create a CSR that contains information from the key
and certificate at the GUI and send it to the CA.

Creating a PKCS#10 Certificate
Signing Request for the GUI to
Submit to a CA .

Import the certificate you received from the CA into
the GUI keystore.

Importing the CA-Issued Certificate
to the GUI Keystore .

The trust store at the server must contain a copy of
the public key from the Sterling External
Authentication Server GUI.

Importing a Certificate into the
Sterling External Authentication
Server Trust Store .

Import a copy of the server certificate to the GUI
trust store.

Importing the Server Certificate into
the GUI Trust Store .
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Self-Signed Certificate Generation
To configure the Sterling External Authentication Server for secure
communications, you must first generate a self-signed certificate. To configure a
secure connection between the GUI and the Sterling External Authentication
Server, you must create a key certificate on the computer where the GUI is
running.

A self-signed certificate is required whether you use a self-signed or CA-issued
certificate to secure the connection between the Sterling External Authentication
Server and clients or between the GUI and the Sterling External Authentication
Server.
v If you plan to use a self-signed certificate to authenticate Sterling External

Authentication Server to a client application, first generate the
self-signed-certificate for the server. Then, export the certificate information and
send it to the client application. If you use self-signed certificates, you are
responsible for updating and maintaining them.

v If you plan to use a CA-issued certificate to authenticate Sterling External
Authentication Server to a client application, first generate the self-signed
certificate. Then, use this information to generate a certificate signing request
(CSR) for a CA-issued digital certificate. After you obtain a CA certificate, import
this information into the Sterling External Authentication Server keystore.

v If you plan to use a self-signed certificate to authenticate the GUI to the Sterling
External Authentication Server, first generate the self-signed-certificate for the
GUI. Then, export the certificate information and send it to the Sterling External
Authentication Server.

v If you plan to use a CA-issued certificate to authenticate the GUI to the Sterling
External Authentication Server, first generate the self-signed certificate at the
GUI. Then, use the information from the self-signed certificate to generate a
certificate signing request (CSR) for a CA-issued digital certificate. After you
obtain a CA certificate, import this information into the GUI keystore.

Generating a Self-Signed Certificate for the Sterling External
Authentication Server

To generate a self-signed key certificate for the Sterling External Authentication
Server and add it to the Sterling External Authentication Server keystore:

Procedure
1. At the Sterling External Authentication Server, type the following command

from the install_dir/jre/bin directory where install_dir is the installation
directory path, and press Enter.
keytool -genkey -alias alias_name -keyalg alg_type -keysize keysize -validity
validity_in_days -keystore keystore_path -storepass password

Refer to Parameters to Generate a Self-Signed Certificate for the parameters.
Following is a sample command used to create a server key certificate:
$ keytool -genkey -alias SEASkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore C:\install_dir\conf\system\keystore -storepass password

Following are sample commands to create a key certificate. Each uses the
-dname option to control the attributes used to define the subject distinguished
name:
$ keytool -genkey -alias SEASkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore c:\install_dir\conf\system\keystore -storepass password -dname
“CN=SEAServer, DC=companyname, DC=com”
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$ keytool -genkey -alias SEASkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore c:\install_dir\conf\system\keystore -storepass password -dname
“C=US, O=companyname, CN=SEAServer”

2. If you do not use the -dname option to define the CN attribute, provide the
following information:
v Given name and surname

Note: Information you provided in the Given name and surname field is used
to create the CN attribute in the subject DN.
v Organizational unit
v Organization
v City or locality
v State or Province (use UPPER CASE characters)
v Two-letter country code (use UPPER CASE characters)

3. Verify the information and press Enter.
4. At the prompt to provide a key password, do not provide a password. Press

Enter.
CAUTION:
The key certificate and keystore passwords must be the same for Sterling
External Authentication Server to function properly.

5. Do one of the following:
v If you are using CA-issued certificates, continue to Creating a PKCS#10

Certificate Signing Request for the GUI to Submit to a CA.
v If you are using a self-signed certificate, complete the procedure Exporting a

Self-Signed Certificate for the Sterling External Authentication Server.

Generating a Self-Signed Certificate for the GUI
To establish secure communications between the GUI and the Sterling External
Authentication Server, you must create a key certificate on the computer where the
GUI is running.

About this task

To create a self-signed key certificate at the GUI:

Procedure
1. On the computer where the GUI is running, type the following command and

press Enter:
keytool -genkey -alias alias_name -keyalg alg_type -keysize keysize -validity
validity_in_days -keystore keystore_path -storepass password

The follow example illustrates how to create a key certificate:
$ keytool -genkey -alias SEASGUIkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore c:\keystore\mykeystore -storepass password

The following examples illustrate creating a key certificate using the -dname
option to control the attributes used to define subject distinguished name:
$ keytool -genkey -alias SEASGUIkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore c:\keystore\mykeystore -storepass password -dname “CN=SEASGUI,
DC=companyname, DC=com”

$ keytool -genkey -alias SEASGUIkeycert -keyalg RSA -keysize 1024 -validity
360 -keystore c:\keystore\mykeystore -storepass password -dname “C=US,
O=companyname, CN=SEASGUI”
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2. If you do not use the -dname option to define the CN attribute, provide the
following:
v First and last name

Note: Information you provided in the First and last name field is used to
create the CN attribute in the subject DN.
v Organizational unit
v Organization
v City or locality
v State or Province (use UPPER CASE characters)
v Two-letter country code (use UPPER CASE characters)

3. Verify the information you provided and press Enter.
4. At the prompt to provide a password, do not provide a password. Press Enter.

CAUTION:
The key certificate and keystore passwords must be the same for Sterling
External Authentication Server to function properly.

5. Do one of the following:
v If you are using CA-signed certificates, complete the procedure Creating a

PKCS#10 Certificate Signing Request for the GUI to Submit to a CA.
v If you are using a self-signed certificate, export a copy of the file. Refer to

Exporting a Self-Signed Certificate for the GUI.

Parameters to Generate a Self-Signed Certificate
Following are the parameters to generate a self-signed certificate for the GUI and
the server:

Parameter Description

keytool Invokes the Keytool utility. Type this command with no options to
view help.

-genkey Instructs the Keytool utility to generate a certificate and a private
key.

-alias alias_name Certificate Name. This name is used to identify the certificate in the
keystore.

-keyalg alg_type Algorithm type to create the key. This value must be an RSA
algorithm.

-keystore
keystore_path

Path and file name of the keystore file. If you omit this parameter,
the keystore is created in your home directory with the file name
.keystore.

-keysize keysize Size of the key to create. Maximum key size is 2048.

-validity
validity_in_days

Number of days that the certificate is valid for.

-storepass password Password of the keystore file.

-dname Controls attributes used to specify the distinguished name in the
self-signed certificate or CSR. For example, use domain attributes
instead of geographic attributes.
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Export a Self-Signed Certificate
After you create a self-signed certificate at the Sterling External Authentication
Server, you may need to send this information to the client with which you are
communicating. Complete the procedure, Exporting a Self-Signed Certificate for
the Sterling External Authentication Server, to export the information.

After you create a self-signed certificate at the GUI, you need to export the
certificate and send it to the Sterling External Authentication Server. Complete the
procedure Exporting a Self-Signed Certificate for the GUI.

Exporting a Self-Signed Certificate for the Sterling External
Authentication Server

If you are using self-signed certificates, export a copy of the certificate to a file to
import into the partner's trust store.

About this task

To export a self-signed certificate generated for the Sterling External Authentication
Server:

Procedure
1. From the install_dir/jre/bin directory on the Sterling External Authentication

Server, type the following command, where install_dir is the installation
directory path.:
keytool -export -alias alias_name -keystore keystore_path -storepass password
-rfc -file cert_file_name.xxx

Refer to Commands to Export a Self-Signed Certificate for the parameters.
2. Press Enter to run the command.

Exporting a Self-Signed Certificate for the GUI
If you are using self-signed certificates, export a copy of the certificate to a file to
import into the server's trust store.

About this task

To export the certificate:

Procedure
1. On the computer where the GUI is running, type the following command:.

keytool -export -alias alias_name -keystore keystore_path -storepass password
-rfc -file cert_file_name.xxx

Refer to Commands to Export a Self-Signed Certificate for a description.
2. Press Enter to run the command.

What to do next

Import the certificate into the Sterling External Authentication Server trust store.
Refer to Importing a Certificate into the Sterling External Authentication Server
Trust Store.
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Commands to Export a Self-Signed Certificate
Following is a description of the parameters used to export a self-signed certificate
at a server or a GUI:

Parameter Description

keytool Invokes the Keytool utility.

-export Exports a copy of the certificate so you can distribute it to the
servers with which you communicate as client, to the computer
where the GUI resides, and to client applications.

-alias alias_name Name of the certificate. It is used to identify the certificate in the
keystore.

-keystore keystore_path Path and file name of the keystore. If you do not define this
parameter, it is created in your home directory with the file
name .keystore.

-storepass password Password of the keystore file.

-rfc Exports the certificate in PEM format; if you do not include this
parameter, the certificate is exported in DER format.

-file cert_file_name.xxx Path and file name of the certificate to export.

Creation of a Certificate Signing Request
Before you can request a certificate authority (CA)-issued certificate to secure the
connection between Sterling External Authentication Server and clients or between
the GUI and the Sterling External Authentication Server, you must generate a
certificate signing request (CSR). To generate a CSR, you first generate a self-signed
certificate and use the information from the self-signed certificate to generate the
CSR. You then submit the CSR to a CA and request a digital certificate that is
authenticated and digitally signed by the CA.

Note: This process does not apply if you plan to use self-signed certificates to
authenticate Sterling External Authentication Server to a client application or to
authenticate the GUI to Sterling External Authentication Server.

Creating a PKCS#10 Certificate Signing Request for the Server
To create a CSR for the certificate created for the Sterling External Authentication
Server:

Procedure
1. At the Sterling External Authentication Server, navigate to the

install_dir/jre/bin directory, where install_dir is the directory where Sterling
External Authentication Server is installed. Type the following command and
press Enter.
keytool -certreq -keystore keystore_path -alias alias_name -file CSR_file
-storepass password

Refer to Parameters to Create a CSR for a description of the parameters.
The following examples illustrates how to generate a PKCS#10 CSR for the
SEASkeycert certificate:
$ keytool -certreq -keystore c:\install_dir\conf\system\keystore -alias
SEASkeycert -file c:\keystore\CSR.txt -storepass mypassword

2. Submit the output file to the CA to request a server certificate.
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What to do next

When you receive the certificate from the CA, perform the procedure Importing
the CA-Issued Certificate into the Server Keystore.

Creating a PKCS#10 Certificate Signing Request for the GUI to
Submit to a CA

Complete the following procedure to create a certificate signing request (CSR) that
contains key and certificate information from a self-signed certificate. After you
create the CSR, submit it to a CA to request a CA-issued digital certificate that is
authenticated and digitally signed by the CA.

About this task

To create a CSR for the GUI to submit to a CA:

Procedure
1. On the computer where the GUI is running, type the following command and

press Enter.
keytool -certreq -keystore keystore_path -alias alias_name -file CSR_file
-storepass password

Refer to Parameters to Create a CSR for a description of the parameters.
The following command illustrates how to generate a PKCS#10 CSR for the
GUI certificate:
$ keytool -certreq -keystore c:\keystore\mykeystore -alias GUIkeycert -file
c:\keystore\CSR.txt -storepass mypassword

2. Submit the output file to the CA to request a certificate for the GUI.

Results

When you receive the certificate from the CA, perform the procedure Importing
the CA-Issued Certificate to the GUI Keystore.

Parameters to Create a CSR
The following parameters are used to create a CSR:

Parameter Description

keytool Invokes the Keytool utility.

-certreq Generates a certificate signing request (CSR).

-keystore keystore_path The path to the keystore that contains the certificate to create the
CSR for.

-alias alias_name The alias name of the certificate to create the CSR for.

-file CSR_file The path and file name of the CSR to create.

-storepass password The password of the keystore.

Import of the CA-Issued Certificate Keystore
The keystore stores the private-public key pair and associated CA-issued
certificate. Two keystores are maintained: the keystore at the Sterling External
Authentication Server and at the GUI. Import the certificates used by the Sterling
External Authentication Server to communicate with clients in the Sterling External
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Authentication Server keystore. Import certificates used by the GUI to
communicate with the Sterling External Authentication Server in the GUI keystore.

Importing the CA-Issued Certificate into the Server Keystore
About this task

To replace the self-signed certificate with the CA-issued certificate for the Sterling
External Authentication Server:

Procedure
1. Navigate to the install_dir/jre/bin directory on the Sterling External

Authentication Server.
2. Type the following command and press Enter.

keytool -import -keystore keystore_path -alias alias_name -storepass
password -file certificate

Refer to Parameters to Import the CA-Issued Certificate into the Keystore for a
description of the parameters.
Following is a sample command to import a CA-issued certificate to the server
keystore:
$ keytool -import -keystore c:\install_dir\conf\system\keystore -alias
SEASServerKey -storepass mypassword -file c:\certificate\CASignedCert.txt

3. When prompted to trust the certificate, type yes and press Enter.
4. Obtain a copy of the root certificate of the CA.

What to do next

Distribute a copy of the root certificate to the servers that require client
authentication, the remote computer running the Sterling External Authentication
Server GUI, and client applications.

Importing the CA-Issued Certificate to the GUI Keystore
About this task

The following procedure replaces the self-signed certificate that was created in
Generating a Self-Signed Certificate for the GUI with the CA-issued certificate for
the GUI.

To import the CA-issued certificate into the GUI keystore:

Procedure
1. At the GUI, type the following command and press Enter:

keytool -import -keystore keystore_path -alias alias_name -storepass
password -file certificate

Refer to Parameters to Import the CA-Issued Certificate into the Keystore for a
description of the parameters.
The following example illustrates how to import a CA-issued certificate to the
GUI keystore:
$ keytool -import -keystore c:\keystore\mykeystore -alias GUIKeycert
-storepass mypassword -file c:\certificate\CASignedCert.txt

2. When you are prompted with the message, Trust this certificate?, type yes and
press Enter.
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3. Obtain a copy of the root certificate of the CA and import it to the trust store of
Sterling External Authentication Server as described in Importing the Server
Certificate into the GUI Trust Store.

Parameters to Import the CA-Issued Certificate into the
Keystore

Following are the parameters used to import a CA certificate into a keystore:

Parameter Description

keytool Invokes the Keytool utility.

-import Instructs Keytool to import a certificate to the keystore.

-keystore keystore_path Path and file name of the keystore file.

-alias alias_name Alias name to identify the certificate in the keystore. Use the
same alias as you used to create the certificate in Generating a
Self-Signed Certificate for the GUI .

-storepass password Password of the keystore file.

-file certificate Location of the CA-issued certificate to import.

Import Certificates into the Trust Store
Depending upon the connection you are securing, you import certificates into the
trust store. To secure the connection between the Sterling External Authentication
Server and client connections, the Sterling External Authentication Server trust
store must contain a copy of the root certificate for each secure server that Sterling
External Authentication Server connects to as well as from clients that initiate a
connection to the Sterling External Authentication Server. To secure the connection
between the GUI and the Sterling External Authentication Server, the GUI trust
store must contain a copy of the public key of Sterling External Authentication
Server.

Importing a Certificate into the Sterling External
Authentication Server Trust Store

To import the CA root or the public key to the Sterling External Authentication
Server trust store:

Procedure
1. Navigate to the install_dir/jre/bin directory on the Sterling External

Authentication Server, where install_dir is the directory where Sterling External
Authentication Server is installed.

2. Type the following command, and press Enter:
keytool -import -keystore truststore_path -storepass password -file certificate

The following example illustrates how to import the server certificate to the
Sterling External Authentication Server trust store:
$ keytool -import -keystore “c:\install_dir\conf\system ruststore” -storepass
mypassword -file c:\TrustCertificate\cert.txt

3. When prompted, Trust this certificate?, type yes and press Enter.

Importing the Server Certificate into the GUI Trust Store
To import the server CA root or the public key to the GUI trust store:
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Procedure
1. On the computer where the GUI resides, type the following command and

press Enter:
keytool -import -keystore truststore_path -storepass password -file certificate

The following example illustrates how to import the server certificate to the
GUI trust store:
$ keytool -import -keystore c: ruststore\mytruststore -storepass mypassword
-file c:\TrustCertificate\cert.txt

2. When you are prompted with the message, Trust this certificate?, type yes and
press Enter.

Parameters to Import the Certificate into the Trust Store
Following are the parameters used to import a CA certificate into a trust store:

Parameter Description

keytool Invokes the Keytool utility.

-import Instructs Keytool to import a certificate to the trust store.

-keystore truststore_path Specifies the path and file name of the trust store file.

-storepass password Password of the trust store file. Default=changeit.

-file certificate Location of the public certificate to import.

Configuring Sterling External Authentication Server to Access the SSL
Keystore

About this task

You must have a self-signed or CA-issued certificate in the server keystore before
completing this procedure. See Generating a Self-Signed Certificate for the Sterling
External Authentication Server or Import of the CA-Issued Certificate Keystore for
more information.

The SSL keystore file stores the certificate used to connect to secure LDAP servers
and to perform TLS/SSL negotiations with connecting client applications.

To configure Sterling External Authentication Server to access the keystore:

Procedure
1. From the Manage menu, select System Settings.

2. Click the SSL tab.
3. Specify the following information:

v Protocol
v Keystore File
v Keystore Password

4. Click OK.
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Configuring Sterling External Authentication Server to Access the SSL
Trust Store

The trust store file contains the CA and self-signed certificates that authenticate
secure connections to Sterling External Authentication Server from client
applications, from Sterling External Authentication Server to LDAP servers that it
connects to, and to optionally validate signatures on CRLs and certificates.

About this task

This procedure assumes that you have imported client and secure server
certificates to the server trust store. See Importing a Certificate into the Sterling
External Authentication Server Trust Store for more information.

To enable the Sterling External Authentication Server trust store:

Procedure
1. From the Manage menu, select System Settings.
2. Click the Trusted Certificate tab.
3. Specify the following parameters:

v Trust Store File
v Trust Store Password

4. Click OK.

Configuring the Secure Connection Listener
About this task

To enable a client application to connect securely to Sterling External
Authentication Server:

Procedure
1. From the Manage menu, select System Settings.
2. Click the Listeners tab.
3. In the Secure Listener section, specify the following parameters:

v IP Address
v Port
v Keystore alias
v Enabled

4. Click OK.

Configuring SSL or TLS Between the GUI and the Sterling External
Authentication Server

About this task

Complete this procedure to configure the GUI to use SSL/TLS to connect to the
Sterling External Authentication Server. Before you complete this procedure, have a
certificate at the GUI and the Sterling External Authentication Server, import the
GUI certificate into the Sterling External Authentication Server trust store and
import the root certificate of the Sterling External Authentication Server into the
trust store of the GUI.
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To configure SSL or TLS between the GUI and Sterling External Authentication
Server connection:

Procedure
1. From the Login screen, click Config.
2. Specify the Keystore File and password. Click Next.
3. On the Create SSL/TLS Trust Store Info screen, specify the trust store file and

password and click Next.
4. From the Confirm screen, click Save.
5. Click Close to return to the Login screen.

32 Sterling External Authentication Server: Implementation Guide



Chapter 4. Creation and Management of Certificate
Revocation List (CRL) Definitions

Create Certificate Revocation List (CRL) definitions to download published CRLs.
Published CRLs validate certificates and determine if a certificate has been
revoked. During certificate validation, Sterling External Authentication Server
checks CRLs in the CV definition and determines if a certificate is revoked.

Sterling External Authentication Server supports the system-wide connection
definitions based on a specific local bind address and validation of certificates that
include the CRL distribution points extension. To create CRL definitions that enable
CRL access as required for some CV requests, you may need to reference
system-wide connection definitions and variables that support advanced
operations. For information about the CRL distribution points extension, see X.509
Extensions. For information on variables, refer to CV and Authentication Definition
Variables.

Creating a CRL Definition
Create a CRL definition to allow Sterling External Authentication Server to
determine if a certificate has been revoked early. Certificate authorities issue CRLs
periodically and publish them to HTTP or LDAP servers so that they can be
referenced for up-to-date information about revoked certificates. To allow Sterling
External Authentication Server to access this information and validate certificates
received against the CRL list, create a CRL definition.

About this task

To use system-wide definitions to connect to the LDAP server, create the definition
before you create a CRL definition. Refer to Creating a System-Wide LDAP or
HTTP Connection Definition.

To create a CRL definition:

Procedure
1. From the Manage menu, click CRL Definitions.
2. From the CRL Definitions screen, click the + icon .
3. On the General screen, specify the following parameters and click Next:

v CRL Definition Name
v CRL Cache
v Refresh CRL on every check
v Clock Tolerance
v Reject expired CRL
v Verify Signature

4. On the Query General screen, select one of the following options to identify
how to connect to the server where the CRL is published and how to query for
the list:
v Use defined connection
v Specify query parameters
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v Specify query as URL
5. Do one of the following:

v On the LDAP Parameters screen, specify the following parameters:
– Protocol
– Host
– Port
– Base DN
– Return Attributes
– Scope
– Match Attributes
– Query Timeout

v On the HTTP Parameters screen, specify the following parameters:
– Protocol
– Host
– Port
– Path
– Query
– Query Timeout

6. On the LDAP Connection Settings screen, specify the authentication method
used by the LDAP server, if required, and click Next:
v Authentication Method
v Principal Name
v Principal Password
v Client Key Certificate Alias
v LDAP Version
v Start TLS
v Referral Action
v JNDI Properties

7. On the Confirm screen, verify the parameters and click Save and Close.

Editing a CRL Definition
About this task

Edit a CRL definition from within the certificate validation it is associated with or
from the Manage menu. For more information on the CRL fields, refer to Creating
a CRL Definition.

To edit a CRL:

Procedure
1. Do one of the following:

v To edit a CRL from the Certificate Validation Definitions window,
double-click the definition that includes the CRL definition. Click the
Referenced CRLs tab. Select the CRL definition to modify and click .

v To edit a CRL from the Sterling External Authentication Server menu, select
Manage>CRL Definitions. Double click the CRL to edit.

2. Modify parameters as required.
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3. Click the Summary tab and review all parameters. Click OK.

Copying a CRL Definition
About this task

Copy a CRL definition using the Manage menu or when you are in a CV
definition. To copy a CRL definition from the CV definition, it cannot be
referenced.

To copy a CRL:

Procedure
1. To open a CRL definition from the Certificate Validation Definitions window,

double-click the CV definition that includes the CRL definition. Click the
Referenced CRLs tab. Highlight the CRL definition to modify and click .

2. To open a CRL definition from the Manage menu, select Manage > CRL
Definitions and double-click the CRL to copy.

3. Rename the CRL.
4. Change the parameter settings as required.
5. On the Confirm screen, verify the settings and click Save.

Deleting a CRL Definition from the Manage Menu
About this task

Delete a CRL from the Manage menu. It cannot be deleted from a CV definition.

To delete a CRL:

Procedure
1. From the Manage menu, click CRL Definitions.
2. Select the CRL to delete and click the - icon .
3. Click OK.

Chapter 4. Creation and Management of Certificate Revocation List (CRL) Definitions 35



36 Sterling External Authentication Server: Implementation Guide



Chapter 5. Configuration of Active Directory to Prepare for
Use with Sterling External Authentication Server

You can store certificates, SSH keys, users, or IP addresses in Active Directory and
use Sterling External Authentication Server to access the information. Sterling
External Authentication Server then provides Active Directory to Sterling Secure
Proxy for user authentication.

Note: Use Microsoft Management Console (MMC) and Sterling External
Authentication Server to configure Active Directory.

The Active Directory Schema
The Active Directory schema defines the objects allowed in a directory. Use the
schema file to extend Active Directory. Complete the procedures in this section to
extend the schema, add a node to the schema, and add superior to the
loginCredentials class. If you are using the SSH protocol, complete the procedure
to add the sshPublicKey attribute to the user class.

Extending Schema for Active Directory
To add a directory object for Lookup Login Credentials, extend the schema for the
directory.

Procedure

To extend the Active Directory schema:
1. Log in to the AD domain with an administrator account that is a member of

the Schema Admins group.
2. Edit the file called seas_ad.ldf. Replace all occurrences of DC=example,DC=com

with your AD domain name.
For example, if your AD domain is acme.local, replace DC=example,DC=com
with DC=acme,DC=local.

3. Save the file.
4. Make a backup of Active Directory.
5. Run the following command:

ldifde -i -f seas_ad.ldf

Note: If you get the error, access denied, the account you logged in may not be
an administrator in the Schema Admins group. If you meet these requirements
and you get the error, run the command using the administrator account for
the domain controller.

Adding an Active Schema Node
When you add attributes to Activity Directory (AD), an Active Directory Schema
node must exist under the Console Root. If the node does not exist, add it as
follows:
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Procedure
1. Select Start>Run.
2. On the Open field, type regsvr32 schmmgmt.dll.
3. Click OK.
4. Select File>Add/Remove Snap-in.
5. Click Add.
6. Select Active Directory Schema and click Add.
7. Click OK.

Adding the sshPublicKey Attribute to the User Class
If you use the SSH protocol, add the sshPublicKey attribute.

About this task

Note: Make sure an Active Schema node exists. To search for a node, open MMC.
Look for the Active Directory Schema node under Console Root. If it does not
exist, create it. Refer to Adding an Active Schema Node.

To add the sshPublicKey attribute:

Procedure
1. Open Microsoft Management Console.
2. Right-click Active Directory Schema and click Reload the schema.
3. Expand the Active Directory Schema.
4. Click Classes.
5. Right-click user class on the list and click Properties.

Note: If you use a different class than the system user class, select it.
6. On the Attributes tab, click Add.
7. On the Select Schema Object dialog, select sshPublicKey from the list. Click

OK.
8. Click Apply. Click OK to close the Properties dialog.

Adding superior to the loginCredentials Class
About this task

Note: Make sure an Active Schema node exists. Open MMC and look for Active
Directory Schema node under Console Root. If it does not exist, create it. Refer to
Adding an Active Schema Node.

To add superior to the loginCredentials class:

Procedure
1. Open the MMC.
2. Right-click Active Directory Schema and click Reload the schema.
3. Expand Active Directory Schema.
4. Click Classes.
5. Right-click the loginCredentials class on the list and select Properties.
6. Click the Relationship tab and select Add Superior.
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7. Select the user class and click OK.

Note: If you use a different class than the system user class, select it.
8. Click Apply. Click OK to close the Properties dialog.

Adding the ADSI Edit Node
Before you complete certain procedures in AD, you must add an ADSI Edit
nodend a Domain node. To determine if an ADSI Edit node exists, expand the
Console Root. Look for Domain node under ADSI Edit. If these nodes do not exist,
use this procedure to add them.

About this task

To add the ADSI edit node in AD:

Procedure
1. Select File>Add/Remove Snap-in and click Add.
2. Select ADSI Edit and click Add.
3. Click OK.

Adding the Domain Node
To add the domain node:

Procedure
1. Right click ADSI Edit and click Connect to.
2. On the Connection Settings dialog, enable Select a well known naming

context and select Domain.
3. Click OK.

Mapped Credentials in Active Directory Setup
Set up mapped credentials in Active Directory (AD) when you want to allow
Sterling Secure Proxy to log in to backend servers using different credentials than
the credentials used by the trading partners. The trading partner presents one set
of credentials to log in to Sterling Secure Proxy. Sterling Secure Proxy uses Sterling
External Authentication Server to look up the credentials in AD. Then, AD returns
a different set of credentials to use to log in to the company server.

Assigning Mapped Credentials in Active Directory
If you plan to use mapped credentials to access the company server, you must
assign mapped credentials.

About this task

Note: Before you assign mapped credentials, you must extend the schema. Refer
to Extending Schema for Active Directory. Additionally, the ADSI Edit node and
the Domain node must exist. To check for the ADSI Edit node definition, open
Active Directory (AD) and expand Console Root. Look for Domain node under
ADSI Edit. If these nodes do not exist, add them. Refer to Adding the ADSI Edit
Node .
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To assign map credentials in AD:

Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node. Right-click Domain and select Update Schema

Now.
4. Expand the node for your AD domain.
5. Expand the Users container.

Note: If users are stored in a different container, such as OU=External
Partners, navigate to that container and expand it.

6. Right click the user to modify and select New>Object.
7. Select loginCredentials from the class list and click Next.
8. Type a name for the object and click Next.

For example, name the object Login Credentials for XXXX, where XXXX is
the destination service name.

9. Click More Attributes.
10. Select loginTarget from the Select a property to view field.
11. On the Edit attribute field, type the destination service name for the server.

This value must match the destination service field in the Sterling Secure
Proxy netmap.

12. Click Set, then click OK.
13. To return a routing key when you log in to the destination service, do the

following:
a. Click More Attributes.
b. Select routingKeyName from the Select a property to view field.
c. On the Edit attribute field, type the routing key label for the

public/private SSH key pair used to log in to the server.
d. Click Set, then OK.

14. To return a mapped user ID to log in to the destination service:
a. Click More Attributes.
b. Select loginId from the Select a property to view field.
c. On the Edit attribute field, type the user ID used to log in to the server.
d. Click Set, then OK.

15. To return a mapped password to login to the destination service:

Note: Type the password in hexadecimal, with each character specified in the
form 0xHH, separated by spaces.
a. Click More Attributes.
b. Select loginPwd from the Select a property to view field.
c. On the Edit attribute field, type the password used to log in to the server.
d. For example, if password=password, enter: 0x70 0x61 0x73 0x73 0x77

0x6f 0x72 0x64.

e. To find converters, search for text to hexadecimal converter on Google.
f. Click Set and click OK.

16. Click Finish.
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Creation of a User Authentication Profile in Sterling External
Authentication Server

Follow the instructions in the procedure, Creating an LDAP Authentication
Definition to create a User authentication profile. Use the table below to identify
the values to assign in Sterling External Authentication Server.

Sterling External
Authentication Server Field Value to Assign

Authentication type LDAP

Profile name Name for the profile

Host Host name or IP address of the Active Directory server

Port Port number to connect to the Active Directory server

LDAP principal to bind Specify User DN

Replace base DN with the distinguished name where
users are stored, for example,
CN=Users,DC=example,DC=com.

Application Feature Lookup login credentials (Sterling) to configure user ID,
password, or routing key mapping.

User authenticated user
connection

Connection definition for the Active Directory server.

Specify query parameters Enable to allow you to define the query parameters.

Return Attributes Mapped credentials to return. By default, loginId,
loginPwd, and routingKeyName are returned.

Delete any attributes you don't want to map.

SSH Public Keys Creation
Assign SSH public keys to users in Active Directory (AD) when you require that a
trading partner who logs in to Sterling Secure Proxy through SFTP use Sterling
External Authentication Server authentication and uses either key or password and
key as the authentication method.

Complete the following procedures to configure SSH public keys in AD and
Sterling External Authentication Server:
v Assignment of SSH Public Keys
v SSH Key Authentication Profile Creation

Assignment of SSH Public Keys
Complete this procedure to add the SSH public keys to the Activity Directory (AD)
database.

Before you begin

Before you assign SSH public keys, you must extend the schema. Refer to
Extending Schema for Active Directory . Additionally, the ADSI Edit node and the
Domain node must exist. To check for the ADSI Edit node definition, open AD and
expand Console Root. Look for Domain node under ADSI Edit. If these nodes do
not exist, add them. Refer to Adding the ADSI Edit Node .
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Procedure

To assign SSH pubic keys:
1. Open MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Right-click the Domain node and click Update Schema Now.
5. Expand the node for your AD domain.
6. Expand the Users container.

Note: If users are stored in a different container, such as OU=External
Partners, navigate to that container and expand it.

7. Right-click the user to modify and select Properties.
8. Select sshPublicKey on the list and click Edit.
9. Open the SSH public key file.

10. Copy the base64 key and paste it into a new text document. The base64 key is
the lines between the BEGIN SSH2 PUBLIC KEY and END SSH2 PUBLIC
KEY markers, excluding lines that start with keywords like Comment.

11. Remove newlines from the text, leaving a single long line of base64 text.
12. Copy the single line of base64 text.
13. In MMC, paste the single line into the Value to add field and click Add.
14. Repeat step 8 through 12 for any other public keys. Click OK when all keys

have been added.
15. Click Apply to save changes, then click OK to close the Properties dialog.

SSH Key Authentication Profile Creation
Create an SSH key authentication profile in Sterling External Authentication Server
to use the SSH keys you configured in Active Directory (AD) to authenticate users.
Refer to the procedure, Creation and Management of SSH Key Authentication and
Mapping Definitions.

Use the following table to identify values to assign to the Sterling External
Authentication Server fields:

Sterling External
Authentication Server Field Value to Assign

Authentication type SSHKEY

Profile name Name for the profile

Name Automatically populated with sshPublicKeyQuery

Connection method Use globally defined connection

Global connection definition Definition you created for the LDAP server

Specify Query Parameters Allows you to specify query parameters

Base DN Distinguished name for the user container.

For example, CN=Users,DC=example,DC=com.

Application Feature Lookup login credentials (Sterling) to configure user ID,
password, or routing key mapping.

Use globally defined
connection

Connection definition for the Active Directory server
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Sterling External
Authentication Server Field Value to Assign

Specify query parameters Allow you to define the query parameters

Return Attributes Mapped credentials. By default, loginId, loginPwd, and
routingKeyName are returned. Delete attributes you don't
want to map.

Validating Certificates Stored in Active Directory
To validate users with certificates stored in Active Directory (AD), configure AD
and Sterling External Authentication Server to look up certificates through an
LDAP query. Add certificates to AD in one of the following ways:

Procedure
1. Publish third-party certificates to the Active Directory Enterprise Trust

When a certificate is published to the Active Directory Enterprise Trust, it is
added to the multi-value cACertificate attribute of the following object:
CN=NTAuthCertificates,CN=Public Key Services,CN=Services,CN=Configuration,
DC=<domain>,DC=<com>

2. Issue a certificate to a user through the domain's Certificate Service web site,
http://<dcname>/certsrv/.
When a user is issued a certificate through the Certificate Service web site, the
certificate data is stored in the userCertificate attribute on the AD user's record.
In addition, the subject of the issued certificate is set to the distinguished user
name.

Results

For each method used to store certificates in AD, you must define a certificate
validation profile to validate certificates based on where they are stored. In Sterling
Secure Proxy, you must define separate inbound nodes or adapters for clients that
have certificates published in the AD Enterprise Trust and for clients with
certificates issued through the Certificate Service web site.

You can add certificates to AD by publishing third-party certificates to the AD
Enterprise Trust.

Certificate Publishing to the Active Directory Enterprise Trust
Use the following procedures to publish certificates to the Active Directory
Enterprise Trust:
v Publishing Certificates
v Viewing Certificates Published to Active Directory Enterprise Trust
v Creation of an Sterling External Authentication Server Certificate Profile to

Validate Certificates in the AD Enterprise Trust
v Assigning Users to a Partner Certificate in the AD Enterprise Trust
v Creation of a Profile on Sterling External Authentication Server to Authenticate a

User ID with Certificate in Enterprise Trust

Publishing Certificates
To publish certificates to the AD Enterprise Trust:
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Procedure
1. Log in to the AD domain controller using an administrator account.
2. Run the following command:

certutil -dspublish -f filename NTAuthCA

where filename is the fully-qualified path to the certificate in text Base-64 or
binary DER format. Refer to http://support.microsoft.com/kb/295663 (Article
ID: 295663; How to import third-party certification authority (CA) certificates into the
Enterprise NTAuth store) for more information.

Viewing Certificates Published to Active Directory Enterprise
Trust

You can view certificates published to the Active Directory Enterprise Trust.

About this task

To view certificates:

Procedure
1. Log in to the AD domain controller. Use an administrator account.
2. Open the MMC.
3. Look for Certificates (Local Computer) under Console Root. If no certificate is

displayed, add it as follows:
a. Select File>Add/Remove Snap-in.
b. Click Add.
c. Select Certificates.
d. Click Add.
e. Enable Computer Account and click Next.
f. Enable Local computer.
g. Click Finish.
h. Select Enterprise PKI.
i. Click Add.
j. Click Close.

4. Expand Certificates (Local Computer).
5. Expand Enterprise Trust.
6. Select Certificates. The certificates are displayed in the list to the right of the

screen.

Creation of an Sterling External Authentication Server
Certificate Profile to Validate Certificates in the AD Enterprise
Trust

After you add certificates to the Active Directory (AD) Enterprise Trust, you must
create an Sterling External Authentication Server profile to use certificates stored in
the AD Enterprise Trust. Before you create the profile, be sure to define a
connection definition for the AD server. Use the following table to determine the
values to assign in Sterling External Authentication Server. Refer to Creation and
Management of Certificate Validation (CV) Definitions to Validate Certificates.
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Sterling External
Authentication Server
Field Value to Assign

Name Name for the CV definition, for example,
AD_CertVal_EnterpriseTrust.

Define query to verify
certificate subject

Verify the subject of a certificate using an attribute query.

Use defined connection Select the connection definition for your AD server.

Verify certificate matches
certificate in directory

Compare the certificate to the one stored in the directory
entry. Type cACertificate in the Certificate Attribute field.

Base DN The starting point in the directory to begin the search.

Type the following: CN=NTAuthCertificates,CN=Public Key
Services,CN=Services,CN=Configuration,DC=domain,DC=com
where domain and com are the values for your domain.

Return Attributes dn, cACertificate to define attributes to return from entries
that match.

Scope Select base to search only base DN entries.

Assigning Users to a Partner Certificate in the AD Enterprise
Trust

After you add a partner certificate to AD, you can assign users to the certificate.

About this task

To assign users to a certificate:

Procedure
1. Open the MMC.
2. Expand Active Directory users and computers.
3. Expand the node for your AD domain.
4. Expand the user container.

Note: If users are stored in different containers, such as OU=External
Partners, navigate to that container and expand it instead.

5. Double-click the user to assign the certificate to.
6. Select the Published Certificates tab.
7. Click Add from Store.
8. Select the partner certificate from the list.

Note: If the certificate list gets too large, it may be easier to select Add from
File, then select the file for the partner certificate. Be careful to select the
correct certificate file. Make sure that the certificate is published to the Active
Directory Enterprise Trust, or publish it immediately.

9. Click OK.
10. Click Apply to save changes.
11. Click OK to close the Properties dialog.
12. Repeat steps 5 to 11 for any other users you want to assign to the partner

certificate.
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Creation of a Profile on Sterling External Authentication
Server to Authenticate a User ID with Certificate in Enterprise
Trust

The previous procedures add the partner certificate data to the userCertificate
attribute of the Active Directory user object. You can now require that partner
users present a specific certificate for authentication by creating a user
authentication profile in Sterling External Authentication Server that compares the
certificate from the client against the certificate assigned to the user in Active
Directory.

In order to use this user authentication profile, a certificate validation request must
be issued before the user authentication request, and both requests must be issued
on the same conversation. Sterling Secure Proxy uses the policy definition when
selecting the External Authentication check boxes for both certificate validation and
user authentication, and specifying the corresponding profile names.

Use the definitions in the following table to complete the procedure. Refer to
Creation and Management of LDAP Authentication Definitions.

Sterling External
Authentication Server Field Value to Assign

Name Name for the profile, such as
AD_UserAuth_EnterpriseTrust

Protocol Appropriate protocol for accessing Active Directory

Host Host name or IP address of the AD domain controller

Port LDAP listen port number for the AD domain controller

LDAP principal to bind Specify user DN

Replace the base DN with the distinguished name of the
container where users are stored.

Attribute Query Definition fields

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection

Base DN {principal}

Return Attributes userCertificate

Scope Base

Attribute Assertion Definitions fields

Name Name for the assertion such as VerifyUserCertificate

Assertion “{attr[GetUserCertificate].userCertificate} ==

{attr[VerifyCertSubject].cACertificate}

This assertion compares the values of the userCertificate
attribute returned by the GetUserCertificate query against
the values of the cACertificate attribute returned by the
VerifyCertSubject query from the prior certificate
validation request for the client certificate. If one of the
values of the userCertificate attribute matches one of the
attributes of the cACertificate attributes returned by the
VerifyCertSubject query, the assertion succeeds.
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Validation of Certificates Issued by Windows Certificate Service Web
Site

When a user is issued a certificate through the Certificate Service web site, the
certificate data is stored in the userCertificate attribute on the AD user's record. In
addition, the subject of the issued certificate is set to the distinguished user name.

Viewing Certificates Issued by Windows Certificate Service
Web Site

To view certificates:

Procedure
1. Log in to the domain controller. Use an administrator account.
2. Open the MMC.
3. Look for Certification Authority (Local) under Console Root. If it is not found,

add it as follows:
a. Select File>Add/Remove Snap-in.
b. Click Add.
c. Select Certification Authority.
d. Click Add.
e. Enable Local computer.
f. Click Finish.
g. Click Close.

4. Expand Certification Authority (Local).
5. Expand the node for the CA.
6. Select Issued Certificates. The certificates are displayed to the right.

Creation of a Profile in Sterling External Authentication Server
to Validate Certificates Issued by a Certificate Service Web
Site

Create a profile to validate certificates issued by a certificate service web site. Refer
to Create and Creation and Management of Certificate Validation (CV) Definitions
to Validate Certificates.

Use the following table to identify the values to assign in Sterling External
Authentication Server.

Sterling External
Authentication Server
Field Value to Assign

Name Name for the CV definition, for example,
AD_CertVal_InternalUser

Subject Verification Query Dialog

Define query to verify
certificate subject

Define the attributes to use to verify a certificate subject

Certificate subject is a
valid DN in directory

Use a valid DN to validate certificate

Use defined connection Enable this option and select the definition for your AD server
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Sterling External
Authentication Server
Field Value to Assign

Verify certificate matches
certificate in directory.

Makes sure that the certificate presented by the user matches
the certificate in AD.

Creation of a Profile in Sterling External Authentication Server
to Authenticate a User ID with a Certificate in the AD User
Record

Create an authentication definition to create a query to return the userCertificate
attribute of the user record and an assertion to verify that the certificate sent by the
client matches one of the certificates assigned to the user.

The assertion compares the value(s) of the userCertificate attribute returned by the
GetUserCertificate query against the value(s) of the userCertificate attribute
returned by the VerifyCertSubject query from the prior certificate validation
request for the client certificate. If one of the values of the userCertificate attribute
matches one of the attributes of the userCertificate attributes returned by the
VerifyCertSubject query, the assertion succeeds.

Refer to Creation and Management of LDAP Authentication Definitions for
instructions. Use the values in the following table to determine the values to assign
in Sterling External Authentication Server.

Sterling External
Authentication Server
Field Value to Assign

Name Name for the profile, such as AD_UserAuth_EnterpriseTrust

Protocol The appropriate protocol for accessing Active Directory

Host Host name or IP address of the AD domain controller

Port LDAP listen port number for the AD domain controller

LDAP principal to bind Specify user DN

Replace base DN with the distinguished name of the
container where users are stored, such as
CN=Users,DC=acme,DC=com.

Attribute Query Definition fields

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection

Base DN {principal}

Return Attributes userCertificate

Scope Base

Attribute Assertion Definitions fields

Name Name for the assertion such as VerifyUserCertificate
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Sterling External
Authentication Server
Field Value to Assign

Assertion “{attr[GetUserCertificate].userCertificate} ==

{attr[VerifyCertSubject].userCertificate}

This assertion compares the userCertificate attribute returned
by the GetUserCertificate query against the userCertificate
attribute returned by the VerifyCertSubject query from the
prior certificate validation request for the client certificate. If a
value in the userCertificate attribute matches an attribute of
the userCertificate returned by the VerifyCertSubject query,
the assertion succeeds.

Assurance that Only Authorized Users Can Access a Service
You can configure Sterling External Authentication Server to receive the name of
the service that the user requested during user authentication and SSH
authentication requests. You write a query to enforce that only users authorized to
use a service can log in to that service.

Consider the following sample directory structure:
DC=example,DC=com

CN=SEAS
CN=Service Groups

CN=HTTP-Service Users
ou=HTTP-Service
uniqueMember=cn=partneruser01,cn=Partner Users,dc=example,dc=com
uniqueMember=cn=partneruser02,cn=Partner Users,dc=example,dc=com

CN=FTP-Service and SSH-Service Users
ou=FTP-Service
ou=SSH-Service
uniqueMember=cn=partneruser03,cn=Partner Users,dc=example,dc=com
uniqueMember=cn=partneruser04,cn=Partner Users,dc=example,dc=com

In the directory structure, a container called Service Groups contains a list of
groups corresponding to services. Each group contains the distinguished names of
the user records that are members of the group. The ou attribute of the group
specifies the service name corresponding to the group.

The group HTTP-Service Users contains users that are allowed to access the service
called HTTP-Service. The group FTP-Service and SSH-Service Users contains users
allowed to access the services called FTP-Service and SSH-Service.

With this directory structure, you can define queries in Sterling External
Authentication Server user authentication profiles that make sure that members of
a group for a service can log in to that service.

Complete the procedures in this section to configure access to a service by
authorized users only:

Creating a Container for Service Groups
Create a container for service groups to define a list of groups corresponding to
services.
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Before you begin

Before you create a container for service groups, the ADSI Edit node and Domain
node must exist. To check for the ADSI Edit node definition, open AD and expand
Console Root. Look for Domain node under ADSI Edit. If these nodes do not exist,
add them. Refer to Adding the ADSI Edit Node .

About this task

To create a container for service groups:

Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Expand the node for your AD domain.
5. Find the parent container where you want to create the container (Ex: SEAS).

If it does not exist, create it as follows:
a. Right-click the node for your AD domain and select New>Object.
b. On the Create Object dialog, select the container class from the list.
c. Click Next.
d. Type the name for the parent container, such as SEAS.
e. Click Next.
f. Click Finish.

6. Right-click the parent container and select New>Object.
7. On the Create Object dialog, select the container class from the list.
8. Click Next.
9. Type the name for the container, such as Service Groups.

10. Click Finish.

Adding a User ID to a User Group for a Service in Active
Directory

Before you begin

Before you add a user ID to a group, the ADSI Edit and Domain nodes must exist.
To check for the ADSI Edit node, open AD and expand Console Root. Look for
Domain node under ADSI Edit. If they do not exist, add them. Refer to Adding the
ADSI Edit Node .

About this task

To add a user ID to a user group for an AD service:

Procedure
1. Open MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Expand the node for your AD domain.
5. Right-click the user you want to add to a group and select Properties.
6. Select distinguishedName on the attribute list.
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7. Click Edit.
8. Copy the value for the distinguished name.
9. Click Cancel twice.

10. Navigate to the container for the service groups and expand the node.
11. On the list to the right, find the group entry of the services where you want to

add the user, for example, CN=HTTP-Service Users. If it does not exist, add it
as follows:
a. Right-click the user groups container and select New>Object.
b. Select the groupOfUniqueNames class from the list and click Next.
c. Type a name for the group, such as, HTTP-Service Users.
d. Paste the distinguished name of the user record, for example,

cn=partneruser01,cn=Partner Users,dc=example,dc=com.
e. Click Next.
f. Click More Attributes.
g. Select ou from the Select a property to view field.
h. Type the service name, as it is configured on the destination service name

field on the Sterling Secure Proxy netmap, for example, HTTP-Service, and
click Add.

i. Repeat this step for other services to assign to the group.
j. Click OK.
k. Click Finish.

12. If a group entry for the service already exists, add the user to the group as
follows:
a. Double-click the group entry for the service.
b. Select uniqueMember on the list of attributes and click Edit.
c. Paste the distinguished name of the user record in the Value to add field.
d. Click Add.
e. Click OK.
f. Click Apply to save changes. Click OK to close the properties dialog.

Addition of a Query to an Sterling External Authentication
Server Authentication Profile to Validate the User ID and
Service

Add a query to an Sterling External Authentication Server authentication profile to
validate the user ID and service. This procedure assumes that you have already
created an authentication definition. Refer to Attribute Query Definition for
instructions.

Use the following table to determine the values to assign in Sterling External
Authentication Server:

Sterling External
Authentication Server
Field Value to Assign

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection

Specify query parameters To allow you to define the query parameters
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Sterling External
Authentication Server
Field Value to Assign

Base DN Type the distinguished name where service groups are stored,
for example, CN=Service
Groups,DC=SEAS,DC=example,DC=com.

Return Attributes dn

Scope Select One Level

Match Attributes Name=ou Value=destinationService

Name=uniqueMember Value={principal}

Allowed IP Addresses Check
Sterling External Authentication Server receives the incoming IP address of
partners during certificate, user, and SSH key authentication requests. You can
define queries on profiles to make sure an incoming IP address is an allowed IP
address and allow the request only if the IP address is allowed.

Consider the following sample directory structure:
DC=example,DC=com

CN=SEAS
CN=Allowed Hosts

CN=partnerhost01
ipNetworkNumber=xxx.xxx.xxx.xxx

CN=partnerhost02
ipNetworkNumber=yyy.yyy.yyy.yyy

CN=zzz.zzz.zzz.zzz
ipNetworkNumber=zzz.zzz.zzz.zzz

In the directory structure, a container called Allowed Hosts identifies the IP
addresses that can access the system. Each entry in the container defines an IP
address. An LDAP query is then defined to check for allowed IP addresses.

After a valid IP address is found, you can then verify that the client certificate,
public SSH key, or user ID is associated with the IP address.

You can configure user IDs and identify IP addresses to use for log in. The easiest
way to configure IP addresses allowed is to add the ipHost class as an auxiliary to
the user class. This adds the multi-value ipHostNumber attribute to the user class.
The IP addresses assigned to the user can be added to this attribute.

Complete the procedures in this section to configure Sterling External
Authentication Server to validate IP addresses from inbound nodes and determine
if they are allowed.

Creating a Container for Allowed Hosts in AD
Use this procedure to create a container for allowed hosts.

Before you begin

Before you add IP addresses, the ADSI Edit and Domain nodes must exist. To
check for the ADSI Edit node, open AD and expand Console Root. Look for
Domain node under ADSI Edit. If these nodes do not exist, add them. Refer to
Adding the ADSI Edit Node .
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About this task

To create a container for allowed hosts in AD:

Procedure
1. Open MMC.
2. Expand the ADSI Edit container.
3. Expand the Domain node.
4. Find the parent node where the container for allowed hosts will be created. If it

does not exist, create it as follows:
a. Right click the node for your AD domain and select New>Object.
b. On the Create Object dialog, select the container class from the list.
c. Click Next.
d. Type the name for the parent container.
e. Click Next.
f. Click Finish.

5. Right click the parent container and select New>Object.
6. On the Create Object dialog, select the container class from the list and click

Next.
7. Type the name for the hosts container, for example, Allowed Hosts.
8. Click Finish.

Adding an IP Address to an Allowed Hosts Container in AD
After you create the host container, add the IP addresses to the container to
identify the IP addresses that are allowed.

Before you begin

Before you add IP addresses, the ADSI Edit node and the Domain node must exist.
To check for the ADSI Edit node definition, open AD and expand Console Root.
Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

About this task

To add an IP address to an allowed host:

Procedure
1. Open MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Right click the container for the hosts, for example Allowed Hosts, and select

New>Object.
5. On the Create Object dialog, select ipNetwork class.
6. Click Next.
7. Type a name for the host record. Use a value that identifies the record, such as

DNS host name or IP address.
8. Click Next.
9. Type the IP address for the partner host.
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10. Click Next.
11. Click Finish.

Addition of a Query to a Sterling External Authentication
Server Profile to Check for Allowed IP Addresses

Define a query to look up the incoming IP address on the Allowed Hosts container.
If the IP address is found, the query is successful and the dn attribute of the host
record is returned. If the IP address is not found, the query fails and the certificate
validation, user authentication, or SSH key authentication request fails.

Complete the procedure, Attribute Query Definition, to add the query. Use the
values in the following table to configure Sterling External Authentication Server.
Create an authentication definition before you define the query definition.

Sterling External
Authentication Server
Field Value to Assign

Name Name of the attribute query definition.

Connection Specification Use globally defined connection

Select the connection definition for the AD server.

Specify query parameters Enable this option to allow you to define the query
parameters.

Base DN Distinguished name where service groups are stored, for
example, CN=Allowed
Hosts,DC=SEAS,DC=example,DC=com.

Return Attributes dn

Scope One Level

Match Attributes Name=ipNetworkNumber Value=IpAddress

Adding ipHost as an Auxiliary Class to the User Class
Before you begin

Be sure an Active Directory schema exists. Refer to Adding an Active Schema
Node.

About this task

To add IP addresses allowed to the ipHost class:

Procedure
1. Log in to the AD domain as administrator and as a member of the Schema

Admins group.
2. Open MMC.
3. Click Classes.
4. Right click user the list and select Properties.
5. Select the Relationship tab.
6. Click Add Class next to Auxiliary classes.
7. Select ipHost on the list and click OK.
8. Click Apply to save the changes and click OK to close the Properties dialog.
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9. Right-click the Active Directory Schema node and select Reload the Schema.

Assigning an IP Address to a User
Before you begin

Before you add IP addresses, the ADSI Edit node and the Domain node must exist.
To check for the ADSI Edit node definition, open AD and expand Console Root.
Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

About this task

To assign an IP address to a user:

Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. If you just added the ipHost class as an auxiliary class to the user class, in the

procedure Adding ipHost as an Auxiliary Class to the User Class, right-click
the Domain node and select Update Schema Now.

5. Expand the node for your AD domain.
6. Expand the Users container.

Note: If you store users in a different container, (ex: OU=External Partners),
navigate to that container, and expand it instead.

7. Right-click the user that you want to modify and select Properties.
8. Select the ipHostNumber attribute and type Edit.
9. In the Value to add field, type the IP address and click Add.

10. Repeat step 9 for other IP addresses. Click OK when all IP addresses have
been added.

11. Click Apply to save the changes and click OK to close the Properties dialog.

Addition of a Query to the User Authentication Profile to
Validate an IP Address and User ID

This procedure assumes that you have already created a user authentication
definition. Complete the procedure, Attribute Query Definition to create an
assertion to compare the incoming IP address against the IP addresses assigned to
the user. The assertion examines the ipHostNumber attribute of the user record. If
it is equal to any of the values, it returns true. If it is not, it compares the incoming
IP address against the value(s) in the ipHostNumber attribute. If the IP address is
found in any of the values stored in the ipHostNumber attribute, the assertion
succeeds. Otherwise, the assertion fails, and the user validation request also fails.

Use the values in the following table to determine the values to assign in Sterling
External Authentication Server:

Sterling External
Authentication Server Field Value to Assign

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection
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Sterling External
Authentication Server Field Value to Assign

Specify query parameters To define the query parameters

Base DN {principal}

Return Attributes dn, ipHostNumber

Scope Base

Attribute Assertions Definitions

Name Name for the assertion

Assertions {attr[FindUserIPAddrs].ipHostNumber} == any ||

{attr[FindUserIPAddrs].ipHostNumber} == {ipAddress}

Verification that a Certificate Is Associated with an IP Address
After an incoming IP address is validated, you can further validate the user by
verifying that the certificate presented by the client is associated with the IP
address.

Consider the following sample directory structure:
DC=example,DC=com

CN=SEAS
CN=Allowed Hosts

CN=acmehost01
ipNetworkNumber=xxx.xxx.xxx.xxx

CN=acmehost02
ipNetworkNumber=yyy.yyy.yyy.yyy

CN=internalhost01
ipNetworkNumber=aaa.aaa.aaa.aaa

CN=Host Groups
CN=Acme Inc Hosts

o=Acme Inc
uniqueMember=cn=acmehost01,cn=Allowed Hosts,cn=SEAS,dc=example,dc=com
uniqueMember=cn=acmehost02,cn=Allowed Hosts,cn=SEAS,dc=example,dc=com

CN=No Org Hosts
o=none
uniqueMember=internalhost01,cn=Hosts,cn=SEAS,dc=example,dc=com

In the directory, a container called Allowed Hosts contains IP addresses that access
the system.

Another container called Host Groups contains groups corresponding to partner
organizations. The groups contain the distinguished name of the host records (IP
addresses) that are valid for that organization. The organization name is specified
in the o attribute.

The group called Acme Inc Hosts contains host IP addresses that present
certificates with O=Acme Inc in the subject. The group No Org Hosts contains host
IP addresses that present certificates with no organization.

With this directory structure, you can add a query to the certificate validation
profiles to enforce the rule that only the IP addresses assigned to a certificate's
organization can log in.
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Complete the procedures in this section to configure the ability to verify that a
certificate is associated with an IP address:

Creating a Container for Host Groups in AD
Before you begin

Before you complete this procedure, the ADSI Edit node and the Domain node
must exist. To check for the ADSI Edit node, open AD and expand Console Root.
Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

About this task

Use this procedure to create a container for host groups that contains a list of
groups corresponding to partner organizations. After you create the container, use
the procedure Adding an IP Address to a Host Group in Active Directory.

To create a container for host groups:

Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Find the parent node under which you would like to create the hosts container,

for example, SEAS. If the node is not found, create it as follows:
a. Right-click the node for your AD domain and select New>Object.
b. On the Create Object dialog, select the container class from the list.
c. Click Next.
d. Type the name for the parent container, for example SEAS.
e. Click Next.
f. Click Finish.

5. Right-click the parent container and select New>Object.
6. On the Create Object dialog, select the container class from the list.
7. Click Next.
8. Type the name for the host groups container, such as Host Groups.
9. Click Finish.

Adding an IP Address to a Host Group in Active Directory
After you create a host container, you add IP addresses that are valid for that
particular organization.

Before you begin

Before completing this procedure, the ADSI Edit and Domain nodes must exist. To
check for the ADSI Edit node definition, open AD and expand Console Root. Look
for Domain node under ADSI Edit. If these nodes do not exist, refer to Adding the
ADSI Edit Node .

About this task

To add an IP address to the host group you created:
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Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Expand the container for the hosts.
5. Find the record for the IP address in the hosts container. If it is not there, add

it as follows:
a. Right click the hosts container and select New>Object.
b. On the Create Object dialog, select ipNetwork from the list.
c. Click Next.
d. Type a name for the host record. Use any name that identifies the record,

like the DNS host name or the IP address.
e. Click Next.
f. Type the IP address for the partner host.
g. Click Next.
h. Click Finish.

6. Right click the record for the IP address and click Properties.
7. Select distinguishedName from the attribute list and click Edit.
8. Copy the value for the distinguishedName attribute to the clipboard.
9. Click Cancel twice.

10. Navigate to the container for the host groups and expand the node.
11. On the list to right, find the group entry corresponding to the organization of

the host you are adding, for example, CN=Acme Inc Hosts. If it does not exist,
add it as follows:
a. Right-click the host groups container and select New>Object.
b. Select the groupOfUniqueNames class from the list and click Next.
c. Type a name for the group, for example, <organization> Hosts. If the

certificate has no organization, type a name to identify this, for example,
No Org Hosts.

d. Paste the distinguished name of the partner host record that you copied in
step 8.

e. Click Next.
f. Click More Attributes.
g. Select o (organization) from the Select a property to view field.
h. Type the organization name, as it appears on the subject of the partner

certificate, for example, Acme Inc. If the certificate has no organization,
type none.

i. Click Add.
j. Click OK.
k. Click Finish.

Addition of a Query to Validate an IP Address and Certificate
Before you begin

This procedure assumes that you have already created a certificate authentication
definition and a user authentication definition. Complete the procedure, Attribute
Query Definition to create an assertion to compare the incoming IP address against
the list of IP addresses assigned to the user.
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About this task

The FindHostGroup query you define looks up the host group corresponding to
the certificate's organization and including the incoming IP address as a member. If
the group is not found, the certificate validation request fails.

Use the values in the following tables to determine the values to assign in Sterling
External Authentication Server. Use the first set of values to define the query to
look up an incoming IP address and the second values to create a query to find the
host group for the certificate's organization. When you add the queries you
defined, place the first query called FindHostDN first in the order and
FindHostDN second in the list.

Table 1. Values Used to Lookup an Incoming IP Address

Sterling External
Authentication Server Field Value to Assign

Name Name of the attribute query definition, for example,
FindHostDN.

Connection Specification Use globally defined connection

Select the connection definition for the AD server.

Specify query parameters To define the query parameters

Base DN Distinguished name for the hosts container, for example,
CN=Allowed Hosts,CN=SEAS,DC=example,DC=com.

Return Attributes dn, flags

Scope One Level

Match Attributes Name=ipNetworkNumber Value=IpAddress

Attribute Assertions
Definitions

Name Name for the assertion

Assertions {attr[FindUserIPAddrs].ipHostNumber} == any ||

{attr[FindUserIPAddrs].ipHostNumber} == {ipAddress}

Table 2. Values Used to Query the Host Group for Certificate's Organization

Sterling External
Authentication Server Field

Value to Assign

Name Name of the attribute query definition, for example,
FindHostGroup

Connection Specification Use globally defined connection

Select the connection definition for the AD server

Specify query parameters To define the query parameters

Base DN Distinguished name for the hosts group, for example,
CN=Host Groups,CN=SEAS,DC=example,DC=com).

Return Attributes dn, uniqueMember

Scope One Level

Chapter 5. Configuration of Active Directory to Prepare for Use with Sterling External Authentication Server 59



Table 2. Values Used to Query the Host Group for Certificate's Organization (continued)

Match Attributes Name=o Value=I{subject.o, none}

Name uniqueMember Value= {attr[FindHostDN].dn}
Note: If a certificate subject does not define an
organization, set the value to None. To group hosts for
certificates with no organizations, create a host group called
No Org Hosts and set the o attribute to none.

Authentication to Check for a Valid IP Address and an Associated SSH
Key

After an incoming IP address has been validated, it can be further validated by
verifying that the public SSH key presented by the client is associated with that IP
address.

Consider the following sample directory structure:
DC=example,DC=com
CN=SEAS

CN=Allowed Hosts
CN=sshhost01

ipNetworkNumber=aaa.aaa.aaa.aaa
CN=sshhost02

ipNetworkNumber=bbb.bbb.bbb.bbb
CN=sshhost03

ipNetworkNumber=ccc.ccc.ccc.ccc

CN=SSH Public Key Groups
CN=Keys for sshhost01

sshPublicKey=<...>
sshPublicKey=<...>
sshPublicKey=<...>

:
uniqueMember=cn=sshhost01,cn=Hosts,cn=SEAS,dc=example,dc=com

CN=Keys for sshhost02 and sshhost03
sshPublicKey=<...>
sshPublicKey=<...>
sshPublicKey=<...>

:
uniqueMember=cn=sshhost02,cn=Hosts,cn=SEAS,dc=example,dc=com
uniqueMember=cn=sshhost03,cn=Hosts,cn=SEAS,dc=example,dc=com

In the directory structure, a container called Allowed Hosts contains IP addresses
with access to the system. A container called SSH Public Key Groups contains a
groups corresponding to SSH public keys. The groups contain the distinguished
name of the host records (IP addresses) that are valid for the SSH public keys.

Complete the procedures in this section to configure this authentication method:

With such a directory structure, you can add a query to the SSH key authentication
profile to enforce only the IP addresses specifically assigned to an SSH public key
can log in.

Creating a Container for SSH Public Keys in AD
Create a container for SSH Public Key that contains groups corresponding to SSH
public keys.
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About this task

Note: Before you complete this procedure, the ADSI Edit node and Domain node
must exist. To check for the ADSI Edit node, open AD and expand Console Root.
Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

To create a container to store SSH public keys in AD:

Procedure
1. Open the MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Expand the node for your AD domain.
5. Find the parent container where you create the container for the keys, for

example, SEAS. If the container has not been created, create it as follows:
a. Right-click the node for your AD domain and select New>Object.
b. On the Create Object dialog, select the container class from the list.
c. Click Next.
d. Type a parent container name.
e. Click Next.
f. Click Finish.

6. Find the parent node where you want to create the host container. This
container is created for directory organization purposes only. If the node is not
found, create it as follows:
a. Right click the node for your AD domain and select New>Object.
b. On the Create Object dialog, select the container class from the list
c. Click Next.
d. Type the name for the parent container (Ex: SEAS).
e. Click Next.
f. Click Finish.

7. On the Create Object dialog, select the container class from the list and click
Next.

8. Type a name for the container, for example, SSH Public Keys.
9. Click Finish.

Adding an ldapPublicKey to the groupOfUniqueNames Class
as an Auxiliary Class

To use the sshPublicKey attribute in an object, add the ldapPublicKey class as an
auxiliary to the object's class. Because you use the groupOfUniqueNames class to
store SSH public key group, you add the ldapPublicKey class as an auxiliary to the
groupOfUniqueNames class.

About this task

Note: Make sure an Active Schema node exists. To search for a node, open MMC.
Look for the Active Directory Schema node under Console Root. If it does not
exist, create it. Refer to Adding an Active Schema Node .

To add an ldapPublicKey to the groupOfUniqueNames:
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Procedure
1. Log in to the AD domain with an administrator account that is a member of

the Schema Admins group.
2. Open the MMC.
3. Click Classes.
4. Right click the groupOfUniqueNames class on the list and select Properties.
5. Select the Relationship tab.
6. Press Add Class next to Auxiliary classes.
7. Select the ldapPublicKey class on the list and click OK.
8. Click Apply to save the changes and click OK to close the Properties dialog.
9. Right-click Active Directory Schema node and select Reload the Schema.

Adding an IP Address and SSH Public Key to a Group in
Active Directory

After you add the SSH Public Key container, you then add the distinguished name
of the host records (IP addresses) that are valid for the SSH public keys in by the
group.

About this task

Note: Before you complete this procedure, the ADSI Edit node and the Domain
node must exist. To check for the ADSI Edit node, open AD and expand Console
Root. Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

To add an IP address and SSH public key to a group:

Procedure
1. Open MMC.
2. Expand ADSI Edit.
3. Expand the Domain node.
4. Right click the Domain node and select Update Schema Now.
5. Expand the container for the hosts, for example Allowed Hosts, and find the

record for the IP address in the hosts container. If it does not exist, add it as
follows:
a. Right click the hosts container and select New>Object.
b. On the Create Object dialog, select the ipNetwork class from the list.
c. Click Next.
d. Type a name for the host record, for example, the DNS host name or IP

address.
e. Click Next.
f. Type the IP address for the partner host.
g. Click Next.
h. Click Finish.

6. Right click the record corresponding to the IP address and click Properties.
7. Select distinguishedName from the attribute list and click Edit.
8. Copy the value for the distinguishedName attribute and click Cancel twice.
9. Navigate to the SSH public key groups container and expand the node.
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10. On the list to the right, find the group entry corresponding to the host you are
adding. If the group does not exist, add it as follows:
a. Right click the SSH public key groups container and select New>Object.
b. Select the groupOfUniqueNames class from the list and click Next.
c. Type a name for the group, for example, Keys for <host>.
d. Paste the distinguished name of the partner host record that you copied in

step 8.
e. Click Next.
f. Click Finish.

11. Double-click the group entry.
12. Select sshPublicKey on the list of attributes and click Edit.
13. Select sshPublicKey on the Select a property to view field.

Note: If the sshPublicKey attribute is not listed, you either did not add the
ldapPublicKey class as an auxiliary to the groupOfUniqueNames class, or you
did not reload an updated schema.

14. Open the SSH public key file and copy the base64 key to the clipboard.
The base64 key are the lines between the BEGIN SSH2 PUBLIC KEY and END
SSH2 PUBLIC KEY markers, excluding lines that start with keywords, like
Comment.

15. Paste the copied text into a new text document.
16. Remove any new lines from the pasted text. This creates a single long line of

base64 text.
17. Copy the single line of base64 text and paste it into the Value to add field.
18. Click Add.
19. Click OK.
20. Click Apply.
21. Click OK to save changes.

Query to an SSH Key Authentication Profile to Validate the IP
address and SSH Public Key

Complete the procedure, Attribute Query Definition to add a query to validate the
IP address and SSH public key. The FindSSHKeyGroup query looks up the SSH
pubic key group with the key sent by the client including the IP address. If the
group is not found, key authentication request fails.

Use following table to determine the values to define in the Attribute Query:

Sterling External
Authentication Server Field Value to Assign

Name Name for the attribute query definition.

Connection Specification Use globally defined connection

Select the connection definition for the AD server

Specify query parameters To define the query parameters

Base DN Type the distinguished name for the host containers for
example, CN=Allowed
Hosts,CN=SEAS,DC=example,DC=com

Return Attributes dn, flags

Chapter 5. Configuration of Active Directory to Prepare for Use with Sterling External Authentication Server 63



Sterling External
Authentication Server Field Value to Assign

Scope One Level

Match Attributes Name=ipNetworkNumber Value=IpAddress

Select the query you created and move it to the first position in the list.

Sterling External
Authentication Server Field Value to Assign

Name Name for the attribute query definition, such as,
FindSSHKeyGroup.

Connection Specification Use globally defined connection

Select the connection definition for the AD server

Specify query parameters To define the query parameters

Base DN Distinguished name for the SSH public key groups for
example, CN=SSH Public Key
Groups,CN=SEAS,DC=example,DC=com

Return Attributes dn

Scope One Level

Match Attributes Name=sshPublicKey Value=sshPublicKey_b64

Name=uniquemember value=FindHostDN

Select the query you created and move it to the second position in the list.

Service Principal Definitions for a Change Password Definition
Define an account with the following permissions for the service principal:

Database Used Permission Values

Active Directory 2003 v Read the global domain password policy

v Read the userAccountControl and pwdLastSet attributes on
other users' records

v On AIX, permission to modify other user's passwords

Obtain the permissions using an administrative account or a
normal user with permissions through delegation of control

Active Directory 2008 v Read the global domain password policy

v Read fine-grained password policies

v Read the userAccountControl, pwdLastSet, and
msDS-ResultantPSO on other users' records

v On AIX, permission to update other user's passwords

Obtain the permissions using an administrative account or a
normal user with permissions through delegation of control
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About Changed Password
After a password is changed, the old password can bind to Active Directory and
access network resources for up to one hour. For one hour after a password is
changed, the user can be authenticated with either the old or new password.

You can change how long the old password can be used using the Registry key in
the domain controller called HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Control\Lsa\OldPasswordAllowedPeriod

Set to value to 0 to prevent old passwords from being used to authenticate the
user.

For more information, refer to: http://support.microsoft.com/kb/906305/en-us.

Delegation of Control
Create a service account for Sterling External Authentication Server and specify the
account in the Service Principal Bind Information on the Change Password
settings, instead of using an administrative account. Delegate control be to this
account to allow it to read other user attributes and read the fine-grained
password policy in AD 2008 as well as change other users' passwords when
Sterling External Authentication Server is installed on AIX.

Creating a Service Account
To create a service account for Sterling External Authentication Server:

Procedure
1. On the domain controller, be sure to log in as a domain administrator. Select

Start>Programs>Administrative Tools>Active Directory Users and
Computers.

2. Right click the user container where the service account will be added and
select New>User.

3. Type a user ID in the User logon name field and a full name. Click Next.
4. Type a password for the account.
5. Disable the User must change password at next logon field.
6. Enable the Password never expires field.
7. Click Finish.

Delegating Control of the Sterling External Authentication
Server Service Account

To delegate control to the Sterling External Authentication Server service account:

Procedure
1. Right click the folder containing the users authenticated by Sterling External

Authentication Server (Ex: Partner Users) and select Delegate control. Click
Next

2. Click Add on the Users or Groups page.
3. Type the Sterling External Authentication Server service account name on the

Enter object names to select edit field (Ex: seas) and click Check Names. The
Sterling External Authentication Server service account should be resolved and
underlined.
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4. Click OK.
5. Click Next on the Users or Groups page.
6. If Sterling External Authentication Server is installed on AIX, enable Reset user

passwords and force password check at next logon.
7. Enable Read all user information.
8. Click Next.
9. Click Finish.

Configuring a Password Policy in Active Directory 2003 and 2008
In Active Directory 2003, the password policy is global and applies to all users of
the domain. It is not possible to define password policies for individual users or
groups.

About this task

To configure password policy:

Procedure
1. On the domain controller, while logged in as a domain administrator, launch

the Microsoft Management Console.
2. Under Console Root, expand the Group Policy Management node. If not there,

add it. Refer to as follows:
a. Select File>Add/Remove Snap-in.
b. Click Add.
c. Select Group Policy Management.
d. Click Add.
e. Click Close.
f. Click OK.

3. Expand the Forest node.
4. Expand Domains node.
5. Right click the node for the domain and select Create and Link a GPO here.
6. On the New GPO dialog, type a name for the policy and OK.
7. Right click the policy you created and click Edit.
8. On the Group Policy Object Editor window, on the tree to the left, expand

Computer Configuration > Windows Settings > Security Settings > Account
Policies.

9. Click Password Policy.
10. To enable each policy setting:

a. Double-click each policy setting to the right.
b. Enable Define this policy setting.
c. Type a value for the setting.
d. Click OK.
e. Close the Group Policy Editor window.

11. Right click the new policy and click Enforced.
12. Click OK on the confirmation message box
13. Click the move up icon (single triangle icon on the left) until the new policy is

positioned before the Default Domain Policy.
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14. Right click the Default Domain Policy and click Edit.
15. On the Group Policy Object Editor window, expand Computer

Configuration>Windows Settings>Security Settings>Account Policies.
16. Click Password Policy.

17. To disable each policy setting
a. Double-click each policy setting on the list to disable all settings:
b. Disable Define this policy setting.
c. Click OK.
d. After disabling all settings, close the Group Policy Editor window.

Fine-Grained Password Policy Configuration in AD 2008
The global domain password policy for Active Directory 2008 is configured the
same as in Directory 2003.

Active Directory 2008 provides the ability to define fine-grained password policies
that can be applied to individual users or global security groups to override the
global domain password policy. Before fine-grained password policies can be
defined, the domain controller functional level must be raised to Microsoft
Windows 2008.

Raising the Domain Controller Functional Level to Microsoft
Windows 2008

To raise the domain controller functional level:

Procedure
1. Select Start>Programs>Administrative Tools>Active Directory Domains and

Trusts.
2. Select the domain node under Active Directory Domains and Trusts root node.
3. Right click the domain and select Raise Domain Functional Level.
4. Select Windows 2008 and click Raise.
5. Click OK on the warning message.
6. Click OK on the confirmation message.

Creating a Fine-grained Password Policy
Before you begin

Before you complete this procedure, the ADSI Edit node and the Domain node
must exist. To check for the ADSI Edit node, open AD and expand Console Root.
Look for Domain node under ADSI Edit. If these nodes do not exist, refer to
Adding the ADSI Edit Node .

About this task

To create a fine-grained password policy:

Procedure
1. While logged in as a domain administrator, launch MMC.
2. Under Console Root, expand the ADSI Edit node.
3. Expand the Default naming context node.
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4. Expand the DC=domain node.
5. Expand the System node
6. Double click CN=Password Settings Container.

The list of currently defined policies is displayed.
7. Right click CN=Password Settings Container and select New>Object.
8. Select the msDS-PasswordSettings class and click Next.
9. Type a name for the policy and click Next.

10. Type values for the following fields and click Next after each definition:
v msDS-PasswordSettingsPrecedence—Number greater than 0 to determine

which policy to apply when a user is assigned more than one policy. Active
Directory does not merge policies into one policy.

v msDS-PasswordReversibleEncryptionEnabled—Type false.
v msDS-PasswordHistoryLength—Type a number to define how many

passwords to keep in history. When the user changes the password, a
password in this list cannot be reused.

v msDS-PasswordComplexityenabled—Type true if passwords must contain
characters from at least three of the following four character groups:
uppercase characters, lowercase characters, numeric characters, or special
characters.

v msDS-MinimumPasswordLength—Minimum characters required for
passwords.

v msDS-MinimumPasswordAge—How old a password must be before it can
be changed. Format is d:hh:mm:ss. For example, to specify 1 day, enter
1:00:00:00.

v msDS-MaximumPasswordAge—Maximum length of time a password can
be used before it expires. Format is d:hh:mm:ss. For example, to specify 30
days, enter 30:00:00:00.

v msDS-LockoutThreshold—How many invalid login attempts can occur
before the account is locked. 0 means the account is not locked.

v msDS-LockoutObsevationWindow—How long after an invalid login attempt
that system invalid login attempts are tracked. This value is reset when the
user logs in successfully. Format is d:hh:mm:ss. For example, to specify 5
minutes, enter 0:00:05:00.

v msDS-LockoutDuration—How long an account is locked after too many
invalid login attempts is reached. Format d:hh:mm:ss. For example, to
specify 30 minutes, enter 0:00:30:00.

11. Click Finish.
12. Right click the policy just added and select Properties.
13. Click the Security tab.
14. Click Add.
15. On the Enter object names to select field, type the Sterling External

Authentication Server service account name and click Check Names.
The Sterling External Authentication Server service account is resolved and
underlined.

16. Click OK.
17. Click Apply.
18. Click OK.
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Results

After a password policy is created, it can be assigned to individual users or global
security groups.

Assigning a Password Policy to a User or Global Security Group
Before you begin

Before you complete this procedure, the ADSI Edit node must exist. To check for
the ADSI Edit node, open AD and expand Console Root. Look for Domain node
under ADSI Edit. If these nodes do not exist, refer to Adding the ADSI Edit Node .

About this task

To assign a password policy:

Procedure
1. While logged in as the domain administrator, launch MMC.
2. Under Console Root, expand the ADSI Edit node.
3. Expand the Default naming context node.
4. Expand the DC=domain node.
5. Expand the System node.
6. Double-click CN=Password Settings Container.

The list of currently defined policies is displayed.
7. Right-click the policy you want to assign to a user or group and select

Properties.
8. On the Attributes tab, select msDS-PSOAppliesTo and click Edit.
9. Click Add Windows Account.

10. On the Enter the object names to select field, type a user ID or global
security group name and click Check Names.
If the user ID or the global security group exists, the name is resolved and
underlined.

11. Click OK twice.
12. Click Apply.
13. Click OK.

Results

For more information about fine-grained password policies, refer to
http://technet.microsoft.com/en-us/library/cc770842(WS.10).aspx.
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Chapter 6. Tivoli Configuration to Allow a User to Change a
Password in Sterling External Authentication Server

Complete procedures in this section to configure Tivoli and allow a user to change
his password in Sterling External Authentication Server.

Service Principal Definitions for a Change Password Definition
Define an account with the following permissions for the service principal:

Database Used Permission Values

IBM Tivoli Directory
Server

v Read the global password policy

v Read individual and group password policies

v Modify userPassword attribute of other users

v Read the pwdChangedTime, pwdReset, ibm-
pwdIndividualPolicyDN, and memberOf attributes

v Read the ibm-pwdGroupPolicyDN attributes from the group
records

Obtain permissions using an administrative account or a normal
user with permissions though an ACL.

IBM Tivoli 6.x Password Policy Configuration
IBM Tivoli version 6.x provides the ability to define individual and group
password policies that override the global password policy. The global password
policy is similar to the global password policy for version 5.x. The main difference
is that the distinguished name of the container holding the global password policy
changed to "CN=PWDPOLICY, CN=IBMPOLICIES" (versus "CN=PWDPOLICY" in
5.x), and the addition of a new attribute (ibm-pwdGroupAndIndividualEnabled)
that enables group and individual password policies.

Enabling Group and Individual Password Policies in Tivoli
Version 6.x

You can enable group and individual password policies in Tivoli Version 6.x.

Procedure

To enable group and individual password policies:

Run the following command on the directory server while logged in as root:
idsldapmodify -D admin DN -w admin password -k -f filename -h user://host:port

where filename is a file containing the following lines:
dn: cn=pwdpolicy,cn=ibmpolicies
ibm-pwdpolicy:true
ibm-pwdGroupAndIndividualEnabled:true
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Note: The ibm-pwdGroupAndIndividualEnabled attribute can only be modified
using the idsldapmodify command on the Directory server and while logged in as
root. It is not possible to modify this attribute through an LDAP editor (ex:
JXplorer or Apache Directory Studio).

If the -k flag is omitted, the command fails with error unwilling to perform.

Configuring the Global Password Policy in Tivoli Version 6.
To configure the global password policy:

Procedure
1. Use an LDAP editor (JXplorer or Apache Directory Studio) to connect to the

directory as the administrator.
2. Edit the CN=PWDPOLICY, CN=IBMPOLICIES container.
3. Set the ibm-pwdPolicy attribute to true to enable the global password policy.
4. Edit the following policy attributes to define desired policy settings:

v pwdAllowUserChange—true allows users to change their passwords. Users
must also have modify access to the userPassword attribute.

v pwdCheckSyntax—2 enables checking password syntax for complexity such
as minimum length and types of characters. 0 disables syntax checking.

v pwdMinLength—minimum password length. If 0, no minimum length is
enforced.

v passwordMinAlphaChars—minimum alphabetic characters required in the
password. If 0, password is not checked for alphabetic characters.

v passwordMinOtherChars—minimum numeric or special characters required
in the password. If 0, password is not checked for numeric or special
characters.

v passwordMaxRepeatedChars—maximum times a character can appear in the
password. If 0, password is not checked for repeated characters.

v passwordMaxConsecutiveRepeatedChars—maximum times a character can
appear consecutively. 0= password is not checked for consecutive characters.

v pwdInHistory—number of previous passwords remembered. A password
cannot be reused if it is in this list. 0=passwords can be reused indefinitely.

v passwordMinDiffChars—minimum characters that must be different from the
previous password. If 0, characters in the password are not checked against
the previous password.

v pwdMaxAge—maximum password age in seconds. Password expires after it
has been in use this long. If 0, password does not expire.

v pwdMinAge—minimum password age in seconds. Password cannot be
changed until it has been used for at least this amount of time. If 0,
password can be changed at any time.

v pwdMustChange—true if users must change their password after it has been
reset by an administrator. If true, pwdAllowUserChange must also be set to
true.

Giving Users Access to LDAP Attributes in Tivoli Version 6.x
To be able to change their own passwords, users must be given modify access to
the userPassword attribute and read access to the pwdLastChanged and pwdReset
operational attributes. This allows Sterling External Authentication Server to
determine when passwords expire, or whether passwords must be changed. Users
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must also have read access to ibm-pwdIndividualPolicyDN and
ibm-pwdGroupPolicyDN so to allow Sterling External Authentication Server to
retrieve the password policy.

About this task

To give users access to LDAP attributes in Tivoli:

Procedure
1. Type the following command on the Directory server while logged in as root:

idsldapmodify -D admin DN -w admin password -v -f filename

where filename is the file containing the following lines:
dn: ou=SEAS2.4,O=IBM,C=US
changetype: modify
replace: ibm-filterAclEntry
ibm-filterAclEntry: group:CN=ANYBODY:(objectclass=*):normal:rsc:system:rsc:restricted:
rsc:sensitive:rsc:critical:rsc
ibm-filterAclEntry: access-id:cn=this:(objectclass=*):at.userPassword:grant:w:
at.pwdChangedTime:grant:r:at.pwdReset:grant:r:at.ibm-pwdIndividualPolicyDN:
grant:r:at.ibm-pwdGroupPolicyDN:grant:r

2. Replace the sample dn value (ou=SEAS2.4,O=IBM,C=US) with the
distinguished name of the container where users are stored. Run this command
only once for each user container.

Creating a Group or Individual Password Policy in Tivoli
Version 6.x

To create a group or individual password policy:

Procedure
1. Use an LDAP editor (JXplorer or Apache Directory Studio) to connect to the

directory as the administrator.
2. Select the CN=IBMPOLICIES container.
3. Create a new entry under the CN=IBMPOLICIES container. To create a new

entry:
a. Select the following classes:

v container
v ibm-pwdPolicyExt
v pwdPolicy
v top

b. Type a name for the policy in the CN attribute.
c. Type the value of the mandatory pwdAttribute attribute to userPassword

4. Add one or more policy attributes you wish to override. Refer to Set the
ibm-pwdPolicy attribute to true to enable the global password policy. for a list
of attributes. In addition, you can set the following attribute:
ibm-pwdPolicy—true enables the policy.

Results

After a policy is created, it can be associated with any user or group.

Associating a Password Policy with a User
To associate a password policy with a user:
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Procedure
1. Type the following command on the Directory server while logged in as root:

idsldapmodify -D admin DN -w admin password -k -f filename

where filename is the file containing the following lines:
dn:cn=testUser,ou=Users,ou=SEAS2.4,O=IBM,C=US
changetype:modify
add:ibm-pwdIndividualPolicyDN
ibm-pwdIndividualPolicyDN:cn=testPwdPolicy_1,cn=ibmpolicies

2. Replace the value of the dn (cn=testUser,ou=Users,ou=SEAS2.4,O=IBM,C=US)
with the distinguished name of the user who you will assign the password
policy.

3. Replace the value of the ibm-pwdIndividualPolicyDN attribute
(cn=testPwdPolicy_1,cn=ibmpolicies) with the distinguished name of the
password policy you are assigning to the user. The ibm-
pwdIndividualPolicyDN attribute can only be set by running the
idsldapmodify command on the Directory server while logged in as root. It is
not possible to set this attribute through an LDAP editor. Only one password
policy can be assigned to a user at a time. If the user is a member of a group,
and the group has a policy, all attributes are merged and the most restrictive
attributes are enforced.

Associating a Group Password Policy with a Group
To associate a group password policy with a group:

About this task

Only one password policy is assigned to a group at a time. If a group is a member
of another group with its own policy, all attributes are merged and the most
restrictive attributes are enforced.

For information about a group policy and how the policy is constructed in Tivoli
6.x, refer to:

http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/
com.ibm.IBMDS.doc/toc.xml

Procedure
1. Type the following command on the Directory server while logged in as root:

idsldapmodify -D admin DN -w admin password -k -f filename

where filename is the name of a file containing the following lines:
dn:cn=testGroup,ou=Groups,ou=SEAS2.4,O=IBM,C=US
changetype:modify
add:ibm-pwdGroupPolicyDN
ibm-pwdGroupPolicyDN:cn=testPwdPolicy_1,cn=ibmpolicies

2. Replace the value of dn (cn=testGroup,ou=Groups,ou=SEAS2.4,O=IBM,C=US)
with the distinguished name of the group where you will assign the password
policy.

3. Replace the value of the ibm-pwdGroupPolicyDN attribute
(cn=testPwdPolicy_1,cn=ibmpolicies) with the distinguished name of the
password policy you are assigning to the group.

Note: The ibm-pwdGroupPolicyDN attribute can only be set by running
idsldapmodify on the Directory server while logged in as root. It cannot be set
through an LDAP editor.
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Chapter 7. Import of Sterling Connect:Enterprise Users into
Microsoft Active Directory

Sterling External Authentication Server enables you to import IBM Sterling
Connect:Enterprise® for UNIX users into Active Directory (AD). In addition, you
can update users in Active Directory and Tivoli.

Sterling Connect:Enterprise for UNIX Import Tool Configuration
To configure the Sterling Connect:Enterprise for UNIX import tool, update the
property file to identify where the file is located and how to connect to the LDAP
server. The property file is called ldapImportTool.properties.

Following is a sample file:
## LDAP HOST ip address
LDAP_SERVER_HOST=127.0.0.1

## LDAP SERVER PORT
LDAP_SERVER_PORT=636

## valid input : AD (Active Directory)| OTHER (Tivoli, OPEN LDAP,
## APACHE DIRECTORY, ...)
LDAP_SERVER_TYPE=AD

## LOCATION IN LDAP where users are stored
USER_BASE_DN=CN=Users,DC=SSPDomain,DC=labs

## ID of the LDAP Principal whose Credential is be used to run
## this tool
SERVICE_PRINCIPAL=CN=Administrator,CN=Users,DC=SSPDomain,DC=labs

## password of the LDAP Principal whose Credential is used to run
## this tool
SERVICE_PRINCIPAL_PASSWORD=ppppppp

## LDAP protocol : ldap|ldaps (non-secure and secured mode)
PROTOCOL=ldaps

## type of user to add to USER_BASE_DN
OBJECT_CLASSES=organizationalPerson,person,top,user
##OBJECT_CLASSES=top,person,organizationalPerson,inetOrgPerson

##common name attribute to represent users
USER_ATTRIBUTE=cn

## prefix to distinguish QA, Dev, production executing
## this tool (user created will be prefixed by this value)
USER_PREFIX=

## only apply search to users that match the pattern specified
SEARCH_FILTER=(&(objectClass=user)(sn=Oppeinhemer))

## for group operations, users will be added/removed from the
## specified group
GROUP_DN=CN=Dev Admin Group,ou=User Groups,DC=SSPDomain,DC=labs

## If overwrite is set to true, existing users or groups
## will be modified with new values
OVERWRITE=TRUE
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#the attribute for group operations (uniqueMember | member) for this server
MEMBER_ATTRIBUTE=uniqueMember

## location of input file for either the users to import
## or user attributes to update
INPUT_LOCATION=C:\\seas2300-10262009\\dist\\bin\\ceunixData.xml

## when adding users, the password attribute supported by the LDAP
## server
##PASSWORD_ATTRIBUTE=userPassword
PASSWORD_ATTRIBUTE=unicodePwd

##LDAP_IMPORT_HANDLER=com.sterlingcommerce.hadrian.client.CeunixDataImport
LDAP_IMPORT_HANDLER=com.sterlingcommerce.hadrian.client.ExternalDataImport

DATA_TRANSFORM_HANDLER=com.sterlingcommerce.hadrian.client.Ops3DES

Configure the attributes as needed for your environment. Following are the
attributes:

Attribute Description

LDAP_SERVER_HOST LDAP host IP address

LDAP SERVER PORT Port to use to connect to the LDAP server

LDAP_SERVER_TYPE Server type. Valid options: AD (Active Directory)| OTHER (Tivoli,
OPEN LDAP, APACHE DIRECTORY)

USER_BASE_DN Location in LDAP where users are stored

SERVICE_PRINCIPAL ID of the LDAP principal whose credential runs this tool

SERVICE_PRINCIPAL_PASSWORD LDAP principal's password
Note: Do not set this attribute and the user is prompted for the
password.

PROTOCOL LDAP protocol to use: ldap|ldaps (non-secure or secure)

OBJECT_CLASSES Type of user to add to the USER_BASE_DN

USER_ATTRIBUTE Common name attribute to represent users

USER_PREFIX Prefix to identify the department of the user running this tool.

SEARCH_FILTER Apply this search filter to users and apply the search to users that
match the pattern specified.

GROUP_DN=CN For group operations, users are added or removed from the specified
group.

OVERWRITE Determines if values are updated.

If this attribute is set to true, users or groups are modified with new
values. Valid values: TRUE or FALSE

MEMBER_ATTRIBUTE The attribute for group operations for this server. Value values:
uniqueMember | member

INPUT_LOCATION Location of file to import or update

PASSWORD_ATTRIBUTE Password attribute supported by the LDAP server, when adding a
user.

LDAP_IMPORT_HANDLER Performs an import operation. Following are handlers in the
migration tool:

v com.sterlingcommerce.hadrian.client.CeunixDataImport imports
Sterling Connect:Enterprise for UNIX users.

v com.sterlingcommerce.hadrian.client.ExternalDataImport updates
attributes of users.
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Attribute Description

DATA_TRANSFORM_HANDLER Decrypts a password associated with a Sterling Connect:Enterprise
for UNIX user during the import process. Sterling Connect:Enterprise
for UNIX passwords are encrypted and must be decrypted when
imported. This attributes allows you to specify a different transform
handler based on how the password is encrypted and how the input
is formatted.
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Chapter 8. Import of Users from Sterling Connect:Enterprise
for UNIX

When importing users from Sterling Connect:Enterprise for UNIX to IBM Sterling
B2B Integrator, the migration tool creates an export file that contains users,
passwords, and SSH keys. You then import this information into Active Directory.

Import users by adding users from a Sterling Connect:Enterprise for UNIX Export
file or obtaining information from a spreadsheet.

Adding Users from the Sterling Connect:Enterprise for UNIX Migration
Tool

To import users from the migration tool:

Procedure
1. From Sterling Connect:Enterprise for UNIX, copy the ceuexport file from the

$CMUHOME/migration directory to the SEAS_installdir/bin directory on
Sterling External Authentication Server. The file is called
ceuexport_Account.xml.

2. Add the following line to the ldapImportTool.properties file:
LDAP_IMPORT_HANDLER=com.sterlingcommerce.hadrian.client.CeunixDataImport

3. Update the INPUT_LOCATION to point to the import file.
4. Import users. Refer to Import of Users from Sterling Connect:Enterprise for

UNIX for instructions.

Adding or Updating Users from a Spreadsheet
To add or update users in Active Directory from a spreadsheet:

Procedure
1. Build a spreadsheet. Define user IDs and attributes to add to Active Directory.

a. Define a row of column headings, made up of Active Directory field names.
For example, the first column in the table below is CN and identifies the ID
to add.

b. Define additional columns for each field in AD where you want to import
information.

Following is a sample spreadsheet:

CN Company Department Telephone Number

PartnerA Widgets Unlimited Accounts Receivable 800-555-1111

PartnerB Widgets Unlimited Accounts Receivable 800-555-1112

sshkeyA Tools and Such Accounts Payable 800-555-2111

sshkeyB Tools and Such Accounts Payable 800-555-2112

sshpwdA Sky the Limit Operations 800-555-3111

sshpwdB Sky the Limit Operations 800-555-3112

sslscA Mom and Pop Sales 800-555-4111
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CN Company Department Telephone Number

sslscB Mom and Pop Sales 800-555-4112

2. Save the spreadsheet.
3. Save the spreadsheet again as a comment separated values file (*.csv).

Following is a sample:
CN,Company,Department,telephoneNumber
PartnerA,Widgets Unlimited,Accounts Receivable,800-555-1111
PartnerB,Widgets Unlimited,Accounts Receivable,800-555-1112
sshkeyA,Tools and Such,Accounts Payable,800-555-2111
sshkeyB,Tools and Such,Accounts Payable,800-555-2112
sshpwdA,Sky the Limit,Operations,800-555-3111
sshpwdB,Sky the Limit,Operations,800-555-3112
sslscA,Mom and Pop,Sales,800-555-4111
sslscB,Mom and Pop,Sales,800-555-4112

4. Copy the .csv file into the SEAS_installdir/bin directory.
5. Update the ldapImportTool.properties file with the following information:

LDAP_IMPORT_HANDLER=com.sterlingcommerce.hadrian.client.ExternalDataImport

6. Set the INPUT_LOCATION attribute to the name of the csv file.

Import of Users from Sterling Connect:Enterprise for UNIX
After you update the property file, you are ready to import users from Sterling
Connect:Enterprise for UNIX.

To import users into Microsoft Windows, type the following command in the
console:
ldapImportTool -f ldapImportTool.properties

To import users into UNIX, type the following command:
./ldapImportTool.sh -f ldapImportTool.properties

The Import tool logs errors to the Sterling External Authentication Server output
logs in SEAS_installdir/logs/seas.log. It produces an audit log of all updates it
makes to the AD database. The audit log is saved to SEAS_installdir/logs/audit/
auditlog.inc.
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Chapter 9. Sterling Connect:Enterprise for UNIX Data to
Sterling B2B Integrator or Sterling File Gateway Migration

If your data is stored on Sterling Connect:Enterprise for UNIX and you want to
move it to Sterling B2B Integrator or IBM Sterling File Gateway, IBM Services can
migrate your data.

Contact your IBM sales representative for more information.
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Chapter 10. Creation and Management of Certificate Validation
(CV) Definitions to Validate Certificates

Certificate Validation (CV) definitions specify how Sterling External Authentication
Server validates a certificate when a client application sends a validation request.
The request references a profile to specify the CV definition.

You can create definitions for LDAP attribute queries and attribute assertions, set
up access to CRLs, and configure how X.509 supported extensions and X.509
custom extensions are allowed or required during validation of a certificate. A CV
definition can include a custom exit to validate certificates using a Java class or an
operating system command. CV definitions can be used to implement
certificate-based routing for Sterling Secure Proxy by defining a special attribute
query. See Specifying Query Parameters for more information.

After Sterling External Authentication Server completes certificate validation steps,
it sends a message to the client application to indicate the success or failure. If
successful, Sterling External Authentication Server can use the conversation ID
associated with certificate validation results to access data as it processes a related
request for user authentication and authorization from the same client application.

Note: Configure Active Directory, LDAP, or Tivoli before you configure the CV
definition.

Creating a CV Definition
About this task

Certificate Validation (CV) definitions specify how Sterling External Authentication
Server validates a certificate sent by a client application. The request references a
profile to specify the appropriate CV definition. The definition must have the same
name as the profile referenced in the CV request.

To create a CV definition:

Procedure
1. From the Certificate Validation Definitions window, click the + icon.
2. On the General screen, specify the name.
3. If desired, type information in the following fields:

v Clock tolerance
v Expiration grace period
v Expiration warning
v Validate using custom exits
v Public key minimum key length

4. Specify how to validate certificates using the following parameters:
v Validate to root
v Validate to Trust Anchor
v Validate using custom exits
v Public key minimum key length
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5. Perform one of the following actions:
v To set up how Sterling External Authentication Server verifies a certificate

subject in an LDAP attribute query definition, click Next and go to
Specifying Certificate Subject Verification for an Attribute Query.

v If you selected Validate using custom exits, go to Specifying Certificate
Subject Verification for an Attribute Query.

v To create an LDAP attribute query without specifying how to verify the
subject of a certificate, go to Creation and Management of Attribute Queries
and Assertions.

Specifying Certificate Subject Verification for an Attribute Query
About this task

When you create a CV definition, you can preconfigure parameters to verify a
certificate subject. You can predefine part of an attribute query that locates a
directory entry associated with the certificate subject. When you create a definition,
Sterling External Authentication Server uses the certificate attributes specified to
automatically fill in related parameters. Create a CV definition before you complete
this procedure. Refer to Creating a CV Definition.

To specify verification of a certificate subject:

Procedure
1. From the Certificate Validation Definitions window, select the CV to modify.
2. Select one of the following options to define how an LDAP attribute query

verifies a certificate subject:
v Define query to verify certificate subject
v Search directory for certificate subject using these attributes
v Certificate subject is a valid DN in directory
v Other
v Use defined connection
v Verify certificate matches certificate in directory

3. Do one of the following:
v To create LDAP attribute queries and assertions, click Next. Go to Creation

and Management of Attribute Queries and Assertions.
v To skip creating attribute query definitions and attribute assertion definitions,

and reference CRLs, click Next twice. Go to Referencing a CRL Definition.
v To create a CRL for this CV definition, click the + icon and go to Creation

and Management of Certificate Revocation Lists (CRL) Definitions.

Referencing a CRL Definition
About this task

To create CRL definitions to reference in CV definitions, go to Creation and
Management of Certificate Revocation Lists (CRL) Definitions.

To reference an existing CRL definition:
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Procedure
1. From the Certificate Validation Definitions window, select the CV definition

where you want to reference the CRL and click .
2. Click the Referenced CRLs tab.
3. Select the CRL definition for this CV definition. Move it from the list on the left

to the right.
4. To configure a supported extension in the definition, click Next. Refer to

Configuring a Supported Extension for a CV Definition or Creating a Custom
Extension.

5. To complete the definition without configuring extensions, click Next until the
Confirm screen is displayed. Click Save. From the Finish screen, click Close.

Configuring a Supported Extension for a CV Definition
About this task

The KeyUsage, BasicConstraints, and CRLDistributionPoints certificate extensions
are supported and are listed with the corresponding object identifiers (OID) and
names on the Supported Extensions screen. For information on supported
extensions, see X.509 Extensions.

To configure a supported extension:

Procedure
1. From the Certificate Validation Definitions window, select the CV definition

where you configure a supported extension and click .
2. Click the Supported Extensions tab.
3. Select the extension to configure and click .
4. In the Properties dialog, specify the value of the CA, Client, or Server

extensions. Click OK.
5. To allow an extension to be used in a certificate, enable Allowed. The

validation does not fail if the extension is not in the certificate.
6. To require a certificate to have a specific extension, enable Required. The

validation fails if the extension is not in the certificate.
7. Disable both Allowed and Required to reject an extension.
8. Click OK.

Custom Extension for a CV Definition Configuration
Sterling External Authentication Server allows you to use custom certificate
extensions. Custom extensions are identified by object identifier (OID) and Name.
The key values used in the extensions are configurable. For detailed information
on custom extensions, see X.509 Extensions.

Creating a Custom Extension
To create a custom extension:

Procedure
1. Open a CV definition.
2. From the Custom Extensions screen, click the + icon .

Chapter 10. Creation and Management of Certificate Validation (CV) Definitions to Validate Certificates 85



3. Click inside the associated text boxes and type the OID (object identifier) and
Name.

4. To display the Properties screen, click .
5. Specify the Value of the CA, Server, and Client extensions and click OK.
6. Do one of the following:

v To allow an extension to be in a certificate, enable Allowed. The validation
fails only if the extension in the certificate does not match the value set on
the properties screen, or if the value set on the properties screen is false.

v To require a certificate to have a specific extension, enable Required.
Validation fails if the extension is not in the certificate, the extension in the
certificate does not match the value set, or the value set is false.

v Disable both Allowed and Required to reject an extension.
7. Click OK.

Editing Custom Extensions in a CV Definition
To edit a custom extension:

Procedure
1. From the Certificate Validation Definitions list, double-click the certificate

validation that contains the custom extension to modify.
2. From the Certificate Validation Definition Properties screen, click the Custom

Extensions tab, select the custom extension, and click .
3. Modify the values in the Properties dialog box and click OK.

4. Disable or enable the Allowed and Required options, as required.

Deleting a Custom Extension in a CV Definition
About this task

To delete a custom extension:

Procedure
1. From the Certificate Validation Definitions list, double-click the certificate

validation with the custom extension to delete.
2. Click the Custom Extensions tab.
3. Select the custom extension to delete and click the - icon.
4. Click OK.

Editing or Copying a CV Definition
You can update, copy, and delete CV definitions. Create new CV definitions by
copying and updating parameters to save time.

About this task

To edit or copy a CV definition:

Procedure
1. To edit a CV definition, select the definition and click .
2. To copy a definition, select the definition to copy and click .
3. Specify a new name.
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4. Edit parameters as needed. Refer to Creating a CV Definition.

Deleting a Certificate Validation Definition
Deleting a certificate validation definition deletes all parameters and definitions for
the definition and invalidates all references to it from a client application.

About this task

To delete a certificate validation definition:

Procedure
1. From the Certificate Validation Definitions window, select the definition and

click the - icon .
2. Click OK.

Managing Supported Extensions in a CV Definition

Editing Supported Extensions in a CV Definition
About this task

Supported extensions can only be edited from the definition where they are used.

To edit a supported extensions:

Procedure
1. From the Certificate Validation Definitions list, double-click the definition to

modify.
2. From the Certificate Validation Definition Properties screen, click the

Supported Extensions tab, select the extension to edit, and click .
3. Change the extensions as required, or click Restore Defaults and click OK.
4. Modify how each extension can be used in a certificate, as required.

Deleting a Supported Extension in a CV Definition
About this task

To delete a supported extension:

Procedure
1. From the Certificate Validation Definitions list, double-click the certificate

validation with the supported extension to delete.
2. Click the Supported Extensions tab.
3. Select the extension to delete and click the - icon.
4. Click OK.

Configuration and Testing of a Custom Exit for a CV Definition
Sterling External Authentication Server allows you to use a Java class or operating
system command to implement a custom exit from a CV definition. If you use a
Java class as a custom exit, the class must implement the IBM-provided interface,
SEASCustomExitInterface.
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Prerequisites for Using a Custom Exit
Before you configure a custom exit, perform the following prerequisite tasks:
v When a CV definition includes a custom exit to a script or program, create the

functionality required by writing the code that runs from the operating system
command line.

v Review the files in the /doc and /samples directories before you develop a Java
class for a custom exit.

v When a CV definition includes a custom exit to a Java class, create the
functionality required for the exit by writing a Java class that performs the
required CV steps.

v Copy class files or a .jar file for a Java class custom exit to the
install_dir/lib/custom directory, where install_dir is the directory used for CV
installation.

When you specify a custom exit for a CV definition, it is also helpful to set logging
to an appropriate level (such as DEBUG or ALL) to enable you to review
processing results of the Java class or script or program that implements your
custom exit.

Development and Deployment of a Custom Exit Class in Java
The SEASCustomExitInterface interface and a sample class implementing the
interface are documented in the javadoc located in the install_dir/doc directory and
can be found in the archive, install_dir/lib/sterling/custom-exit.jar. The source for
the sample implementation can be found at install_dir/samples/
SampleCertValidationExit.java.

The interface provides an initialization method that accepts a list of custom
properties you define for your class. You specify these properties (names and
values) from the GUI as part of the Custom Exit configuration in the CV definition.

Compile exit classes and provide them in a jar file, or as class files with package
structure preserved, in the install_dir/lib/custom directory. The custom exit class
loader searches all jar files and packages for the custom exit class name specified
in the CV definition.

Specifying Java Class in a CV Definition
About this task

To specify the Java class for a custom exit in a CV definition:

Procedure
1. From the Certificate Validation Definitions window, select the CV definition

and click .
2. Click the General tab on the Certificate Validation Definition Properties

screen. Click Validate using custom exits.
3. Click and select Java class.
4. Specify the fully-qualified class name in the format packageName.className

when you specify the custom exit that implements SEASCustomExitInterface.
5. Click next to Properties.
6. Type a name and value for each property required to initialize the custom exit

class. Use the + icon and the - icon to add or remove rows of name and value
pairs. Click OK.
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7. Click OK.
8. Review the log to determine if the certificate was validated successfully by the

custom exit.

Specifying an Operating System Command for a CV Definition
Custom Exit

About this task

To specify the operating system command to use for the custom exit:

Procedure
1. From the Certificate Validation Definitions window, select the CV definition

and click .
2. Click the General tab. Click Validate using custom exits.
3. Click to display the Custom Exits dialog box and select Native OS

command to validate a certificate using a native operating system command
as a custom exit.

4. Type the operating system command to use, including all command line
arguments, in the Command line field.

5. Specify the method to use to pass the certificate chain to the operating system
command. To pass the certificate chain as a certificate file:
v To pass the certificate chain as a certificate file:

a. Select Certificate file.
b. Type the file name for the certificate chain or a valid variable

expression (such as the default, cert{counter}.pem).
c. Specify the certificate chain file format as PEM or DER.
d. Select Delete file after exit to remove the certificate file after custom

exit processing.
Select Delete file after exit to remove the certificate file after custom exit
processing.

Tip:

The default file name uses a counter to ensure a unique file name. The
variable {counter} begins with 0 and increments after each exit, resulting in
the following file names: cert0.pem, cert1.pem, cert2.pem, and so on. The
file name can be passed on the command line as the variable {filename}. For
example, the following command is a valid use of the file name:

openssl x509 -in {filename}
v To pass the certificate chain through the standard input stream, click

Standard input (PEM format).
6. Specify the timing for running the custom exit and performing certificate

validation as configured in the certificate validation definition:
v Select Run default validator after exit to continue processing the CV

definition after the custom exit.
v Select Run custom exit synchronously to enable synchronous use of this

custom exit. That is, if a client application sends a certificate validation
request with a reference to a definition including the custom exit and the
exit is currently running, then current exit processing must complete before
a subsequent invocation can run.
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7. Specify standard error log level and standard output log level to control how
output from the custom exit is logged. All error output is logged in SEAS.log.
All standard (console) output is logged in the SEAS.log.

8. Set the log levels required to meet your needs.
9. To redirect standard error and output from the custom exit to the response

message that Sterling External Authentication Server returns to the client,
select one or both of the following parameters:
v Log output from stderr to response message—send error log to the

response message.
v Select Log output from stdout to response message—send log output to

the message.
10. Click OK.

Results

Review the log to determine if the certificate was validated successfully by the
custom exit.

Create a Sterling External Authentication Server Certificate Validation
Definition for Active Directory

The following is a sample configuration of a Sterling External Authentication
Server Certificate Validation Definition for Active Directory.

Procedure
1. From the Certificate Validation Definitions window, click the + icon.
2. On the General screen, specify the Name

AD_Multifactor_Certcompare_qa2008domain02.
3. Set the parameter values as follows:

v Clock tolerance–0
v Expiration grace period–0
v Expiration warning–14

4. Specify how to validate certificates by selecting the following parameters:
v Verify before certificate date

v Verify after certificate date

v Validate to root

v Validate to trust anchor

5. Set the Public key minimum key length to 1024.
6. Click Next.
7. Click Next.
8. On the Attribute Query Definitions screen, click the + icon.
9. Specify the Name FindHostDN.

10. Select Use globally defined connection and select AD_2008_Domain02_secure
to connect to the LDAP server.

11. Select Specify query parameters.
12. Click Next.
13. Set the following query parameter values::

v Protocol–Select ldaps://

v Host–10.20.200.100
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v Port–636
v Base DN–CN=Allowed Hosts,CN=SEAS,DC=QA2008Domain,DC=labs
v Return Attributes–dn
v Scope–One Level
v Match Attributes

ipNetworkNumber={IpAddress}

v Query Timeout–00:00
14. Click Next.
15. Click Save and Close.
16. On the Attribute Query Definitions screen, click the + icon.
17. Specify the Name VerifyHostAllowed.
18. Select Use globally defined connection and select AD_2008_Domain02_secure

to connect to the LDAP server.
19. Select Specify query parameters.
20. Click Next.
21. Specify the following query parameter values:

v Protocol–Select ldaps://

v Host–10.20.200.100
v Port–636
v Base DN–CN=Service Groups,CN=SEAS,DC=QA2008Domain,DC=labs
v Return Attributes–cn
v Scope–One Level
v Match Attributes

o={subject.o}
ou=SSP2
uniquemember={attr[FindHostDN].dn}

v Query Timeout–00:00
22. Click Next.
23. Click Save and Close.
24. On the Attribute Query Definitions screen, click the + icon.
25. Specify the Name VerifyCertSubject.
26. Select Use globally defined connection and select AD_2008_Domain02_secure

to connect to the LDAP server.
27. Select Specify query parameters.
28. Click Next.
29. Specify the following query parameter values:

v Protocol–Select ldaps://

v Host–10.20.200.100
v Port–636
v Base DN–CN=Users,DC=QA2008Domain,DC=labs
v Return Attributes–dn,uid,userCertificate
v Scope–One Level
v Match Attributes

c={C}
o={O}

v Query Timeout–00:00
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30. Click Save and Close.
31. On the Attribute Assertion Definitions screen, click the + icon.
32. Specify the Assertion Name CertVerification.
33. Specify Assertion

"{cert}"==
"{attr[VerifyCertSubject].userCertificate}"

34. Click Save and Close.
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Chapter 11. RSA Authentication Definition Creation

Sterling External Authentication Server supports RSA SecurID authentication. To
configure basic RSA authentication in Sterling External Authentication Server,
complete the tasks in Configuring Sterling External Authentication Server Support
for RSA SecurID and Creating an RSA Authentication Definition.

Configuring Sterling External Authentication Server Support for RSA
SecurID

To configure basic RSA SecurID support in Sterling External Authentication Server,
complete the following tasks:

Procedure
1. Contact your RSA server administrator to get a copy of the following files:

v sdconf.rec—This file is required. It contains the information that allows an
RSA SecurID Host Agent (Sterling External Authentication Server) to
communicate with the RSA SecurID server. Usually, the RSA server
administrator will need the IP address of the Host Agent(s) to generate this
file.

v sdopts.rec—This file is optional but may be needed for proper connectivity
between the RSA SecurID Host Agent (Sterling External Authentication
Server) and the RSA SecurID server. The “server options file” specifies the
preferred RSA SecurID server for the RSA SecurID Agent (Sterling External
Authentication Server) to use during communications because multiple RSA
SecurID servers may be used within an environment.

2. After you install Sterling External Authentication Server version 2.4.1, copy the
sdconf.rec and sdopts.rec files to the {SEAS_INSTALL}/conf/jaas directory.

3. Create an RSA SecurID authentication definition using Sterling External
Authentication Server. For more information, see Creating an RSA
Authentication Definition.

4. In Sterling Secure Proxy, specify the RSA SecurID profile you created in Sterling
External Authentication Server in the appropriate policy.

5. The first time a successful connection is made to the RSA SecurID Server, a file
named secureid is generated in the {SEAS_INSTALL}/conf/jaas directory. This
file must be presented during subsequent connections and authentication
requests. Make a copy of this file and store it in a safe place. If you lose this
file, your RSA SecurID administrator will have to reset it.

Creating an RSA Authentication Definition
Authentication definitions specify how Sterling External Authentication Server
authenticates a security principal when a client application sends a request. To
enable Sterling External Authentication Server for RSA SecurID support, create an
RSA user authentication definition.

About this task

To create an RSA SecurID authentication definition:
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Procedure
1. From the Authentication Definitions window, click the + icon to add an

authentication definition.
2. On the LDAP Authentication screen, type a Profile Name.
3. Select RSA SecurID as the Authentication type.
4. Click Next.
5. Click Next twice.
6. Click Save.

What to do next

In Sterling Secure Proxy, specify the name of the RSA SecurID profile you created
in the appropriate policy. Use the table below to identify the values to assign in the
Sterling External Authentication Server RSA authentication definition.

Sterling External Authentication Server
Field Value to Assign

Profile name Name for the profile

Authentication type RSA SecurID

Editing or Copying an Authentication Definition
To copy and edit an authentication definition:

Procedure
1. From the Authentication Definitions window, perform one of the following

actions:
v To copy an authentication definition, select the definition to copy and click

.
v To edit an authentication definition, double-click the definition to edit.

2. Type a unique Profile Name if you are copying an authentication definition.
3. Click OK.

Deleting an Authentication Definition
About this task

To delete an authentication definitions:

Procedure
1. From the Authentication Definitions window, select the authentication

definition to delete and click the - icon .
2. Click OK.
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Chapter 12. Authentication Definition for Other 3rd Party
Token Providers

Custom exits can be created in Sterling External Authentication Server that utilize
other 3rd party secure tokens. For more information, contact your IBM Account
Manager or IBM Implementation Services.
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Chapter 13. Configure Sterling External Authentication Server
for FIPS Mode

Use the procedures in this section to configure Sterling External Authentication
Server for FIPS mode operation.

About this task

There are two parameters you can use to configure FIPS mode operation for
Sterling External Authentication Server:
v The FIPS_MODE parameter allows you to enable and disable FIPS-mode

operation for Sterling External Authentication Server.
v The CV_FIPS_MODE parameter allows you to specify whether Sterling External

Authentication Server will validate client certificates as being FIPS-compliant on
certificate validation (CV) requests. If you do not specify a value for this
property, it defaults to the value set for FIPS_MODE.

The following table lists the possible combinations for the FIPS mode parameter
values and indicates whether Sterling External Authentication Server will check the
certificate chain sent on CV requests for FIPS compliance:

FIPS_MODE Setting CVS_FIPS_MODE Setting Perform CV FIPS Check

true true yes

true false no

false true yes

false false no

true (no value specified) true

false (no value specified) false

Procedure
1. Navigate to install_dir/bin, where install_dir is the Sterling External

Authentication Server installation directory.
2. Edit the file called security.properties.
3. To enable FIPS-mode operation, set FIPS_MODE=true.
4. Do one of the following:

a. To validate client certificates for FIPS compliance, set
CVS_FIPS_MODE=true.

b. To override FIPS enforcement for certificates on CV requests, set
CVS_FIPS_MODE=false.

5. Save the file.
6. Restart Sterling External Authentication Server for these settings to take effect.
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Chapter 14. JAAS Authentication Definition Configuration

To configure the Sterling External Authentication Server environment for JAAS,
modify the default JAAS configuration and RSA SecurID properties files located in
the ${SEAS_INSTALL}conf/jaas directory.

The JAAS configuration file called seas_default_jaas.config specifies the
authentication modules supported by Sterling External Authentication Server. The
Sterling External Authentication Server installation updates the JAAS configuration
file with your environment variables. The contents of this configuration file is
shown below:

SeasRSALoginModule {
com.sterlingcommerce.component.authentication.impl.SeasSecurIDLoginModule required
debug=true
properties=".../conf/jaas/secureid.properties";

};

SeasRSALDAPLoginModule {
com.sterlingcommerce.component.authentication.impl.SeasSecurIDLoginModule
sufficient debug=true
properties=".../conf/jaas/secureid.properties";

com.sterlingcommerce.component.authentication.impl.SeasLdapLoginModule sufficient
userProvider="ldaps://ldap_host:{LDAP_PORT}/ cn={USERNAME} CN=Users,

DC=SSPDomain,DC=labs"
authIdentity="cn={USERNAME},CN=Users,DC=SSPDomain,DC=labs"

useSSL=false
debug=true;
};

SeasLDAPLoginModule {
com.sterlingcommerce.component.authentication.impl.SeasLdapLoginModule sufficient

userProvider="ldaps://ldap_host:{LDAP_PORT}/CN=Users,DC=SSPDomain,DC=labs"
authIdentity="cn={USERNAME},CN=Users,DC=SSPDomain,DC=labs"

useSSL=false
debug=true;
};

Edit the JAAS configuration file, seas_default_jaas.config and make your edits.
Then save it.

JAAS Configuration File Modification for RSA SecurID
Sterling External Authentication Server ships with sample code for a JAAS login
module file to support RSA SecurID user authentication.

The Sterling External Authentication Server installation program copies the sample
files to the <SEAS install>/samples/rsa/ directory. The directory contains the
following files:

File Description

build.bat Windows build script

build.sh UNIX build script

SeasSecurIDLoginModule.java Java source code
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To build and deploy the login module
1. Do one of the following:

v If this is a new installation of Sterling Authentication Server:
a. Download the authapi.jar file from the RSA web site
b. Copy the file to the <SEAS install>/lib/thirdparty/ directory

v If this is an upgrade of a Sterling External Authentication Server, authapi.jar
will already be in the <SEAS install>/lib/thirdparty/ directory.

2. Download a Java Development Kit (JDK) from Sun. You can use JDK 1.5 or
later.

3. Edit the build script and set the values for the following variables according to
your environment:

Variable Description

JDK_HOME Fully qualified path to root directory of Java
Development Kit

SEAS_INSTALL Fully qualified path to the SEAS installation
directory

4. Run the build script.
The script compiles the sample java source file and generates a jar file.
The output jar file is named seas-rsa.jar and it is automatically copied to the
<SEAS install>/lib/sterling/ directory.

5. On Windows, edit the <SEAS install>/bin/SEAS$.lax file and add the following
to the lax.class.path line:
../lib/thirdparty/seas-rsa.jar;../lib/thirdparty/authapi.jar;

6. If this is an upgrade SEAS installation, perform the following steps:
a. Edit the <SEAS install>/conf/jaas/seas_default_jaas.config file
b. Replace all instances of

com.sterlingcommerce.component.authentication.impl.

SeasSecurIDLoginModule

with
com.sterlingcommerce.sample.authentication.jaas.

SeasSecurIDLoginModule

7. Stop and restart Sterling External Authentication Server.

To implement a JAAS RSA SecurID or RSA SecurID with LDAP fallback
authentication scheme, update the seas_default_jaas.config file with the following
attributes needed for your environment:

Attribute Description

com.sterlingcommerce.sample.authentication.
jaas.SeasSecurIDLoginModule

Fully-qualified class path of the
SeasSecurIDLoginModule. The file contains the class path
of the Sterling External Authentication Server RSA
SecurID module.

properties Location of the securid.properties file that implements
RSA SecurID. The default is {SEAS_INSTALL}/conf/jaas.
If you move the file, update the variable to provide its
fully-qualified path.
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JAAS Configuration File Modification for LDAP
To implement a JAAS LDAP or LDAP fallback authentication scheme, update the
seas_default_jaas.config file with the following attributes for your environment:

Attribute Description

com.sterlingcommerce.component.authentication.
impl.SeasSecurIDLoginModule

Fully-qualified class path of the SeasLDAPLoginModule.
The file contains the class path of the Sterling External
Authentication Server LDAP module.

If you want to implement your own LDAP module,
replace this class path with your own. See Implementing
Your Own LDAP Module in Sterling External
Authentication Server for more information.

debug Enables debug mode for this module.

True—Debug is enabled.

False—Debug is disabled.

This attribute is not required for proper initialization of
the LDAP login module.

userProvider Points to the LDAP server that may be contacted by the
SeasLDAPLoginModule. The base DN must be specified.

Specify either ldap or ldaps. If you specify ldaps to run
the LDAP login module in secure mode, update the
truststore file located in {SEAS_INSTALL}/conf/system/
truststore with the location of the LDAP server's public
certificate.

{LDAP_PORT}—Replace this variable with the port
number of the LDAP host.

authIdentity Location of the users in the specified LDAP server.

Do not replace the {USERNAME} variable in the
seas_default_jaas.config file.This variable will be
substituted with a user by the SeasLDAPLoginModule
when a request to authenticate a specific user is made.

useSSL Enables the secure mode.

True—The module will run in secure mode.

False—The module will run in nonsecure mode.

Implementing Your Own LDAP Module in Sterling External
Authentication Server

Sterling External Authentication Server provides the ability implement your own
LDAP module.

About this task

To implement your own LDAP module:
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Procedure
1. Copy the jar file that contains your LDAP module to SEAS_install_dir/lib/

custom. The jar file must contain the class name you will specify in the
seas_default_jaas.config file.

2. In the seas_default_jaas.config file, replace the following line with your own
class name:
com.sterlingcommerce.component.authentication.impl.SeasLdapLoginModule

3. Save the seas_default_jaas.config file.

RSA SecurID Properties File Modifications
The SecurID properties file specifies information necessary to communicate with
the SecurID server and the Sterling External Authentication Server host that will
communicate with that server. During Sterling External Authentication Server
installation, environment variables are updated in the RSA SecurID properties file,
secureid.properties. All other attributes are optional. To update this file, open it in
a text editor, make your changes, and save the file.

A sample RSA SecurID properties file is shown below:
# RSA Authentication API Properties
# Override Host IP Address (SEAS Host Machine IP address)
RSA_AGENT_HOST=seas.host.machine
# Interval in seconds between which configuration is refreshed.
RSA_CONFIG_READ_INTERVAL=600
# [This section is for Data Repository configuration.]
# Type of the Server configuration.
SDCONF_TYPE=FILE
# Path of the Server configuration.
SDCONF_LOC=C:\\development\\seas-03162009\\dist\\conf\\sdconf.rec
# Type of the Server statuses.
SDSTATUS_TYPE=FILE
# Path of the Server statuses.
#SDSTATUS_LOC=C:\\development\\seas-03162009\\dist\\logs\\JAStatus.1
#SDSTATUS_LOC=

# Type of the Server options.
SDOPTS_TYPE=FILE
# Path of the Server options.
SDOPTS_LOC=C:\\development\\seas-03162009\\dist\\conf\\sdopts.rec
# Type of the Node Secret.
SDNDSCRT_TYPE=FILE
# Path of the Node Secret.
SDNDSCRT_LOC=

# Logs event messages to a file.
RSA_LOG_TO_FILE=YES
# Name of the log file.
RSA_LOG_FILE=C:\\development\\seas-03162009\\dist\\logs\\rsa_jaas.log
# Minimum severity level allowed to log.
RSA_LOG_LEVEL=DEBUG

# [This section is for debugger.]
# Enables debug tracing.
RSA_ENABLE_DEBUG=YES
# Sends tracing to the console.
RSA_DEBUG_TO_CONSOLE=NO
# Sends tracing to a file.
RSA_DEBUG_TO_FILE=YES
# Name of the trace file.
RSA_DEBUG_FILE=C:\\development\\seas-03162009\\dist\\logs\\rsa_jaas_debug.log
# Allows function entry tracing.
RSA_DEBUG_ENTRY=YES
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# Allows function exit tracing.
RSA_DEBUG_EXIT=YES
# Allows control flow tracing.
RSA_DEBUG_FLOW=YES
# Allows regular tracing.
RSA_DEBUG_NORMAL=YES
# Traces the location.
RSA_DEBUG_LOCATION=YES

Creating JAAS Authentication Definitions
Authentication definitions specify how Sterling External Authentication Server
authenticates a security principal when a client application sends a request. To
enable Sterling External Authentication Server for JAAS support, create a JAAS
user authentication definition.

About this task

To create a JAAS authentication definition:

Procedure
1. From the Authentication Definitions window, click the + icon to add an

authentication definition.
2. On the LDAP Authentication screen, type a Profile Name.
3. Select JAAS as the Authentication type.
4. Select a JAAS Module Name.
5. Click Next.
6. Click Next twice.
7. Click Save.

What to do next

In Sterling Secure Proxy, specify the name of the JAAS profile you created as the
External Authentication Profile in the appropriate policy.

Editing or Copying a JAAS Authentication Definition
To copy or edit a JAAS authentication definition:

Procedure
1. From the Authentication Definitions window, perform one of the following

actions:
v To copy an authentication definition, select the definition to copy and click

.
v To edit an authentication definition, double-click the definition to edit.

2. Type a unique Profile Name if you are copying an authentication definition.
3. Click OK.

Deleting an Authentication Definition
About this task

To delete an authentication definitions:
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Procedure
1. From the Authentication Definitions window, select the authentication

definition to delete and click the - icon .
2. Click OK.
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Chapter 15. Sterling B2B Integrator User Authentication
through an Sterling External Authentication Server Custom
Exit

Sterling External Authentication Server provides a custom user authentication exit
to validate a trading partner user ID and password against the Sterling B2B
Integrator user store. Refer to Generic Authentication Definitions for instructions
on creating a user authentication.

Before you use this custom exit to validate user information against the Sterling
B2B Integrator user store, you must configure a separate HTTP server adapter in
Sterling B2B Integrator to enable both user authentication and SSL, and to invoke a
do-nothing business process called HelloWorld.

Certificate Preparation for Authentication in the Sterling B2B Integrator
User Store

To prepare to authenticate user IDs and passwords in Sterling Secure Proxy using
the Sterling B2B Integrator user store, you must prepare certificates by performing
the following tasks:
v Configuring the HTTP Server Adapter Certificate
v Exporting the System Certificate from Sterling B2B Integrator
v HTTP Server Adapter System Certificate Import into the Sterling External

Authentication Server Trust Store
v Sterling External Authentication Server Keystore Export
v Importing the Sterling External Authentication Server System Certificate into the

Sterling B2B Integrator CA Certificate Store

Configuring the HTTP Server Adapter Certificate
Decide which system certificate you will use for the HTTP server adapter. Use the
default certificates provided by Sterling B2B Integrator, or import your own. For
security reasons, use your own certificates.

About this task

Note: PEM key certificates must have a txt extension. If your key certificate file
has a different extension, rename it to txt. PKCS12 certificates must have a pfx
extension. If necessary, rename the PKCS12 certificate to certificatename.pfx.

To import a system certificate into the Sterling B2B Integrator certificate store:

Procedure
1. On the Sterling B2B Integrator dashboard, select Trading Partners > Digital

Certificates > System.
2. Click Go! in the check in section for the type of key you are checking in: PEM

or PKCS12 certificate.
3. Specify the location of the certificate file and the password for the private key

and click Next.
4. Click Next.
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5. Click Finish.

Exporting the System Certificate from Sterling B2B Integrator
After you identify the system certificate to use for the HTTP server adapter, export
the public part of the certificate. After it is exported, it will be imported into the
Sterling External Authentication Server trust store.

About this task

To export the system certificate:

Procedure
1. On the Sterling B2B Integrator dashboard, select Trading Partners >Digital

Certificates > System.
2. Do one of the following:

v Type the system certificate name in the Search by certificate name field and
click Go.

v Click Go on the List section to get a list of all certificates and locate the
desired certificate.

3. On the System Certificates screen, click the checkout button next to the
certificate to export.

4. Select BASE64, then click Go.
5. Click Save and select the location where you want to save the exported

certificate.

HTTP Server Adapter System Certificate Import into the
Sterling External Authentication Server Trust Store

Add the exported certificate to the Sterling External Authentication Server trust
store, located in the conf/system/truststore folder.

To import the system certificate into the Sterling External Authentication Server
trust store, navigate to the install_dir/jre/bin directory on the computer where the
Sterling External Authentication Server resides, type the following command, and
press Enter.
keytool -import -keystore truststore_path -alias alias_name -storepass
password -file certificate

Following is a description of the keytool parameters used to import an Sterling
External Authentication Server certificate:

Parameter Description

-import Instructs keytool to import a certificate into the keystore.

-keystore
truststore_path

The path and file name of the truststore file.

-alias alias_name The alias name to identify the certificate in the keystore. Use the
same alias as you used to create the certificate.

-storepass password The password of the keystore file.

-file certificate The location of the certificate for Sterling External Authentication
Server to import.
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Sterling External Authentication Server Keystore Export
To allow the HTTP server adapter to trust the client certificate from Sterling
External Authentication Server, the client certificate must be exported from the
Sterling External Authentication Server keystore and then imported into the
Sterling B2B Integrator CA certificate store. The Sterling External Authentication
Server keystore is located in the conf/system/keystore directory, by default.

To export the client certificate from the Sterling External Authentication Server
keystore, navigate to the install_dir/jre/bin directory on the computer where the
server resides, type the following command, and press Enter.
keytool -export -alias alias_name -keystore keystore_path -storepass password
-rfc -file cert_file_name.xxx

Following is a description of the keytool parameters used to export an Sterling
External Authentication Server certificate:

Parameter Description

-export Instructs keytool to export a certificate from the Sterling External
Authentication Server keystore.

-keystore
keystore_path

The path and file name of the keystore file.

-alias alias_name The alias name of the Sterling External Authentication Server client
certificate in the keystore. Use the same alias as you used to create
the certificate.

-storepass password The password of the keystore file.

-rfc Exports the certificate in PEM format. To export the certificate in
DER format, do not include the –rfc parameter.

-file certificate The location of the certificate for Sterling External Authentication
Server to import.

Importing the Sterling External Authentication Server System
Certificate into the Sterling B2B Integrator CA Certificate Store

After the Sterling External Authentication Server client certificate is exported, it
must be imported into the Sterling B2B Integrator CA certificate store.

About this task

To import the certificate into the Sterling B2B Integrator CA certificate store:

Procedure
1. On the Sterling B2B Integrator dashboard, select Trading Partners > Digital

Certificates > CA.
2. Click Go! on the Check in section.
3. Specify the certificate file and click Next.
4. Type a name for the certificate and click Next.
5. Click Finish on the Confirm screen.
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Configuring a Sterling B2B Integrator HTTP Server Adapter for Sterling
External Authentication Server Support

To configure a Sterling B2B Integrator server adapter to support Sterling B2B
Integrator user authentication through an Sterling External Authentication Server
custom exit:

Procedure
1. On the Sterling B2B Integrator dashboard, select Deployment > Services

>Configuration

2. Click Go! on the Create New Service panel.
3. Select HTTP Server Adapter as the service type and click Next.
4. Type a name and description for the adapter and click Next.
5. Specify a listen port, perimeter server, and queue depth (max concurrent

sessions). Select Yes for User Authentication Required. Select Must for Use
SSL. Click Next.

6. Select the server certificate that the HTTP server adapter will present to
Sterling External Authentication Server from the System Certificate combo
box.
Refer to the Configuring the HTTP Server Adapter Certificate for information
on how to check in a system certificate for the HTTP adapter to use.

7. Select the CA certificate to use to validate the Sterling External Authentication
Server certificate from the CA Certificates list. Click the arrow to move it to
the list on the right.
See Importing the Sterling External Authentication Server System Certificate
into the Sterling B2B Integrator CA Certificate Store for information on how to
check in the CA certificate for Sterling External Authentication Server. If no
certificate is selected, client authentication is disabled.

8. Press Next.
9. Click the + icon to add a new URL.

10. On the URI field, specify a URL name starting with a slash (for example:
/gisAuth). If the leading slash is missing, an error is returned to clients trying
to access the URL. Click Next.

11. On the Business Process combo box, select HelloWorld and click Next.
12. Click Next on the URI page.
13. Click Finish.

Configuring an Sterling External Authentication Server User
Authentication Profile

To configure an Sterling External Authentication Server user authentication profile
to support Sterling B2B Integrator user authentication:

Procedure
1. Launch the Sterling External Authentication Server user interface and login.
2. On the Authentication Definitions window, click +.
3. On the Authentication type combo box, select Generic.
4. Type a profile name.
5. Click the Authenticate using custom exits check box and press the ... button.
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6. On the class name field, specify
com.sterlingcommerce.component.authentication.impl.HttpUserAuthExit.

7. Click the ... button next to Properties.
8. Add the following property: url = <fully-qualified URL for HTTP server

adapter>
For example: https://acmehost:11080/gisAuth

9. Click OK.
10. Click Next to move through the definition pages.
11. Click Save.

Custom Exit Configuration Properties
Following is a description of the configuration properties:

Name Value

url Fully-qualified URL for the primary HTTP Server Adapter. The format
is:<protocol>://<host>:<port>/<uri>. This property is required.

alt.url.1 Fully-qualified URL for the first alternate HTTP Server Adapter. If the
connection to the primary adapter fails, the first alternate is tried next. This
property is optional.

alt.url.2 Fully-qualified URL for the second alternate HTTP Server Adapter. If the
connection to the first alternate adapter fails, the second alternate is tried next.
This property is optional.

alt.url.3 Fully-qualified URL for the third alternate HTTP Server Adapter. If the
connection to the second alternate adapter fails, the third alternate is tried
next. This property is optional.

bind.addr IP address of NIC to use for outbound connection. Used with systems with
more than one NIC. This property is optional.

client.alias Alias of client certificate to use for outbound SSL connection. Used only if the
Sterling External Authentication Server keystore has more than one key
certificate. This property is optional.

Log Messages

Sterling Secure Proxy Messages
Following are the Sterling Secure Proxy messages written to the secureproxy log
file:

Message Sample

Success
Authentication

08 Aug 2009 13:08:40,548 INFO [ProxyNearScheduler-Thread-6]

sys.ADAPTER.httpAdapter - SSE1827I Engine Name=engine,
Adapter Name=httpAdapter, Sterling External Authentication Server
Name=eaServer.

Received user authentication response from Sterling External
Authentication Server. Client: null Profile: gisAuth User: admin
Message: AUTH073I admin successfully authenticated
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Message Sample

Failed
Authentication

08 Aug 2009 13:12:14,042 INFO [ProxyNearScheduler-Thread-5]

sys.ADAPTER.httpAdapter - SSE1827I Engine Name=engine,
Adapter Name=httpAdapter, Sterling External Authentication Server
Name=eaServer.

Received user authentication response from Sterling External
Authentication Server. Client: null Profile: gisAuth User: admin
Message: AUTH074E Authentication failed for admin. Exception
encountered during custom exit: AUTH071E Authentication failed
for admin (Reason: invalid userid/password).

Sterling External Authentication Server Messages
Following are the Sterling External Authentication Server messages written to the
Sterling External Authentication Server log file:

Message Description

Success Authentication 08 Aug 2009 13:08:41,986 730209 [Pool Worker - 4] INFO
com.sterlingcommerce.component.authentication.impl.CommonAuthenticator - AUTH073I
admin successfully authenticated.

Failed Authentication F08 Aug 2009 13:12:14,027 942250 [Pool Worker - 5] ERROR
com.sterlingcommerce.component.authentication.impl.HttpUserAuthExit -
java.lang.Exception: AUTH071E Authentication failed for admin

(Reason: invalid userid/password).

Sterling B2B Integrator Authentication Log Messages
Following are the messages written to the Sterling B2B Integrator log file:

Message Sample

Failed Authentication [2009-08-14 13:02:32.931] DEBUG 000000000000 GLOBAL_SCOPE SecurityManager user:user
attempting to log in (SSO:false)

[2008-08-14 13:02:32.931] DEBUG 000000000000 GLOBAL_SCOPE GISAuthentication
user:user is identified as a LOCAL GIS User

[2008-08-14 13:02:32.931] ALL 000000000000 GLOBAL_SCOPE SecurityManager user:user
authorization FAILED (SSO:false)

Successful
Authentication

[2009-08-14 13:03:35.9] DEBUG 000000000000 GLOBAL_SCOPE SecurityManager user:user
attempting to log in (SSO:false)

[2008-08-14 13:03:35.9] DEBUG 000000000000 GLOBAL_SCOPE GISAuthentication user:user
is identified as a LOCAL GIS User

[2008-08-14 13:03:35.9] ALL 000000000000 GLOBAL_SCOPE SecurityManager user:user
authorization SUCCEEDED (SSO:false)
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Chapter 16. Creation and Management of SSH Key
Authentication and Mapping Definitions

An SSH key authentication and mapping definition specifies how Sterling External
Authentication Server authenticates an SSH user when a client application sends a
request for authentication.

A client application such as Sterling Secure Proxy sends a request to Sterling
External Authentication Server. The request contains a profile name, user ID, and
SSH public key. Sterling External Authentication Server uses information in the
profile to bind to an LDAP directory, look up the SSH keys assigned to the user,
and perform an attribute assertion to match the key provided by the user to the
list of keys stored at the LDAP server. Sterling External Authentication Server
notifies the client if the key sent by the client matches a key stored in the LDAP
server.
v The credentials of the principal used to bind to the directory are defined in the

SSH key authentication. Unlike regular user authentication requests, the userid
from the SSH key authentication request cannot be used to bind to the directory
because the password for the user is not available in the key authentication. The
credentials to bind to the directory are the directory administrator and are
configured in a global LDAP connection definition.

v The query to look up SSH keys assigned to a user is defined in the profile
according to your directory layout. If you use the openssh schema provided
with Sterling External Authentication Server, the query returns all sshPublicKey
attributes for the user. If you use a customized schema, be sure to modify the
query to ensure that the query returns the attributes associated with the
customized schema.

v An assertion definition matches the public key from the request against the keys
returned by the SSH public key lookup query. A pre-configured assertion is
included with Sterling External Authentication Server. It uses the openssh
schema to store the public keys. If you do not use this schema, edit the assertion
definition to use the appropriate schema.

v To use SSH key mapping, define another query to return a reference to the
mapped key. The existing MapSSHCredentials query provided with Sterling
External Authentication Server returns the new routingKeyName attribute of the
loginCredentials record, and assigns it to the mappedRoutingKeyName
application output. The application uses the value of the
mappedRoutingKeyName output to locate a public/private key pair to use as
the mapped key for the user.

OpenLDAP or IBM Tivoli Preparation to Store Keys, User IDs, and
Passwords for an SSH User

Before you can store SSH keys in a directory to perform user authentication and
login credentials mapping, you must update the directory schema.

Use the schema files provided by Sterling External Authentication Server to extend
your schema for OpenLDAP and IBM Tivoli Directory Server directories, or as a
reference when you manually extend other directories. If you use these directory
extensions and create directory entries, the creation of an application output
definition is automated. Alternatively, use any arbitrary directory object that stores
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a user ID and password, as long as the password can be retrieved as unencrypted
data. When using an arbitrary directory object, you define the attribute query that
can store a user ID and password, as long as the password can be retrieved as
unencrypted data. When using an arbitrary directory object, you must define the
attribute query that fetches the credentials for the application output definition.
Then, use controls on the Application Output Definition screen to manually map
attributes returned by the query to outputs that a client application can access.

If you implemented a custom SSH schema you do not need to configure the
custom SSH schema provided with Sterling External Authentication Server. You
create or edit an SSH Key Authentication profile and identify the attributes defined
in the custom schema, when defining queries and assertions.

Implementing the SSH and SCI Schemas for Open LDAP
To implement the SSH and SCI schema for Open LDAP:

Procedure
1. Copy the openssh-lpk.openldap.schema file from the install_dir/schema/ to the

schema subdirectory of your OpenLDAP installation.
2. Copy the sci.schema file from install_dir/schema/ to the schema subdirectory of

the OpenLDAP installation.
3. Edit the slapd.conf file to add an include statement with the added schema

references. The file is located in the /etc/openldap directory.
include /etc/openldap/schema/sci.schema
include /etc/openldap/schema/openssh_lpk.openldap.schema

4. Restart the LDAP server.

Implementing the SSH and SCI Schemas for IBM Tivoli
To implement the SSH and SCI schema for IBM Tivoli:

Procedure
1. Copy the v3.openssh-lpk file from the install_dir/schema/ to the schema

subdirectory of your Tivoli installation. Schemas are often located in the
/usr/ldap/etc directory.

2. Copy the file install_dir/schema/V3.sci to the schema subdirectory of your
Tivoli installation. Schema files are normally located in the /usr/ldap/etc
directory.

3. Restart the LDAP server.

Entries for SSH Public Key in the LDAP Server
For each user SSH key, define an sshPublicKey attribute and set it to the value of
the public SSH key for the user. If a user has multiple SSH public keys, define an
attribute for each key.

Note: The data of the sshPublicKey attribute must be in PEM format. and be
cleared of BEGIN/END comments and newlines. Copy the content of a public key
to an editor. Remove the BEGIN and END comments from the file and delete all
newlines. The key should be on one line.

Following is a sample of an LDIF file for a user entry that uses the
openssh-lpk.openldap.schema file with an LDAP user entry that contains two SSH
public keys:
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dn: cn=guser,ou=users,dc=example,dc=com
objectClass: person
objectClass: organizationalPerson
objectClass: inetOrgPerson
objectClass: ldapPublicKey
objectClass: top
cn: guser
sn: userLast
sshPublicKey:: c3NoLXJzYSBBQUFBQjNOemFDMXljMkVBQUFBQkl3QUFBSUVBbkRUN09VYWROZmNXdH
pzV0QveFIzWXBYd2VmS3FLbVhaQnRsenlIWVRXTjhoOXZtaHdiY1NlNWVtYWZFeVh1eGJr eXBHRDFMK
0Y1aStVbUZadE1nSUtyblIwQ1hZazhwYmlxeXBSc1J4OXBEQWR5QzRrekZaTEJnQzR 2R3NibjRHTStTZUN
XTVA0Zy9oazRGNFRvWWx6Y0VENTBnaDgzTXVwc1dhOWZaRko4PSBxYXRlc3RAcWFzbGVzOAo=
sshPublicKey:: c3NoLWRzcyBBQUFBQjNOemFDMWtjM01BQUFDQkFLU3gyRGoyRmgyZjY5b0hNU2o2UFo
va3U2ZUJoZlA1enE5UHhUeHBadExXWjlxNFh6NWtkOVFmdzFuZTVNbDhhOHFBSmN2YmFwQStBRG50U2J
0bHZQVFh5MXdObnB2OTUxRjFaYUlMd0ZIejBLUzkxUGJ1aE5ZOE9JbEdJTEY1Q0JraWc2aFFPMXBu
SFJWRlVMMEx0a3lodnI0eG5CYTdqTmtKSm1hQUJpZkJBQUFBRlFEWDc4RlhVdDJpN052QjN4aTRXdG1NbUZ
6OEZ3QUFBSUFIT1JuUE5sdC9qa25mTW4zZWtlQ3ZHbEVrZjdEQlhIRlE4UGdEcmNpNWh0US9NekpjR0tCb2
FXRUVNQnNGLzBrVVlCdjZkWVZwZTR2dVM5VmZnRzFDV0lvMjV6N1BDM2FvQ1lmK0VGUXFReWtuL1BFV1M1U
UU1NlB6S29ueXBMa3ZLdFFkS3VtbVNFSFBCR1owbUVWT2lEbjhsdTZBb1Z0L28rMmZXZXkvSlFBQUFJQXdo
MHJXRU5UMXVFZFUxV1hOL2hBdmcrTkVlVy94SnkvQUpXeTNrMGxLajM4MVdnekdiODRneTFDL2FMam40bWo
4Q29ublhPeHVxZnBiL3Q4Q0c1U2xUVlUwaUUxYWpDR0o2ODNVT20wc2xNeTl3S1hYU3BJcWdnU25zTnJaQj
J6Y0lIS29NTDNITHF4WEF4RXZnMndhaTZReHBGd1d3Q0UwOVM4eHBwbm4zdz09IHFhdGVzdEBxYXJoYXMyM
Qo=
userPassword:: e1NIQX1rZC9aM2JRWml2L0Z3WlROak9iVE9QM2tjT0k9

Login Credential Creation in the LDAP Server
After you add the schema to the directory, create loginCredentials entries to define
attributes for the user ID, password, and SSH key. The supported directory
structure creates separate loginCredentials entries in the authenticated user’s
directory entry: one for each destination service.

Set the loginId and logingPwd attributes to the ID and password needed to login
to the destination service. Enter the password in binary text. Set the
routingKeyName attribute to the label that maps to the public/private key pair
that is needed to login to the destination service. Set the attribute called
loginTarget to the destination service name defined in the authentication request
from the client application. After this is defined, the query to obtain the credentials
is pre-populated with the correct values and the mapping to outputs is performed
automatically.

LDIF Entry Example for SSH
The LDIF entry below demonstrates an entry in the supported structure:
dn: cn=SSP1-App2 Login Credentials, cn=User010101, ou=SterlingEAS 2.0
Users, dc=IBM, dc=com
objectClass: loginCredentials
objectClass: top
cn: SSP1-App2 Login Credentials
description: User010101’s login credentials for SSP1-App2
(loginPwd=loginPwd2)
loginId: loginId010101
loginPwd:: cGFzc3dvcmQ=
loginTarget: SSP1-App2
routingKeyName : internaKey

In the scenario suggested in the preceding example, Sterling External
Authentication Server authenticates the user, User010101, by binding to the
following DN: cn=User010101, ou=SterlingEAS 2.0 Users, dc=IBM, dc=com.
Assume that with the directory information tree structured as indicated in the
example, a client application sends an authentication request that references a
destination service, SSP1-App2. The user ID to log in to this service is
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loginId010101 and the corresponding password is loginPwd2. Sterling External
Authentication Server queries the loginCredentials entry and returns the user ID,
password, and routing key name to the client application in the authentication
response.

Note: The value of the loginPwd attribute is base64-encoded. If you need a tool to
base64-encode a password, OpenSSL can do this using the following command line
syntax:
openssl enc -a -e -in clearTextPasswordFile -out base64EncodedPasswordFile

Creating an SSH Key Authentication Definition
About this task

Create an SSH key authentication definition to identify how to authenticate an SSH
user in Sterling Secure Proxy. Before you create an SSH key authentication
definition, define a global connection setting for the LDAP server. Refer to Creating
a System-Wide LDAP or HTTP Connection Definition.

Select the assertion definition to use with the definition. It matches the public key
from the request against the keys returned by the SSH public key lookup query. A
preconfigured assertion called VerifySSHPublicKey is provided with Sterling
External Authentication Server. It uses the openssh schema to store the public keys.
You can use this SSH assertion definition or define your own. If you do not use the
openssh schema, you must edit the assertion definition to reference the schema
used.

To create an SSH key authentication definition:

Procedure
1. From the Authentication Definitions window, click the + icon to add a

definition.
2. Select SSHKEY as the authentication type. The SSH Key Authentication screen

is displayed.
3. Define a profile name in the Profile Name field. Click Next.
4. Identify the following information and click Next.

v The name is automatically populated with sshPublicKeyQuery.
v Select Use globally defined connection as the connection method.
v Select the global connection definition that you defined for the LDAP server.
v Select Specify Query Parameters.

5. On the Query Parameters screen, define the Base DN information. Click Next.
6. Click Save to save the definition.
7. At the Attribute Assertion Definitions screen, do one of the following:

v The Verify SSHPublicKey assertion is prepopulated. Double-click this
assertion to review the definition. Click OK.

v Click Next to go to the Application Output Definition page.

Use the following table to identify the values to assign to the Sterling External
Authentication Server fields:

Sterling External
Authentication Server Field Value to Assign

Authentication type SSHKEY
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Sterling External
Authentication Server Field Value to Assign

Profile name Name for the profile

Name Automatically populated with sshPublicKeyQuery

Connection method Use globally defined connection

Global connection definition Definition you created for the LDAP server

Specify Query Parameters Allows you to specify query parameters

Base DN Distinguished name for the user container. For example,
CN=Users,DC=example,DC=com.

Application Feature Lookup login credentials (Sterling) to configure user ID,
password, or routing key mapping.

Use globally defined
connection

Connection definition for the Active Directory server

Specify query parameters Allow you to define the query parameters

Return Attributes Mapped credentials to return. By default, loginId,
loginPwd, and routingKeyName are returned.

Delete any attributes you don't want to map.

SSH Application Output Definition Creation
Create an SSH Application Output definition to perform an SSH user and key
query. Lookup loginCredentials is an option you select in an Application Output
definition. It returns login credentials to the client application.

You configured the schema to define the objects allowed in the directory when you
configured sci.schema for OpenLDAP or and v3. for IBM Tivoli Directory Server.

Creating an Application Output Definition for the
loginCredentials (sterling) Definition

To create an application output definition for the loginCredentials (sterling)
definition:

Procedure
1. On the Application Output screen, click the Application Feature drop-down

box. Select Lookup loginCredentials (sterling).
2. Click Query to create an LDAP attribute query.
3. Enable the Use globally defined connection option and select the LDAP server

from the drop-down box. Click Next.
4. The Query Parameters screen is populated with the appropriate parameters.

Edit the Base DN field, the starting point in the directory to begin the search.
Click Next.

5. Review the details summarized on the Confirm screen and click Save.
6. Click Close to return to the Application Output Definition screen, where the

mapping of return attributes to outputs has been performed automatically.
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Creating an Application Output Definition for the
loginCredentials (custom) Definition

To create an application output definition for the loginCredentials (custom)
definition:

Procedure
1. On the Application Output screen, click the Application Feature drop-down

box. Select Lookup loginCredentials (custom).
2. Click Query to create an LDAP attribute query that returns the attributes

mapped to application output to the client application.
3. Enable the Use globally defined connection option and select your LDAP

server from the drop-down box. Click the Query Parameters tab.
4. Construct an attribute query to return the user ID and password from your

directory object. See Attribute Query Definition for instructions.
After the Attribute Query wizard closes, you must manually map the return
attributes to the respective output names.

5. In the left pane, click the Output Name, mappedUid. Selecting the output
highlights it.

6. Click the query return attribute that corresponds to the user ID for the
destination service in the right pane. Selecting the attribute highlights it, and
Map is no longer dimmed.

7. Click Map to complete the mapping of the user ID attribute to the output
name. Repeat this procedure to map the password attribute returned from your
query to the Output Name, mappedPwd.

Editing or Copying an SSH Key Authentication Definition
About this task

When authentication requirements for destination services change, authentication
requests from client applications can change. Changes in requests require changes
in authentication definitions.

You can change how Sterling External Authentication Server authenticates SSH
keys and users by copying, editing, and deleting SSH key authentication
definitions. To create a new SSH key authentication definition, you can save time
and reduce errors by copying, renaming, and editing a similar definition to create
the new one.

To copy or edit an SSH key authentication definition:

Procedure
1. From the Authentication Definitions window, perform one of the following

actions:
v To make a copy of an authentication definition, select the definition and click

. Type a unique Profile Name for the definition.
v To edit an authentication definition, double-click the definition.

2. For SSH key authentication, update the parameters as required. Refer to
Creating an SSH Key Authentication Definition for a description of the
parameters.

3. Click OK.
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Deleting an SSH Key Authentication Definition
About this task

To delete an SSH key authentication definition:

Procedure
1. From the Authentication Definitions window, select the definition to delete

and click .
2. Click OK.
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Chapter 17. Generic Authentication Definitions

Authentication definitions specify how Sterling External Authentication Server
authenticates a security principal when a client application sends an authentication
request. Generic authentication definitions enable custom definitions using a
custom exit, attribute queries, and attribute assertions.

Creating a Generic Authentication Definition
About this task

To create a generic authentication definition:

Procedure
1. From the Authentication Definitions window, click the + icon .
2. On the LDAP Authentication screen, specify the following parameters and

click Next:
v Profile name
v Authentication type
v User ID required
v Password required
v Authenticate using custom exits

Note: If you define authentication as part of a certificate validation request,
Sterling External Authentication Server variables set during certificate
validation are available for the authentication. Refer to CV and Authentication
Definition Variables for more information about variables.

3. At the Attribute Query Definitions screen, do one of the following:
v To skip defining attribute queries and assertions click Next twice.
v To create attribute queries and assertions, go to Attribute Query Definition.

Custom Exit Configuration and Test for a Generic Authentication
Sterling External Authentication Server allows the use of a Java class or operating
system command to implement a custom exit from a generic authentication
definition. If you use a Java class as a custom exit, the class must implement the
Sterling-provided interface, SEASCustomExitInterface.

Prerequisites for Using a Custom Exit
Before you begin configuring a custom exit, perform the following prerequisite
tasks:
v Before you create a generic authentication definition that includes a custom exit

to a Java class, review the files in the install_dir/doc and install_dir/samples
subdirectories, where install_dir is the directory where Sterling External
Authentication Server is installed.

v Create a generic authentication definition that includes a custom exit to a script
or program. Define the functionality required by writing the code that runs from
the operating system command line.
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v For Java classes created for a custom exit, copy the class files or a .jar file to the
install_dir/lib/custom directory.

v Set logging to an appropriate level (such as DEBUG or ALL) to enable reviewing
the results of processing the Java class, script, or program that implements your
custom exit.

Custom Exit Class Development and Deployment in Java
The SEASCustomExitInterface interface and a sample class implementing the
interface are documented in the javadoc located in the install_dir/doc directory
and can be found in the archive, install_dir/lib/sterling/custom-exit.jar. The source
for the sample implementation can be found at install_dir/samples/
SampleAuthenticationExit.java.

The interface provides an initialization method that accepts a list of custom
properties you define for your class. You specify these properties (names and
values) from the GUI as part of the Custom Exit configuration in the generic
authentication definition.

You must compile your exit classes and provide them in a jar file, or as class files
with package structure preserved, in the install_dir/lib/custom directory. The
custom exit class loader searches all jar files and packages in this directory for the
custom exit class name you specify in the generic authentication definition.

Be sure to perform the prerequisite tasks listed in Prerequisites for Using a Custom
Exit before you begin configuring a custom exit for a generic authentication
definition.

Specifying a Java Class for a Custom Exit in a Generic
Authentication Definition

To specify a Java class for a custom exit in a generic authentication definition:

About this task

Procedure
1. Open the generic authentication definition.
2. Click the Generic Authentication tab on the Update Authentication Definition

screen.
3. Enable Authenticate using custom exits and then click .
4. On the Custom Exits dialog box, enable Java class.
5. In the Class name field, type the fully-qualified class name in the format

packageName.className when you specify the custom exit class that
implements SEASCustomExitInterface.

6. To specify properties for the class, click .
7. On the Properties dialog box, specify the name and value for each property

that is required to initialize your custom exit class. Use the + icon and the -
icon to add or remove rows of name and value pairs.

Results

After your generic authentication definition is used to process an incoming
authentication request, review the log for messages related to authentication
through the custom exit.
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Specifying an Operating System Command for a Custom Exit
About this task

To specify the operating system command to use for the custom exit:

Procedure
1. Open the generic authentication definition.
2. Click the Generic Authentication tab on the Update Authentication Definition

screen. Enable Authenticate using custom exits and then click .
3. To authenticate using a native operating system command as a custom exit,

enable Native OS command.

4. For Command line, specify the operating system command to use, including
all command line arguments. A user ID and password must be passed as
variables on the command line.

5. Specify one of the following methods to use to pass the certificate chain to the
operating system command.

Note: If certificates are processed, a certificate validation request to Sterling
External Authentication Server must be performed before you can pass a
certificate chain.
v Enable Certificate file to send the certificate chain as a certificate file. Define

the following parameters:
a. File name for the certificate chain or a valid variable expression (such as

the default, cert{counter}.pem).File name for the certificate chain or a
valid variable expression (such as the default, cert{counter}.pem).

Tip:

The default file name uses a counter to ensure that the file name is
always unique. The variable {counter} begins with a value of 0 and
increments after each invocation of the exit, resulting in the following file
names: cert0.pem, cert1.pem, cert2.pem, and so on. The file name can be
passed on the command line as the variable {filename}. For example, the
following command is a valid use of the file name:

openssl x509 -in {filename}
b. Specify the certificate chain File format as PEM or DER.
c. To remove the certificate file after the custom exit is complete, enable

Delete file after exit.

d. Click Standard input (PEM format) to pass the certificate chain through
the standard input stream.

v Specify the timing for running the custom exit and for authenticating as
configured in the generic authentication definition:
a. Select Run default validator after exit to continue processing the

authentication validation definition after the custom exit.
b. Select Run custom exit synchronously to enable synchronous use of this

custom exit. If you select this option, and if a client application sends an
authentication request with a reference to a definition including the
custom exit and the exit is currently running, then current exit processing
must complete before a subsequent invocation can run.
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6. Specify standard error log level and standard output log level to control how
output from the custom exit program is logged. Set the log level to meet your
reporting needs. Errors and console output is logged in the SEAS.log.

7. To redirect errors and output to the response message that Sterling External
Authentication Server returns to the client, select one or more of the following
parameters:
v Log output from stderr to response message—to send the error log output

to the response message.
v Log output from stdout to response message—to send the log output to the

response message.

Application Output Definition for a Generic Authentication Definition
Create an Application Output definition if you want Sterling External
Authentication Server to return application-specific data to the client application.
mappedUid and mappedPwd are defined to map log in credentials for Sterling
Secure Proxy.

When Sterling Secure Proxy is configured to use this feature, a user logs in to
Sterling Secure Proxy with a credentials. Sterling External Authentication Server
authenticates the credentials and returns a different set of credentials to use to log
in to the service in the trusted zone. This feature protects your internal systems
because the internal user IDs and passwords are not provided to external users.
External users are only able to log in through the Sterling Secure Proxy.

When creating an Application Output definition within a Generic Authentication
definition, specify the output values for mappedUid and mappedPwd as fixed
values or variable expressions. Refer to CV and Authentication Definition Variables
for more information.

Refer to Creation and Management of LDAP Authentication Definitions for
information about authenticating users using LDAP. When you create LDAP
authentication definitions, it is assumed that the mapped credentials will be stored
in the LDAP directory, and that a query can be constructed to retrieve those
credentials. A wizard launched from the Application Output Definition panel
constructs the LDAP query and creates expressions that are assigned to the
application output: mappedUid and mappedPwd.

In the typical case, these will be assigned as shown in the table below:

Output Name Sample Value

mappedUid {attr[MapCredentials].loginId}

mappedPwd {attr[MapCredentials].loginPwd}

When creating an Application Output definition within a Generic Authentication
definition, you can use LDAP as the credential store for mapping credentials. To
use this method, first create an Attribute Query definition, as described in Creation
and Management of LDAP Authentication Definitions. Then, manually make the
assignment to the output names.

For example, if you create an Attribute Query named MapCredentials to return the
loginId and loginPwd attributes of a loginCredentials entry as described in
Creation and Management of LDAP Authentication Definitions, the values shown
in the preceding table are used for the Application Output definition.
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Note: Application outputs can also be created and assigned directly using a
custom exit written in the Java programming language. For details, see
SEASCustomExitInterface.REQKEY_APPOUTPUTS in the Javadoc installed with
Sterling External Authentication Server.
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Chapter 18. Creation and Management of LDAP Authentication
Definitions

Authentication definitions specify how Sterling External Authentication Server
authenticates a security principal when a client application sends a request.
Authentication definitions include parameters for connecting to a server,
information needed to determine the authentication principal, and mechanisms
used for authentication. Creating authentication definitions allows you to specify
parameters that Sterling External Authentication Server uses when accessing
directories. The authentication definition can include definitions for any attribute
queries, attribute assertions, and application-specific outputs required to perform
authentication.

Note: Configure Active Directory , LDAP, or Tivoli before you create an
authentication definition.

Creating an LDAP Authentication Definition
About this task

To create an LDAP authentication definition:

Procedure
1. From the Authentication Definitions window, click the + icon to add an

authentication definition.
2. On the LDAP Authentication screen, specify the following parameters and

click Next.
v Profile name
v Authentication type
v Protocol
v Host
v Port
v LDAP principal to bind

Note: If you define an authentication method that is part of a certificate
validation request, the Sterling External Authentication Server variables set
during certificate validation are available for the authentication service. Refer to
CV and Authentication Definition Variables for more information about
variables.

3. On the LDAP Connection Settings screen, specify one or more of the following
parameters:
v Principal Name
v Principal Password
v Authentication Method
v Client Key Certificate Alias
v LDAP Version
v Start TLS
v Referral Action
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v Advanced options
4. To skip the attribute queries and assertions click Next twice.
5. To create attribute queries and assertions, refer to Creation and Management of

Attribute Queries and Assertions.

User Authentication Profile Creation in Sterling External Authentication
Server

Follow the instructions in the procedure, Create an LDAP Authentication to create
a User authentication profile. Use the table below to identify the values to assign
in Sterling External Authentication Server.

Sterling External
Authentication Server Field Value to Assign

Profile name Name for the profile

Authentication type LDAP

Host Host name or IP address of the Active Directory server

Port Port number to connect to the Active Directory server

LDAP principal to bind Specify user DN

Replace base DN with the distinguished name where
users are stored, for example,
CN=Users,DC=example,DC=com.

Application Feature Lookup login credentials (Sterling) to configure user ID,
password, or routing key mapping.

User authenticated user
connection

Connection definition for the Active Directory server.

Specify query parameters Enable to allow you to define the query parameters.

Return Attributes Mapped credentials to return. By default, loginId,
loginPwd, and routingKeyName are returned.

Delete any attributes you don't want to map.

Application Outputs Definition Creation for an LDAP Authentication
Definition

Create an Application Output definition for an authentication definition when you
need to perform an LDAP query and return login credentials to the client
application. Lookup Login Credentials can be set in an Application Outputs
definition to return login credentials to the client application.

The schema of an LDAP directory defines the objects allowed in the directory. A
directory schema object is defined to store login credentials. Sterling External
Authentication Server includes schema extension files for OpenLDAP (sci.schema)
and IBM Tivoli Directory Server (v3.schema) in the install_dir/schema directory,
where install_dir is the Sterling External Authentication Server application.

Use the schema files directly to extend your schema for OpenLDAP and IBM Tivoli
Directory Server directories, or use the schema file as a reference when you
manually extend other directories. If you use these directory extensions and
populate directory entries, the creation of an application output definition is mostly
automated. Alternatively, you can use an arbitrary directory object that stores a
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user ID and password, as long as the password can be retrieved as unencrypted
data. When using an arbitrary directory object, you must define the attribute query
that stores a user ID and password, as long as the password can be retrieved as
unencrypted data. When using an arbitrary directory object, you define the
attribute query that obtains the credentials for the application outputs definition.
Then you can use controls on the Application Outputs Definition dialog to
manually map attributes returned by the query to outputs that a client application
can access.

Directory Preparation for Use with Lookup Login Credentials
To add a directory object for Lookup Login Credentials, you must extend the
schema for the directory. IBM provides schema extension files for use with
OpenLDAP. Use the following procedures to extend the schema for the server.

Note: Refer to Configuration of Active Directory to Prepare for Use with Sterling
External Authentication Server for instructions on configuring Active Directory.

For other LDAP servers, follow instructions provided with the product to manually
extend the schema. Reference the schema file, install_dir/schema/sci.schema, for
definition of the object class, loginCredentials, and its associated attributes.

Extending the Schema for OpenLDAP
To edit the schema for OpenLDAP:

Procedure
1. Copy the OpenLDAP schema file (at install_dir/schema/sci.schema) to the

schema subdirectory of OpenLDAP. Schema files are in the
/etc/openldap/schema subdirectory.

2. Edit the slapd.conf file to add an include statement that includes the
sci.schema. The slapd.conf file is normally in /etc/openldap.
The following line includes the sci.schema for a standard OpenLDAP
installation:
include /etc/openldap/schema/sci.schema

3. Restart the LDAP server.

Extending the Schema for IBM Tivoli Directory Server
To edit the schema for IBM Tivoli directory server:

Procedure
1. Copy the V3.sci and V3.openssh-lpk files, located in the install_dir/schema

directory, to the schema subdirectory of the Tivoli installation, normally in the
/usr/ldap/etc folder.

2. Edit the ibmslapd.conf file, located in the /user/ldap/etc directory. Add
include statements for the V3.sci and V3.openssh-lpk schemas.
Following is a sample of the include statements to add to V3.sci and
openssh-lpk schemas to the ibmsladp.conf file:
include ibm-slapdIncludeSchema: /usr/openldap/etc/ldapschema/V3.sci
includeibm-slapdIncludeSchema: /usr/openldap/etc/ldapschema/V3.openssh-lpk

3. Restart the LDAP server.
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Entry Creation for Login Credentials
After you add the SCI schema objects to your directory, you can create
loginCredentials entries. The supported directory structure creates separate
loginCredentials entries as children of the authenticated user's directory entry; one
for each destination service. Set the loginId and logingPwd attributes to the ID and
password needed to login to the destination service. The password must be
entered in binary. The attribute, loginTarget, must be set to the destination service
name that is passed in the Authentication Request from the client application. With
this arrangement, the query to fetch the credentials is pre-populated with the
correct values and the mapping to outputs is performed automatically. Refer to
LDIF Entry Example to see an example of an entry in the supported structure. If
you use a different structure from the preceding example, you must modify the
attribute query to find the entry in your tree as required.

LDIF Entry Example for LDAP
The LDIF entry below demonstrates an entry in the supported structure:
dn: cn=SSP1-App2 Login Credentials, cn=User010101, ou=SterlingEAS 2.0
Users, dc=IBM, dc=com
objectClass: loginCredentials
objectClass: top
cn: SSP1-App2 Login Credentials
description: User010101’s login credentials for SSP1-App2 (loginPwd=loginPwd2)
loginId: loginId010101
loginPwd:: loginPwd2
loginTarget: SSP1-App2

In the preceding LDIF entry, Sterling External Authentication Server authenticates
the user, User010101, by binding to the following DN: cn=User010101,
ou=SterlingEAS 2.0 Users, dc=IBM, dc=com. Assume that with the directory
information tree structured as indicated in the example, a client application sends
an authentication request that references a destination service, SSP1-App2. The user
ID to log in to this service is loginId010101 and the corresponding password is
loginPwd2. Sterling External Authentication Server queries the loginCredentials
entry and returns the user ID and password to the client application in the
authentication response.

Mapping Query Return Attributes to Application Output Names in an
Application Outputs Definition

To create an application outputs definition:

Procedure
1. On the Application Outputs screen, from the Application Feature field, select

the method to use to return attributes to the client application for the
authentication definition:
v To query the IBM loginCredentials directory object of returning attributes in

Sterling External Authentication Server, select Lookup loginCredentials
(Sterling).

v To query any other directory object, select Lookup loginCredentials
(Custom).

2. Click Query to create an LDAP attribute query that returns the attributes to be
mapped to application outputs for return to the client application.
v If you selected the Sterling loginCredentials application feature:
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a. If the authenticated user has read permission on these entries, click Next.
Otherwise, select your connection preference before proceeding to the
next screen.

b. With directory entries arranged as described in LDIF Entry Example, the
Query Parameters screen includes the appropriate parameters; you can
simply review them and click Next. Otherwise, edit the Base DN, Scope,
and Match Attributes as needed before proceeding to the next screen. See
Attribute Query Definition for instructions.

c. Review the details summarized on the Confirm screen. Click Save if all
parameters are set correctly. Click Done to return to the Application
Outputs screen, where the mapping of return attributes to outputs has
been performed automatically.

v If you selected the Lookup loginCredentials (Custom) application feature:
a. Construct an attribute query to return the user ID and password from the

directory object. See Attribute Query Definition.
b. After the Attribute Query wizard closes, you must manually map the

return attributes to the respective output names.
c. In the left pane, click the Output Name, mappedUid. Selecting the output

highlights it.
d. Click the query return attribute that corresponds to the user ID for the

destination service in the right pane. Selecting the attribute highlights it
and Map is no longer dimmed.

e. Click Map to complete the mapping of the user ID attribute to the output
name. Repeat this procedure to map the password attribute returned
from your query to the Output Name, mappedPwd.

Editing or Copying an LDAP Authentication Definition
Changes in requests from client applications require that you make related changes
in the authentication definitions. You can change how Sterling External
Authentication Server operates by copying, editing, and deleting authentication
definitions.

About this task

To copy and edit an LDAP authentication definition:

Procedure
1. From the Authentication Definitions window, perform one of the following

actions:
v To copy of an authentication definition, select the definition to copy and click

.
v To edit an authentication definition, double-click the definition to edit.

2. Type a unique Profile Name if you are copying an authentication definition.
3. For LDAP authentication, update the parameters as required.

Note: If defining an authentication that is a continuation of a certificate
validation request, the Sterling External Authentication Server variables set
during certificate validation are available for the authentication service. Refer to
CV and Authentication Definition Variables for more information about
variables.
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4. To change LDAP connection settings, click the LDAP Connection Settings tab.
Change the parameters as required.

5. Click OK.

Deleting an Authentication Definition
About this task

To delete an authentication definitions:

Procedure
1. From the Authentication Definitions window, select the authentication

definition to delete and click the - icon .
2. Click OK.
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Chapter 19. Creation and Management of Tivoli Access
Manager (TAM) Authentication Definitions

Create Tivoli Access Manager (TAM) authentication definitions to specify
parameters that Sterling External Authentication Server uses when accessing Tivoli
Access Manager resources.

Refer to the following procedures to create a Tivoli Access Manager authentication
definition:
v Creating a Tivoli Access Manager Authentication Definition
v Creating an Application Output Definition for TAM

Tivoli Access Manager Authentication
Sterling External Authentication Server provides an authentication service for
interfacing with Tivoli Access Manager (TAM). The TAM authentication service
provides user ID/password authentication and/or user DN authentication through
Tivoli Access Manager. DN authentication allows you to authenticate the subject of
a certificate received during certificate validation. The TAM authentication service
can also provide application-level authorization for accessing a destination service
specified in the authentication request and provide credential lookup for logging in
to the destination service.

Prerequisites for Tivoli Access Manager Authentication
Each TAM authentication definition (policy) created must be configured to securely
communicate with the TAM Authorization server and the TAM Policy server.
Before you create a TAM authentication definition, review the release notes to
ensure that your system meets the requirements for authenticating with TAM and
that you have performed the prerequisite tasks.

Log Information for Tivoli Access Manager Authentication
Because the child process running the TAM API communicates over standard I/O
streams to the parent process (the CV process), it is critical that the logger not be
configured to use the console appender for output. By default, both processes share
conf/log4j.properties for configuring logging output as well as the active log file in
the logs directory. You can create a separate log4j.properties file for the child
process (the TAM API process) if desired, to allow the parent process to log to the
console. The child process looks for its own log4j.properties file in the
lib/sterling/retro14 directory. If the child process does not find its own properties
file, the parent log4j.properties file is used.

Creating a Tivoli Access Manager Authentication Definition
About this task

To create a Tivoli Access Manager (TAM) authentication definition:

Procedure
1. From the Authentication Definitions window, click the + icon to display the

LDAP Authentication screen.
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2. In the Authentication type field, select TAM to display the Tivoli Access
Manager Authentication screen.

Note: When TAM authentication is used, the first line of the log4j.properties
file should remain commented out. The TAM authenticator will not function if
console output is enabled.

3. On the Tivoli Access Manager Authentication screen, specify the following
parameters and click Next.
v Profile Name
v TAM Config File URL
v Target JRE location
v TAM User to Authenticate
v User ID required
v Password required
v Authorize Access to Destination Service

4. At the Attribute Query Definitions screen, do one of the following:
v To skip defining attribute queries or assertions, click Next twice and continue

with Creating an Application Output Definition for TAM.
v To create an attribute query or assertion definition, go to Creation and

Management of Attribute Queries and Assertions.

Creating an Application Output Definition for TAM
The application output for TAM is implemented using TAM GSO resource
credentials.

About this task

To create an application output definition for TAM:

Procedure
1. On the Application Output screen, specify outputs you want the authentication

definition to return to the client application.
v Return TAM Credentials
v Return Destination Service Login Credentials

2. Click Next and click Save.

Editing or Copying a TAM Authentication Definition
Changes in requests from client applications require that you make related changes
in the authentication definitions. Change how Sterling External Authentication
Server operates by copying, editing, and deleting authentication definitions.

About this task

To copy or edit a TAM authentication definition:

Procedure
1. Do one of the following:

v To make a copy of a TAM authentication definition, select the definition to
copy and click .
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v Type a new Profile Name.
v To edit a TAM authentication definition, double-click the definition.

2. To change a TAM authentication, update parameters as required. Refer to
Creating a Tivoli Access Manager Authentication Definition for more
information.

3. To edit application outputs for a TAM authentication definition, click the
Application Output tab and update the parameters as required. Refer to
Creating an Application Output Definition for TAM.

Deleting an Authentication Definition
About this task

Delete any authentication definition that is no longer needed.

To delete an authentication definitions:

Procedure
1. From the Authentication Definitions window, select the authentication

definition and click the - icon .
2. Click OK.
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Chapter 20. Creation and Management of Attribute Queries
and Assertions

The certificate validation and authentication definitions can include LDAP attribute
queries to find and check specified data from a request against entries in a
directory.

Attribute Query Definition

Creating an Attribute Query Definition
Define LDAP attribute queries to find and check data from a request against
entries in a directory. To create a query:

Procedure
1. On the Attribute Query Definitions screen, click the + icon .
2. Specify a name and description.

Note: For a definition that requires certificate-based routing, the CV definition
must include an LDAP attribute query called Routing Names. Construct the
Routing Names query to use the subject from the CV request and look up a
corresponding attribute (group name) that is returned to the client application
to determine the connection for routing.

3. Specify one of the following connection methods to the LDAP server:
v Use globally defined connection—Use a definition that is already created.

Protocol, host, and port for the LDAP server are automatically populated.
v Use authenticated user's connection—Only available for attribute queries

within LDAP authentication definitions. The query is submitted over the
bound session created when the user in the authentication request is
authenticated. This prevents the need to perform an additional bind
operation to the LDAP server, or to specify login credentials or other
parameters required to perform the bind. For the query to succeed, the user
must have read permissions over the scope of the search specified by this
query definition.

v Define connection info with query—To specify protocol, host, and port
information.

4. In the Query specification section, specify how to perform the LDAP attribute
query:
v Specify query parameters—To query for attributes you define.
v Specify query as URL—A valid URL to use to perform the LDAP attribute

query. The following example shows a valid LDAP URL format:
ldap://host:port/BaseDN?Attributes?Scope?SearchFilter

Type the URL and confirm that it includes the elements to perform the query
as required.

5. Specify query parameters. Refer to Specifying Query Parameters.

© Copyright IBM Corp. 2005, 2013 135



Specifying Query Parameters
About this task

If you chose the Define connection info with query parameter when defining an
attribute query definition, you must specify protocol, host, and port information.

To specify the protocol, host, and port:

Procedure
1. On the Query Parameters screen, define the parameters to use to perform the

attribute query:
v Protocol
v Host
v Port
v Base DN
v Return Attributes
v Scope
v Match Attributes
v Query Timeout

2. Click Save and Close.

3. From the Attribute Query Definitions screen:
v Repeat the previous steps to create another attribute query definition.
v To create an attribute assertion definition, click Next.
v To create the certificate validation without an attribute assertion, click Next

twice.

Specifying Match Attributes
About this task

Match attributes specify how search filters are used to find entries in a directory.
See CV and Authentication Definition Variables, for information about using
variables.

To specify attributes you want to compare to entries in a directory:

Procedure
1. On the Match Attributes dialog box, click Name and type the name used for

matching.
2. Click Value and type the value to use for matching.
3. Repeat Step 1 and Step 2 to specify more match attributes as required.
4. Click OK. The attributes are displayed as Name=Value on the Query

Parameters screen.

Specifying JNDI Properties for a Connection
About this task

If you use a JNDI (Java Naming Directory Interface) service provider that requires
special properties, you can assign the appropriate names and values for the custom
JNDI properties to associate with a server connection.
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To specify JNDI properties for a connection:

Procedure
1. On the JNDI Properties dialog box, click Name and type the value to use.
2. Click Value and type a valid string to specify the value.
3. Repeat Step 1 and Step 2 to specify as many JNDI properties as required.
4. Click OK. Attributes specified display as Name=Value in JNDI Properties on

the LDAP Connection Settings screen.

Editing or Copying an Attribute Query Definition
About this task

To edit an attribute query definition, click the Summary tab to view a list of the
parameters for each functional area. Then click the tab for the area to edit.

To edit or copy an attribute query definition:

Procedure
1. To edit a definition, double-click the CV definition that contains the attribute

assertion to modify in the Certificate Validation Definitions list.
2. To copy a definition. select the CV to copy from the Certificate Validation

Definitions window, and click .
3. Make the changes required.
4. Click OK.

Deleting an Attribute Query Definition
About this task

To delete an attribute query definition that is part of a CV definition:

Procedure
1. From the Certificate Validation Definitions window, select the certificate

validation definition that contains the attribute query definition to delete and
click .

2. From the Attribute Query Definitions window, select the query to delete and
click the - icon .

3. Click OK at the confirmation message.

Query to Check for Allowed IP Addresses
Define a query to look up the incoming IP address on the Allowed Hosts container.
If the IP address is found, the query is successful and the dn attribute of the host
record is returned. If the IP address is not found, the query fails and the certificate
validation, user authentication, or SSH key authentication request fails.

Complete the procedure, Creation and Management of Attribute Queries and
Assertions, to add the query. Use the values in the following table to determine the
values to assign in Sterling External Authentication Server. Create an
authentication definition before you create this procedure.
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Sterling External
Authentication Server Field Value to Assign

Name Name of the attribute query definition.

Connection Specification Use globally defined connection

Select the connection definition for the AD server.

Specify query parameters Enable this option to allow you to define the query
parameters.

Base DN Distinguished name where service groups are stored, for
example, CN=Allowed
Hosts,DC=SEAS,DC=example,DC=com.

Return Attributes dn

Scope One Level

Match Attributes Name=ipNetworkNumber Value=IpAddress

User Authentication Profile Query to Validate an IP Address and User
ID

This procedure assumes that you have already created a user authentication
definition. Complete the procedure, Attribute Query Definition to create an
assertion to compare the incoming IP address against the list of IP addresses
assigned to the user. The assertion examines the ipHostNumber attribute of the
user record. If it is equal to any of the values, it returns true. If it is not, it
compares the incoming IP address against the value(s) in the ipHostNumber
attribute. If the IP address is found in any of the values stored in the
ipHostNumber attribute, the assertion succeeds. Otherwise, the assertion fails, and
the user validation request also fails.

Use the values in the following table to determine the values to assign in Sterling
External Authentication Server.

Sterling External Authentication
Server Field Value to Assign

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection

Specify query parameters To define the query parameters

Base DN {principal}

Return Attributes dn, ipHostNumber

Scope Base

Attribute Assertions Definitions

Name Name for the assertion

Assertions {attr[FindUserIPAddrs].ipHostNumber} == any ||

{attr[FindUserIPAddrs].ipHostNumber} == {ipAddress}

138 Sterling External Authentication Server: Implementation Guide



Query to Validate an IP Address and Certificate
This procedure assumes that you have already created a certificate authentication
definition. Complete the procedure, Attribute Query Definition to create an
assertion to compare the incoming IP address against the list of IP addresses
assigned to the user.

The FindHostGroup query you define looks up the host group corresponding to
the certificate's organization and including the incoming IP address as a member. If
the group is not found, the certificate validation request fails.

Use the values in the following tables to determine the values to assign in Sterling
External Authentication Server. Use the first set of values to define the query to
look up an incoming IP address and the second values to create a query to find the
host group for the certificate's organization. When you add the queries you
defined, place the first query called FindHostDN first in the order and
FindHostGroup second in the list.

Table 3. FindHostDN Query Values

Sterling External
Authentication Server Field Value to Assign

Name Name of the attribute query definition, for example,
FindHostDN.

Connection Specification Use globally defined connection

Select the connection definition for the AD server.

Specify query parameters To define the query parameters

Base DN Distinguished name for the hosts container, for example,
CN=Allowed Hosts,CN=SEAS,DC=example,DC=com.

Return Attributes dn, flags

Scope One Level

Match Attributes Name=ipNetworkNumber Value=IpAddress

Attribute Assertions
Definitions

Name Name for the assertion

Assertions {attr[FindUserIPAddrs].ipHostNumber} == any ||

{attr[FindUserIPAddrs].ipHostNumber} == {ipAddress}

Table 4. FindHostGroup Query Values

Sterling External Authentication
Server Field

Value to Assign

Name Name of the attribute query definition, for example,
FindHostGroup

Connection Specification Use globally defined connection

Select the connection definition for the AD server

Specify query parameters To define the query parameters

Base DN Distinguished name for the hosts group, for example,
CN=Host Groups,CN=SEAS,DC=example,DC=com).

Return Attributes dn, uniqueMember
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Table 4. FindHostGroup Query Values (continued)

Scope One Level

Match Attributes Name=o Value=I{subject.o, none}

Name uniqueMember Value= {attr[FindHostDN].dn}
Note: Certificate subjects may not have an organization.
Specify None if the certificate subject does not have an
organization. You can create a host group named No Org
Hosts with an o attribute equal to none to group hosts
that present certificates with no organizations.

Sterling External Authentication Server Authentication Profile Query to
Validate the User ID and Service

Add a query to an Sterling External Authentication Server authentication profile to
validate the user ID and service. This procedure assumes that you have already
created an authentication definition. Refer to Attribute Query Definition for
instructions.

Use the following table to determine the values to assign in Sterling External
Authentication Server.

Sterling External
Authentication Server Field Value to Assign

Name Name of the attribute query definition

Connection Specification Use authenticated user's connection

Specify query parameters To allow you to define the query parameters

Base DN Type the distinguished name where service groups are
stored, for example, CN=Service
Groups,DC=SEAS,DC=example,DC=com.

Return Attributes dn

Scope Select One Level

Match Attributes Name=ou Value=destinationService

Name=uniqueMember Value={principal}

Attribute Assertion Definition
You can create an attribute assertion definition to specify a Boolean statement that
must evaluate as true in order for the authentication request or certificate
validation request from a client application to succeed. Attribute assertions allow
the specification of additional conditions and can compare details from the request
to fixed data or to attributes returned from queries.

Creating an Attribute Assertion Definition
To create an attribute assertion:

Procedure
1. From the Attribute Assertion Definition screen, click the + icon to display the

Add Assertion Definition dialog box. Specify the following parameters:
v Name
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v Assertion
2. Click OK. The definition is displayed on the Attribute Assertion Definitions

screen.

Editing an Attribute Assertion Definition
To modify an attribute assertion definition:

Procedure
1. On the Attribute Assertion Definitions screen, select the attribute assertion to

edit.
2. Click .
3. Edit the Description or the assertion statement in Assertion.
4. Click the Summary tab and review all parameters. If the settings are accurate,

click OK.
5. Click the Referenced CRLs tab and change the referenced CRL by selecting it

and either moving it to the right to reference it or by moving it to the left to
stop referencing it.

Copying a CV Attribute Assertion Definition
About this task

Copy an attribute assertion definition to create a new assertion definition with
similar parameters.

To copy a CV attribute assertion:

Procedure
1. From the Certificate Validation Definitions window, select the definition that

contains the attribute assertion definition to copy and click .
2. From the Attribute Assertion Definitions window, select the definition and

click .
3. On the Add Assertion Definition screen, specify a name and description.
4. Define the assertion and click OK.

Deleting a CV Attribute Assertion Definition
About this task

To delete a CV attribute assertion definition:

Procedure
1. From the Certificate Validation Definitions window, select the certificate

validation definition that contains the attribute assertion definition to delete
and click .

2. From the Attribute Assertion Definitions window, select the attribute assertion
definition to delete and click the - icon .

3. Click OK at the confirmation message.
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Chapter 21. CV and Authentication Definition Variables

Sterling External Authentication Server supports using variables in certificate
validation and authentication definitions. Variables are resolved at runtime by data
from the certificate validation or authentication request, from the entity's certificate,
and from data returned from attribute queries you have configured.

Syntax and Rules
A variable consists of hierarchical groupings with nodes delimited by a period (.)
or square brackets ([ ]). Observe the following rules or guidelines when you use
variables:
v Sterling External Authentication Server variables are not case sensitive. The

following examples represent the Common Name attribute (CN) of the subject
field of a certificate and illustrate valid syntax formats:
– subject.cn
– subject[cn]
– Subject.CN

v To reference a variable in a definition, enclose the variable in curly braces, for
example, {Subject[cn]}.
A variable can be used in the specification of an attribute query. In the following
example, the URL changes at runtime, based on the contents of the certificate
subject referenced by the variable highlighted in bold:
ldap://ldaphost:389/cn={subject.cn},ou=users,dc=myCompany,dc=com?
DN?base?objectClass=pkiUser

v Variables representing a single element are represented by a single-node
variable. For example, the client ID field of the request is represented by the
single-node variable clientId.

v Variables that represent complex objects are represented by multiple nodes. For
example, a certificate includes a subject and issuer, both of which contain
attributes such as CN and OU. The CN attribute of the subject is represented by
the multi-node variable cert.subject.cn.

v Many multi-node variables can be abbreviated by omitting the parent node, or
nodes, if naming collisions are not created by doing so. For example,
cert.subject.cn can be abbreviated as subject.cn, or cn. And cert.issuer.cn can be
abbreviated as issuer.cn, but not as cn, because it would be indistinguishable
from the subject CN abbreviation.

v The root or intermediate node names used in some multi-node variables have a
value associated with them. For example, when cert is specified alone, it
represents the raw data of the end entity certificate in the certificate validation
request.

v You can assign a default value to variables to prevent a failure in the operation
when a variable is specified in a configuration parameter, but the variable
cannot be resolved.
For example, if you specify a Match Attribute in an LDAP Query Definition as:
ou={issuer.ou}, the query and the validation fail if no OU attribute is defined for
the issuer Distinguished Name. To prevent a failure, append a comma and
specify the default value inside the curly braces: ou={issuer.ou, default Issuer
OU}. If the issuer DN in the certificate has no OU attribute, the Match Attribute
resolves to: ou=default Issuer OU.
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v To prevent an illegal expression from being passed to the expression evaluator,
you should define default values for variables in expressions (for example, when
you configure formulas for evaluating X.509 Extensions).
Assume that the following formula has been configured: “{x} + {y} + {z}”, and
x=1, z=2 but “y” does not exist. The formula will resolve to “1 + + 2”, which
causes an error in the expression evaluator. You can prevent this type of error by
defining a default value for the “y” term {y, 0} to ensure that the formula
resolves to the legal and correct expression:
“1 + 0 + 2”.

Cert Variable Reference in an Attribute Assertion
The cert variable contains the raw data of the end entity X.509 certificate that is
received in the certificate validation request. In the following example, this data is
referenced in an Attribute Assertion statement to perform a binary compare of the
certificate received in a request to the certificate returned from an Attribute Query
named FindCert:
“{cert}” == “{attr[FindCert].userCertificate}”

Variables for Certificate Subject and Certificate Issuer
Variables for certificate validation definitions can reference attributes of the
Distinguished Name (DN) parameter for the certificate subject or certificate issuer
listed in the table on page 62. If the certificate subject or issuer parameter contains
any of these attributes, you can reference the value of that attribute by using a
variable in the format: {subject.attrName} or {issuer.attrName}, where attrName is
an attribute in the preceding list. The variables in the following examples are valid
representations of the CN attribute of a certificate subject and the user ID attribute
of a certificate issuer:
v {subject.CN}
v {issuer.UID}

Abbreviated Notation Usage for Subject
Because attributes of the certificate subject are expected to be the most commonly
used, you can abbreviate these attributes by omitting the subject component of the
variable name, leaving the standalone attribute name. For example, {subject.cn} can
be abbreviated as {cn}.

Variables for Distinguished Name
In addition to the individual attributes, you can reference the complete
Distinguished Name (DN) by the variable name DN, for example, {subject.dn}. The
DN string is always normalized for LDAP in the variable data. Specifically, if the
DN begins with the Country or Domain Component attribute, the DN is reversed.

For example, if a certificate has the following Distinguished Name in the subject
field:
C=US, ST=Texas, L=Irving, O=IBM, CN=Example

the variable referenced by {subject.dn} is resolved to the following string:
CN=Example,O=IBM,L=Irving,ST=Texas,C=US
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Reference to Distinguished Name Attributes with Multiple
Occurrences

If multiple occurrences of the same attribute occur within a Distinguished Name,
you reference the various occurrences with a numeric subscript. Start with 0 and
enclose the subscript in square braces to indicate which occurrence of the attribute
you want to reference.

Note: This subscripting scheme is applied after any normalization for LDAP.

For example, the following subject DN has two occurrences of the OU attribute:
CN=example, OU=ou0val, OU=ou1val, C=US

The following example references the first occurrence of the OU attribute in the
preceding example:
Subject.ou[0]

The following example references the second occurrence of the OU attribute:
Subject.ou[1]

The examples that follow show the OU attribute of the subject DN from the first
example. In the following example, the Base DN is shown as configured, expressed
in variables:
Cn={subject.cn}, ou={subject.ou[1]}, dc=my org, dc=com

The following example illustrates the Base DN with the variables resolved:
Cn=example, ou=ou1val, dc=my org, dc=com

Reference to a Relative Distinguished Name with a
Multi-Valued Attribute

Each node within a Distinguished Name is a Relative Distinguished Name (RDN®).
Typically, the RDN consists of a single attribute name/value pair, with a textual
representation: “name=value”. However, you can include multiple attributes within
a single RDN. This is represented (RFC 2253) by separating each name/value pair
with the plus (+) symbol: “name1=value1+name2=value2”.

To reference the individual attributes in a multi-valued RDN variable, use the
following syntax: “name1+name2.name1” and “name1+name2.name2”. For
example, if a certificate subject contains the following multi-valued RDN:
“cn=example+ou=multi-value”, a base DN could be specified in the configuration
as:
CN={subject[cn+ou].cn}, OU={subject[cn+ou].ou}, DC=my org, DC=com

The following example illustrates the base DN from the preceding example after
the variable is resolved:
CN=example, OU=multi-value, DC=my org, DC=com
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Chapter 22. X.509 Extensions

Certificate extensions were introduced in version 3 of the X.509 standard for
certificates. These v3 extensions allow certificates to be customized to applications
by supporting the addition of arbitrary fields in the certificate. X.509 v3 extensions
provide for the association of additional attributes with users or public keys. Each
extension, identified by its OID (Object Identifier), is marked as “Critical” or
“Non-Critical,” and includes the extension-specific data.

X.509 Extensions and RFC 3280
After the introduction of X.509 v2 for Certificate Revocation Lists (CRL) and X.509
v3 for certificates, the Internet Engineering Task Force (IETF) has since adopted the
standard documented in RFC 3280, “Internet X.509 Public Key Infrastructure --
Certificate and Certificate Revocation List (CRL) Profile.” The IETF adoption led to
the standardization of several extensions; however, the customization that
extensions allow is a source of interoperability issues.

Sterling External Authentication Server supports the following standardized
extensions:

Extension Description

Key Usage Defines the purpose of a key in a certificate.

Basic Constraints Whether the subject of a certificate is a Certificate Authority (CA)
and the maximum depth of a valid path for the certificate.

CRL Distribution
Points

How Certificate Revocation List (CRL) information is obtained
using the appropriate fields.

RFC 3280 requires that a system reject any critical extension that it does not
recognize. To address this requirement and to prevent interoperability issues,
Sterling External Authentication Server provides the following mechanisms for
extension support:
v Allow and require settings to explicitly allow and disallow specific extension as

a means of preventing failures from unrecognized critical extensions
v Boolean expressions for extension properties provide for application-specific

interpretation and enforcement of extensions

Allow and Require Settings
Sterling External Authentication Server provides support for an application to
explicitly allow or disallow a particular extension to appear in a certificate. If an
extension that is disallowed appears in a certificate, the Certificate Validation
Request fails. Similarly, it provides support for an application to explicitly require
that particular extensions appear in certificates. If a required extension is not
included in a certificate, then the Certificate Validation Request fails.

Boolean Expressions for Extension Properties
Sterling External Authentication Server also provides a mechanism for an
application to have very specific control of the interpretation and enforcement of a
particular extension. The general model for extension handling is that Sterling
External Authentication Server allows you to configure a custom expression for
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each extension, which is evaluated at runtime. The expression is declared
independently for client, server, and CA certificates so that different rules can be
applied to each. In the Sterling External Authentication Server user interface, this is
done in the properties panel for the specific extension. In general, the property
names are as follows:
v “Client-ExtensionName”
v “Server-ExtensionName”
v “CA-ExtensionName”

where ExtensionName is the extension's actual name; for example:
Client-KeyUsage.

For each property, there is a default Boolean expression that you can modify or
replace. If the expression does not evaluate to true, the certificate is rejected. Where
applicable, each default expression enforces the rules specified for the extension in
RFC 3280.

The Boolean expressions constructed for extension properties are modeled after the
Java language, using Java operators, precedence rules, balanced parentheses for
controlled precedence, and keywords such as true and false. Variables available in
these expressions include all the variables from the certificate, such as subject and
issuer attributes, plus variables specific to extensions.

Trivial Expressions: Keywords True and False
The simplest expressions consist of a single keyword:
v true—Evaluation of the extension always succeeds, regardless of the data.
v false—Evaluation of the extension always fails, regardless of the data.

Note: The keywords true and false must be written in lower case

Boolean Operators
You can use the following primary boolean operators:

Operation Description

&& Logical AND

|| Logical OR

! Logical NOT

( Begin grouping

) End grouping

Extension Variables
The full name of any extension variable is “ext.extensionName.variableName”, for
example, ext.keyUsage.keyCertSign. Depending on the reference, certain
abbreviations are allowed:
v Within its own extension definition: {variableName}
v Within another extension definition: {extensionName.variableName}
v Outside of extension definitions: {ext.extensionName.variableName}

Each extension has a Boolean variable, “isCritical”, which reflects the
critical/non-critical designation of the extension within the certificate. The other
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extension variables are specific to the extension. In general, the variables defined
correlate directly to fields documented for the extension in the relevant RFC or
reference document.

KeyUsage Extension
The KeyUsage extension defines the following variables, which correlate directly to
the bit fields defined in RFC 3280 for the extension:
v digitalSignature
v nonRepudiation
v keyEncipherment
v dataEncipherment
v keyAgreement
v keyCertSign
v cRLSign
v encipherOnly
v decipherOnly

Because the KeyUsage extension is a common area for problems with
interoperability, the default formulas for KeyUsage specify a minimal set of rules
that demonstrate the mechanics of the feature:
v Client-KeyUsage: !({encipherOnly} && {decipherOnly})
v Server-KeyUsage: !({encipherOnly} && {decipherOnly})
v CA-KeyUsage: !({encipherOnly} && {decipherOnly}) && {keyCertSign}

The first two rules state that it is not legal to set both the encipherOnly and
decipherOnly bits in the same certificate. The third rule adds that CA certificates
must include the keyCertSign bit. Replace or modify the expressions to implement
an application-specific policy for the key usage setting.

BasicConstraints Extension
The BasicConstraints extension is intended primarily for CA certificates. It has a
single Boolean variable, “cA”, which reflects whether or not the certificate is a CA
certificate. If the certificate is a CA certificate, it can also declare a pathLen
constraint that dictates how many sub-CAs are allowed to exist in the hierarchy of
CAs. The pathLen constraint is automatically enforced by Sterling External
Authentication Server.

The following expression is the default formula for CA certificates:

CA-BasicConstraints: {cA} && {KeyUsage.keyCertSign, false}

This default prevents problematic operation for many configurations. However, to
enforce rules for the BasicConstraints extension as specified in RFC 3280, use the
following formula:

CA-BasicConstraints: {isCritical} && {cA} && {KeyUsage.keyCertSign, false}

This rule states that CA certificates must designate the BasicConstraints extension
as critical, set the CA indicator, and set the keyCertSign bit in the keyUsage
extension.
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CRLDistributionPoints Extension
Sterling External Authentication Server supports the CRLDistributionPoints
Extensions for identifying how to obtain certificate revocation list information.
Using CRL Definitions you create and the CRL information included in some
certificates, Sterling External Authentication Server can locate the appropriate
directory and CRL.

When the CRLDistributionPoints extension references a CRL definition, the CRL
definition provides all information for the CRL except for the following details that
are always provided by the extension:
v Directory Name distribution points—The DN specified in the extension

overrides the Base DN specified in CRL definition and the scope is always set to
Base.

v URI distribution points—The protocol, host, port, and query specified in a CRL
definition are overridden by the protocol, host, port, and query information for
the URI specified in the extension. For LDAP this includes the Base DN, Scope,
Match Attributes, and Return Attributes.

Properties
The properties configured for the CRLDistributionPoints extension deviate from
the general “Client|Server|CA-ExtensionName” properties discussed so far.
Instead, two properties are defined for configuration:
v Ignore CRL Distribution Point—Instructs Sterling External Authentication Server

to ignore CRL Distribution Points encountered in end-entity certificates. This
property can be set to the keywords true or false, or to a formula that evaluates
to true or false. The CRL from an “ignored” distribution point will not be
retrieved; however, the extension is still parsed. In fact, the data in the
cRLDistributionPoints extension can be used in the formula to determine
whether or not a particular distribution point is ignored.

v Referenced CRL Definition—Allows a CRL definition to be associated with CRL
Distribution Points found in end-entity certificates. This property should be set
to the name of a previously-defined CRL definition. The name configured for
this property can include variables so that different CRL definitions can be
referenced based on, for example, the certificate issuer or the distribution point
data.

v CA - Ignore CRL Distribution Point—Instructs Sterling External Authentication
Server to ignore CRL Distribution Points encountered in CA certificates. This
property can be set to the keywords true or false, or to a formula that evaluates
to true or false. The CRL from an “ignored” distribution point will not be
fetched; however, the extension is still parsed. In fact, the data in the
cRLDistributionPoints extension can be used in the formula to determine
whether or not a particular distribution point is ignored.

v CA - Referenced CRL Definition—Allows a CRL definition to be associated with
CRL Distribution Points found in CA certificates. This property should be set to
the name of a previously-defined CRL definition. The name configured for this
property can include variables so that different CRL definitions can be
referenced based on, for example, the certificate issuer or the distribution point
data.

These properties are discussed more in the following sections.
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Distribution Point Formats
CRL Distribution Points refers to a feature of the X.509 v2 CRL that allows a CA
to partition its CRL into subsets, primarily in an effort to control the size of the
CRL. The CA can then encode a cRLDistributionPoints extension into each
certificate it issues to indicate the location of the distribution point(s) covering that
particular certificate. The cRLDistributionPoints Extension defines several formats
for publishing the address(es) of the distribution points. Sterling External
Authentication Server currently supports DirectoryName and
UniformResourceIdentifier (URI).

DirectoryName Distribution Points
The DirectoryName must be the full distinguished name (DN) of the directory
entry where the CRL resides. The directory hosting the distribution point must
support LDAP access.

A Directory Name distribution point specifies an X.500 Distinguished Name, but
not the location of the directory. Sterling External Authentication Server uses one
of two mechanisms to locate the LDAP server hosting the distribution point(s):
v Through DNS-based automatic service discovery. For this to work, your

environment must support service discovery, and the DN specified in the
cRLDistributionPoints extension must include Domain Components (DC
attributes).

v Through configuration that is accomplished in two steps:
1. Create a CRL Definition that specifies the LDAP server address.
2. Set the “Referenced CRL Definition” property or the “CA - Referenced CRL

Definition” property in the CRL Distribution Points configuration to the name
you assigned to the CRL Definition in step 1.

At runtime Sterling External Authentication Server uses the Referenced CRL
Definition, overriding the Base DN configured (if any) with the DN specified in the
cRLDistributionPoints extension, to find the distribution point CRL.

Note: All other fields specified in the CRL definition are used, including cache and
connection settings.

URI Distribution Points
Before you begin

The URI must be a full LDAP, LDAPS, HTTP, or HTTPS URL.

Typically, it is not necessary to reference a CRL definition when the distribution
point format is URI. However, if the server hosting the distribution point(s)
requires authentication, you may need to configure log-on credentials in a CRL
definition to be allowed access.

If this is the case, set the “Referenced CRL Definition” property or “CA -
Referenced CRL Definition” property in the CRL Distribution Points configuration
to the name of a CRL Definition you set up with the log-on credentials required to
access the server. At runtime, Sterling External Authentication Server uses the
credentials from the Referenced CRL Definition, and any other properties
configured (with the exception of the URL), to find the distribution point CRL(s).
The URL is always obtained from the cRLDistributionPoints extension in the
certificate.
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You can also reference a CRL definition to use other settings, such as cache
properties. As stated in the preceding example, any URL data configured in the
CRL definition is overridden by the URL from the cRLDistributionPoints extension
in the certificate.

Conditions for Using Variables with the CRLDistributionsPoints
Extension

Variables are unnecessary in the following situations:
v You do not use a CRL definition.
v A single CRL definition is configured to support all distribution points.
v The definition is referenced directly by name, without the use of variables.

Variables are necessary in the following situations:
v You use multiple CRL definitions to access multiple directories.
v The cRLDistributionPoints data in the certificate does not represent the true

address of the distribution point.

The CrlDistributionPoints Variable
The cRLDistributionPoints extension normally contains a single entry for one
distribution point, but allows for multiple distribution points, each of which can
contain multiple entries that designate alternate locations for finding the same
distribution point CRL. To accommodate this possibility, Sterling External
Authentication Server stores distribution point entries in a two-dimensional array
where the rows represent each distribution point and the columns represent each
entry defined for a given distribution point.

The full variable name used to reference any given cRLDistributionPoint entry is:

{ext.crlDistributionPoints.distributionPoint[N1][N2]}

where N1 is the distribution point index and N2 is the index for the entries of a
given distribution point. If there is a single distribution point entry in the
certificate, then this name can always be abbreviated as {distributionPoint}.

You can also use this abbreviation to represent the current entry when referenced
from one of the following:
v The “Ignore CRL Distribution Point” property or “CA-Ignore CRL Distribution

Point” property in the CrlDistributionPoints configuration.
v The “Referenced CRL Definition” property or “CA-Referenced CRL Definition”

property in the CrlDistributionPoints configuration.
v Within the actual CRL Definition specified by the “Referenced CRL Definition”

property in the CrlDistributionPoints configuration.

As Sterling External Authentication Server iterates through each distribution point
entry during cRLDistributionPoints processing, the variable {distributionPoint}
always resolves to the current distribution point being processed. This abbreviated
format will work in most cases.

Each distributionPoint variable (specified as either {distributionPoint} or
{ext.crlDistributionPoints.distributionPoint[N1][N2]}) contains the actual
distributionPoint data, which is a single GeneralName as specified in RFC 3280;
such as a URI or directory name, depending on the type. The full GeneralName is
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specified by the distributionPoint variable name. Its parsed component parts can
be specified by appending “.partName” to the end of the variable name. For
directoryName distribution points, the parsed component parts are the DN
attribute names, such as cn, plus “dn” to specify the complete DN normalized for
LDAP.

For example, a single directoryName distribution point extension, “dc=com,
dc=acme, ou=CA, cn=DP1” could be accessed in whole or in part by any of the
following:

Variable Name Value

{distributionPoint} dc=com, dc=acme, ou=CA, cn=DP1

{distributionPoint.dn} cn=DP1,ou=CA,dc=acme,dc=com

{distributionPoint.cn} DP1

{distributionPoint.ou} CA

{distributionPoint.dc[0]} acme

{distributionPoint.dc[1]} com

For URI distribution points, the parsed component parts are “protocol”, “host”,
“port”, “path” and “query”. For example, the distribution point specified above
could also be represented as the following URI: “ldap://svr:389/
cn=DP1,ou=CA,dc=acme,dc=com?certificateRevocationList?base
?objectClass=cRLDistributionPoint.”

This distribution point could then be accessed in whole or in part by any of the
following:

Variable Name Value

{distributionPoint.protocol} ldap

{distributionPoint} ldap://svr:389/cn=DP1,ou=CA,dc=acme,dc=com?certificateRevocationList?
base?objectClass=cRLDistributionPoint

{distributionPoint.host} svr

{distributionPoint.port} 389

{distributionPoint.path} /cn=DP1,ou=CA,dc=acme,dc=com

{distributionPoint.query} certificateRevocationList?base?objectClass=cRLDistributionPoint

The distribution point type is also available from the distributionPoint variable by
appending “.type”, “.typeName” or “.typeLongName” to the distributionPoint
variable, as described in the following table:

Variable Name Value for URI Value for DirectoryName

{distributionPoint.type} 6 4

{distributionPoint.typeName} URI DN

{distributionPoint.typeLongName} uniformResourceIdentifier directoryName

Example of Multiple CRL Definitions
The following example applies if multiple CRL definitions are required as in the
case where directoryName distribution points are spread across multiple

Chapter 22. X.509 Extensions 153



directories that are not resolved automatically through referrals. For example, a CA
with issuer name: “ou=CA, dc=acme, dc=com”, may have two directoryName
distribution points:
v DN=“cn=DP1, ou=CA, dc=acme, dc=com” Host=ldap1
v DN=“cn=DP2, ou=CA, dc=acme, dc=com” Host=ldap2

To support this situation, set up two CRL definitions:
v Name=“DP1-CrlDef” Host=“ldap1”
v Name=“DP2-CrlDef” Host=“ldap2”

Then set the CrlDistributionPoints properties as follows:
v Ignore CRL Distribution Point: false
v Referenced CRL Definition: {distributionPoint.cn}-CrlDef

At runtime, Sterling External Authentication Server resolves the variable
“Referenced CRL Definition” to DP1-CrlDef or DP2-CrlDef, depending on the CN
extracted from the distribution point DN in the extension, which allows Sterling
External Authentication Server to access the correct directory hosting the
distribution point CRL. The example described below allows the use of the
abbreviated distributionPoint variable.

Example of Distribution Point Variables
This example illustrates the need to use variables when the crlDistributionPoints
data in the certificate do not represent the true address of the distribution point
server, for instance, due to an address change. For example, a CA may have issued
certificates with either of the following URI distribution points:
v ldap://ldap1/cn=DP1,ou=CA,dc=acme,dc=com?certificate

RevocationList?base?objectClass=cRLDistributionPoint
v ldap://ldap2/cn=DP2,ou=CA,dc=acme,dc=com?certificate

RevocationList?base?objectClass=cRLDistributionPoint

Due to a network reconfiguration, or some other reason, you may need to address
these servers with their full DNS name, ldap1.acme.com or ldap2.acme.com. To
support this, you can set up a single global CRL definition with the following URL
specified:

ldap://
{distributionPoint.host}.acme.com{distributionPoint.path}?{distributionPoint.query}

Additionally, set the CrlDistributionPoints property “Ignore CRL Distribution
Point” to true to prevent access to the original, unreachable URI address specified
for the LDAP servers in the distribution point URI.

At runtime, Sterling External Authentication Server checks the global CRL and
resolves the URL to one of the following, depending on the distribution point data:
v ldap://ldap1.acme.com/cn=DP1,ou=CA,dc=acme,dc=com?certificate

RevocationList?base?objectClass=cRLDistributionPoint
v ldap://ldap2.acme.com/cn=DP2,ou=CA,dc=acme,dc=com?certificate

RevocationList?base?objectClass=cRLDistributionPoint
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Custom Extensions
The Custom Extensions feature is a mechanism provided in Sterling External
Authentication Server to allow X.509 v3 extensions unknown to the system to
become known. Sterling External Authentication Server will not process the
extension, but can disallow or require the presence of the extension, and if
appropriate, can accept an otherwise unknown critical extension. The Custom
Extensions feature is also useful for the elimination of log file messages for
unsupported extensions and for providing more meaningful debug-level log
entries.

To register the extension with Sterling External Authentication Server, it is only
necessary to enter the OID of the extension and assign a name. The standard
extension-handling options apply and are provided in the following list with their
default settings:
v Allow—True
v Require—False
v Properties:

– Client-ExtensionName—!{isCritical}
– Server-ExtensionName—!{isCritical}
– CA-ExtensionName—!{isCritical}

However, with the default settings allowing or requiring the presence of the
extension (other than the effect on logging) is no different than if the extension
were never registered. You may need to modify one or more of the Allow or
Require settings, or modify properties. For instance, if the extension is marked
critical, set the Client-ExtensionName formula to true to prevent the system from
rejecting client certificates.
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Chapter 23. Management of Users and Roles

Sterling External Authentication Server can be used by administrators who have
different network administration and configuration tasks to perform. Use the
following procedures to customize the user and role definitions:
v User Management
v Role Management

User Management
User definitions identify users in Sterling External Authentication Server. When
you define users in the system, you specify a user name and password and assign
the user a role. The admin role is the only role available for assignment initially; it
enables all permissions by default. See Creating a Role Definition to create
additional roles that enable you to allow only the required permissions for users.

Creating a User Definition
About this task

To create or copy a user definition:

Procedure
1. From the Manage menu, select Users.

On the External Authentication User Definitions window, click the + icon and
specify the following parameters:
v Name
v Password
v Confirm Password
v Role
v Description
v Properties

2. Click Save.

Changing a User Definition
About this task

To change a user definition.

Procedure
1. From the Manage menu, select Users.
2. Select the user definition to edit and click .
3. On the Update User dialog box, update the user definition by making the

required changes.
4. Click Save.

Deleting a User Definition
You cannot delete a user that is currently logged in.

© Copyright IBM Corp. 2005, 2013 157



About this task

To delete a user definition:

Procedure
1. From the Manage menu, select Users.

2. Select the user definition to delete and click .
3. Click OK.

Role Management
The admin role is predefined and is the only role you can assign to users initially.
By default, the admin role allows all permissions for users assigned the role.
Create additional roles to allow only the required permissions for users assigned
that role.

Note: The user roles that exist in Sterling External Authentication Server include
the anon role. The anon role is used by incoming client applications that request
certificate validation and cannot be assigned to users.

Creating a Role Definition
About this task

You can create new roles and allow Sterling External Authentication Server users
to create, read, update, delete, and execute permissions in the functional areas.

To create a role definition and set permissions:

Procedure
1. From the Manage menu, select Roles.

2. On the External Authentication Role Definitions screen, click the + icon .
3. On the Add Role dialog box, specify the following parameters:

v Role name
v Description
v Permissions
v Select All
v Cert Validation
v Cert Revocation
v Authentication
v Accepter
v User
v Role
v System

4. Click OK to save the role.

Changing a Role Definition
To change the definition of a role:
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Procedure
1. From the Manage menu, select Roles.
2. Select the role definition to edit and click .
3. On the Update Role dialog box, update the role definition:
4. Click OK to save the changes.

Deleting a Role Definition
You cannot delete a role that is assigned to a user who is currently logged in.

About this task

To delete a role definition.

Procedure
1. From the Manage menu, select Roles. The External Authentication Role

Definitions screen is displayed with a list of the role definitions.
2. Select the role definition to delete and click the - icon .
3. Click OK to confirm the deletion.
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Chapter 24. Customization of Layout Views

You can view a variety of information for the definitions displayed. Each definition
window has a default view, but you can also customize views by performing the
following actions:
v Display or hide the columns you select
v Rearrange columns in an order that is important to you
v Save a view for future use
v Rename a view
v Delete a view

Hiding Columns
About this task

You can hide columns to customize layout views.

Procedure
v To hide a column, right-click the column to hide and click Hide Column.
v To hide one or more columns:

1. Right-click the column heading and click Manage Columns.
2. Move the columns you want to hide to the Available Columns list using the

arrow buttons.

Restoring Columns
About this task

To restore a hidden column:

Procedure
1. Right-click the column heading and click Manage Columns.
2. Move the columns you want to restore to the layout by moving them from the

Available Columns list using the arrow buttons.

Managing Columns
About this task

To create a custom view:

Procedure
1. Right-click a column and click Manage Column.
2. To add a column, select the column to be added in the Available Columns list

and click >.
3. To remove a column, select the column to remove in the Selected Columns list

and click <.
4. To rearrange columns, select the column to rearrange in the Selected Columns

frame, and click the up or down arrow to move it to a new location.
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Columns appear in the layout in the order in which they appear in the
Selected Columns list.

5. Click OK.

Column Rearrangement and Resizing
You can rearrange the order of columns in a view by dragging a column heading
to the desired position. You can also change the width of a column by dragging a
column heading border until the column is at the desired width. These settings are
saved for each user.

Saving a Column Layout
About this task

Saving a column layout enables you to change the arrangement of columns and
see details that are relevant for certain tasks. First rearrange, resize, and hide
columns to create an alternate view, then save the column layout with a descriptive
name.

To save a new column layout:

Procedure
1. Right-click any column and click Save Layout.
2. Type a name for the new layout in Layout Name.
3. Click OK.

Selecting a Column Layout View

Procedure

To select a column layout that you have defined, right-click any column and select
Select Layout > name of customized layout.

Column Layout View Management
You can rename a column layout view or delete a column layout view from the
Manage Layout window.

Renaming a Column Layout View
About this task

To rename a column layout:

Procedure
1. Right-click any column and select Manage Layouts.
2. Select the layout you want to rename and click Rename.
3. Type a name for the layout in the Layout Name field and click OK.
4. Click Close.
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Deleting a Column Layout View
About this task

To delete a column layout:

Procedure
1. Right-click a column and select Manage Layouts.
2. Select the layout you want to remove and click Remove.
3. Click Close.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2013. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2013.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

168 Sterling External Authentication Server: Implementation Guide



Index

Special characters
-alias alias_name, field definition 24
-dname option

specify distinguished name for
self-signed GUI certificate 23

-dname, field description 24
-genkey, field definition 24
-keyalg alg_type, field definition 24
-keysize keysize, field definition 24
-keystore keystore_path, field

definition 24
-storepass password, field description 24
-validity validity_in_days, field

definition 24

A
About Sterling External Authentication

Server 1
Active Directory

assigning mapped credentials 40
Certificate publishing to AD

Enterprise Trust 43
extending the schema 37
mapped credentials 39
viewing certificates published to AD

Enterprise Trust 44
Active Directory Enterprise Trust

certificate publishing 43
create certificate profile 45
viewing certificates published to 44

Active Directory schema 37
Active schema node

adding 38
ADSI Edit Node

adding 39
Allow certificate extension display 147
Application output definition

create 115, 128
create for TAM 132
create LDAP definition 115, 126

Attribute assertion definition
create 140
CV, copy 141
CV, delete 141
defined 7

Attribute query definition
CV, delete 137
defined 7
edit 137
subject verification query

parameters 84
Attributes

specify match 136
Authentication

create TAM definition 131
TAM logging information 131
Tivoli Access Manager 131

Authentication definition
copy TAM 132

Authentication definition (continued)
create application output for

LDAP 115, 126
create for TAM 131
create generic 119
create JAAS 93, 103
create LDAP 114, 125
defined 7
delete 94, 103, 117, 130, 133
edit LDAP 94, 103, 116, 129
elements 8

Authentication interaction diagram 2

B
BasicConstraints extension 149
Boolean operators 148

C
CA-issued certificate

generating to secure connection
between the GUI and server 21

generating to secure the server
connection 20

CA-signed certificate, defined 6
Capturing operational messages 12
Cert variable 144
Certificate

Boolean expression for
extensions 148

create CV definition 83
create revocation lists 84
create self-signed certificate for

GUI 23
define subject verification query

parameters 84
delete validation definition 87
display extension 147
extension variables 148
extension, configure 147
import to server keystore 28
Java class files, specify 88
preconfigure subject parameters 84
system, manage 19

Certificate Authority (CA), defined 6
Certificate chain, defined 6
Certificate issuer, variables 144
Certificate revocation list

deleting 35
Certificate revocation list (CRL) 33

copying 35
creating 33

Certificate Revocation List (CRL) 84
Certificate Revocation List (CRL)

definition, defined 8
Certificate Revocation List (CRL),

defined 6
Certificate signing request

creating PKCS#10 for the GUI 27

Certificate signing request (continued)
creating PKCS#10 for the server 27
parameters to create 27

Certificate signing request (CSR) 26
Certificate Signing Request (CSR),

defined 6
Certificate subject

abbreviated 144
variables 144

Certificate validation (CV) 83
Certificate validation definition

defined 83
Certificate Validation definition

defined 7
Certificate validation definitions 83
Certificate validation steps 2
Certificate validation steps diagram 2
Certificates

generation and usage 19
import into trust store 29
publishing 44

Change
admin password 12
log file size 14
logging level 14
maximum number of archived log

files 14
user definition 157
user role definition 159

Column
delete layout 163
hide 161
manage 161
rearrange 162
rename layout 162
resize 162
restore 161
save layout 162
select layout 162

Configure
access to keystore 30
access to SSL trust store 31
certificate extension 147
custom exit for CV definition 87, 119
non-secure listener 11
secure listener ports 31

Configure EA to Use Windows Active
Directory 71

Configuring logging options 12
Connect, GUI to EA 31
Console, turn logging on or off 13
Copy

CV attribute assertion definition 141
TAM authentication definition 132
user definition 157

create
CRL definition 84

Create
application output definition 115, 128
application output for TAM 132
attribute assertion definition 140

© Copyright IBM Corp. 2005, 2013 169



Create (continued)
CV definition 83
key certificate, using -dname

option 23
self-signed certificate for GUI 23
system certificates 19
Tivoli Access Manager 131
user definition 157
user role definition 158

CRL
copy definition 35
copy definition from CV

definition 35
delete definition 35

CRL Definition
editing 34

CRLDistributionPoints extension 150
CSR (certificate signing request) 26
Custom exit

configure 87, 119
defined 8
Java class files, specify 88
OS command, specify 89, 121
prerequisites 88, 119
redirect standard error 90, 122
redirect standard output 90, 122
timing 89, 121

Custom extension
defined 8
delete for CV definition 86, 87

Customize layout views 161
CV attribute assertion definition

copy 141
delete 141

CV attribute query definition
Delete 137

CV definition
configure custom exit 87, 119
copy CRL 35
edit 86
edit extensions 87
elements 7

D
Definitions

authentication, delete 133
authentication, manage 116
create system-wide connections 15
edit CV extensions 87
roles, change 159
roles, create 158
roles, delete 159
security terms 5
TAM authentication, copy 132
user, change 157
user, copy 157
user, create 157
users 157

Delete
authentication definition 94, 103, 117,

130, 133
certificate validation definition 87
column layout view 163
CRL definition 35
CV attribute assertion definition 141
CV attribute query definition 137

Delete (continued)
CV definition custom extension 86,

87
user role definition 159

Directory object, loginCredentials 127
DirectoryName distribution point 151
Distinguished Name (DN) 144

defined 6
referencing 145

Distribution point
DirectoryName 151
URI 151

Domain node
adding 39

E
Edit

attribute query definition 137
CV definition 86
LDAP authentication definition 94,

103, 116, 129
listener connections 15
port number of servlet container 11
supported CV definition

extensions 87
Enable, SSL trust store 31
Enabled, field definition 31
Expressions

keywords 148
Extension

allow certificate display 147
BasicConstraints 149
CRLDistributionPoints 150
custom expression 147
support mechanism 147
variables 148

F
Field definition

-alias alias_name 24
-dname 24
-genkey 24
-keyalg alg_type 24
-keysize keysize 24
-keystore keystore_path 24
-storepass password 24
-validity validity_in_days 24
enabled 31
IP Address 31
keystore alias 31
keytool 24
port 31
trust store file 31

Field definition, trust store password 31
File naming guidelines 5

G
Generic authentication definition,

create 119
GUI

administration and navigation 5
change logging level 13
connect to server 31

GUI (continued)
create self-signed certificate 23
refresh lists 15

H
Hide

columns 161

I
Import

CA certificate to GUI keystore 28
CA certificate to server keystore 28

Import CA-issued certificate into keystore
parameters 29

Import certificates into trust store 29
Importing certificate into GUI trust

store 30
Importing certificate into Sterling

External Authentication Server trust
store 29

Interaction with Sterling Secure Proxy
and Sterling Connect:Direct Secure Plus
Option 4

IP Address, field definition 31

J
JAAS

create authentication definition 93,
103

Java
class files for custom exit 88
JNDI properties, specify 136

K
Kerberos API

configuring 17
Keystore

configure access 30
defined 6, 27

Keystore alias field definition 31
keytool, field definition 24
KeyUsage extension

extension
KeyUsage 149

L
Layout, select column 162
LDAP

create application output 115, 126
create authentication definition 114,

125
defined 7

Listener connection
change settings 15

Listener port
disabling non-secure 11

Listener ports
configure secure 31

Log
change logging level 14

170 Sterling External Authentication Server: Implementation Guide



Log (continued)
change maximum number of archived

files 14
change maximum size 14
turn on or off to console 13

loginCredentials
create directory object 127
store SSH keys in directory 111

loginCredentials Class
adding superior 38

Logs
change logging level from GUI 13

M
Manage

system certificates 19
Match attributes

specify 136

N
Non-secure listener

configure 11

O
Object identifiers (OID) 85
OID

object identifiers 85
Operation 2
OS command

for custom exit, specify 89, 121

P
Parameters

define for Subject Verification
Query 84

import certificate into trust store 30
Password

change for admin 12
Password policy

associating with a user 74
PKCS#10 certificate signing request

creating for the GUI 27
creating for the server 27

Port, field definition 31
Prerequisites

secure connection 9
Principal, defined 7
Private key, defined 6
Public key, defined 6
Publishing certificates 44

Q
Query parameters

specify for LDAP 135, 136

R
Rearrange

columns 162

Redirect
standard error 90, 122
standard output 90, 122

Reference, DN attributes 145
Refresh GUI lists from the server 15
Relative Distinguished Name (RDN) 145
Rename

column layout 162
Replace, self-signed keystore 28
Resize

columns 162
Restore columns 161
Roles

manage 158
parameters 158

S
Save column layout 162
sci.schema 115, 126
Secure connection listener

configure 31
Secure connection prerequisites 9
Security terms, defined 5
Self-signed certificate

export commands 26
exporting 25
exporting for the server 25
generating 22
generating for server 22
generating to secure connection

between the GUI and server 21
generating to secure the server

connection 19
GUI 25

Self-signed certificate defined 5
Service principal definitions 71
Servlet container

port number, edit 11
Session key, defined 6
Simple Authentication, defined 5
SSH key

schema to store 111
SSH key authentication profile

creation 42
SSH public keys

assignment 42
SSH public keys creation 41
sshPublicKey attribute

adding to the User Class 38
SSL keystore

defined 30
SSL trust store

enable access 31
Subject verification query

define parameters 84
Supported extensions, defined 8
Syntax

variables 143

T
TAM

authentication 131
copy authentication definition 132
create authentication definition 131

TAM (continued)
logging information 131
output, specify 132

Timing
custom exit, specify 89, 121

Tivoli Access Manager (TAM)
Application output, create 132
authentication 131
authentication definition, create 131
create 131
logging information 131

Trust store
importing certificate into GUI 30
importing certificate into Sterling

External Authentication Server 29
parameters to import into trust

store 30
Trust store file, parameter definition 31
Trust Store password

parameter definition 31
Trust store, defined 6
Trusted root key defined 6

U
URI distribution point 151
User

change definition 157
change role definition 159
copy definition 157
create definition 157
definitions 157
definitions parameters 157
delete role definition 159
roles, create 158

User authentication and authorization 2
User authentication profile

creating 41

V
Validation request

supported variables 143
Variables

cert 144
certificate validation 143
certificate validation definitions 144
syntax 143

View
customizing display 161
delete column layout 163
rearrange column 162
rename column layout 162
resize column 162
restore column 161

W
Window display

Customize 161
delete column layout 163
hide columns 161
Manage columns 161
rearrange columns 162
rename column layout 162
resize columns 162

Index 171



Window display (continued)
restore columns 161
save column layout 162
select column layout 162

Windows Active Directory
configure Sterling External

Authentication Server 37

X
X.509 v2 147

172 Sterling External Authentication Server: Implementation Guide





����

Product Number: 5725-D03

Printed in USA


	Contents
	Chapter 1. About Sterling External Authentication Server
	Sterling External Authentication Server Operation
	Certificate Validation Steps
	User Authentication and Authorization Steps

	Interaction with Sterling Secure Proxy and Sterling Connect:Direct Secure Plus
	Definition Configuration with the Sterling External Authentication Server GUI
	File Naming Guidelines
	Administration and Navigation from the GUI

	Security Terms
	Elements of CV Definitions
	Elements of Authentication Definitions

	Prerequisite Tasks for Secure Connection Establishment
	Tasks Required for CA-Issued Certificate Usage
	Tasks Required for Self-Signed Certificate Usage


	Chapter 2. System Resources Configuration
	Configure a Listener Port
	Modifying the Non-Secure Listener Port
	Disabling the Non-Secure Listener Port

	Changing the Port Number of the Servlet Container
	Changing the Admin Password
	Logging Options Configuration
	Changing the Logging Level from the GUI
	Turning Logging to the Console On or Off
	Changing the Log File Size
	Changing the Number of Archive Log Files
	Changing the Logging Level in a Logging Properties File

	Refreshing the GUI List from the Server
	Setting Listener Connection Settings (Backlog and Timeout)
	Creating a System-Wide LDAP or HTTP Connection Definition
	Configuring the Kerberos API

	Chapter 3. System Certificate Creation and Management
	Certificate Generation and Usage
	Procedures to Generate a Self-Signed Certificate to Secure the Sterling External Authentication Server Connection
	Procedures to Generate a CA-Issued Certificate to Secure the Connection to Sterling External Authentication Server
	Procedures to Generate a Self-Signed Certificate for the Connection between the GUI and the Sterling External Authentication 
	Procedures to Generate a CA Certificate to Secure the Connection between the GUI and Sterling External Authentication Server

	Self-Signed Certificate Generation
	Generating a Self-Signed Certificate for the Sterling External Authentication Server
	Generating a Self-Signed Certificate for the GUI
	Parameters to Generate a Self-Signed Certificate

	Export a Self-Signed Certificate
	Exporting a Self-Signed Certificate for the Sterling External Authentication Server
	Exporting a Self-Signed Certificate for the GUI
	Commands to Export a Self-Signed Certificate

	Creation of a Certificate Signing Request
	Creating a PKCS#10 Certificate Signing Request for the Server
	Creating a PKCS#10 Certificate Signing Request for the GUI to Submit to a CA
	Parameters to Create a CSR

	Import of the CA-Issued Certificate Keystore
	Importing the CA-Issued Certificate into the Server Keystore
	Importing the CA-Issued Certificate to the GUI Keystore
	Parameters to Import the CA-Issued Certificate into the Keystore

	Import Certificates into the Trust Store
	Importing a Certificate into the Sterling External Authentication Server Trust Store
	Importing the Server Certificate into the GUI Trust Store
	Parameters to Import the Certificate into the Trust Store

	Configuring Sterling External Authentication Server to Access the SSL Keystore
	Configuring Sterling External Authentication Server to Access the SSL Trust Store
	Configuring the Secure Connection Listener

	Configuring SSL or TLS Between the GUI and the Sterling External Authentication Server

	Chapter 4. Creation and Management of Certificate Revocation List (CRL) Definitions
	Creating a CRL Definition
	Editing a CRL Definition
	Copying a CRL Definition
	Deleting a CRL Definition from the Manage Menu

	Chapter 5. Configuration of Active Directory to Prepare for Use with Sterling External Authentication Server
	The Active Directory Schema
	Extending Schema for Active Directory
	Adding an Active Schema Node
	Adding the sshPublicKey Attribute to the User Class
	Adding superior to the loginCredentials Class

	Adding the ADSI Edit Node
	Adding the Domain Node
	Mapped Credentials in Active Directory Setup
	Assigning Mapped Credentials in Active Directory
	Creation of a User Authentication Profile in Sterling External Authentication Server

	SSH Public Keys Creation
	Assignment of SSH Public Keys
	SSH Key Authentication Profile Creation

	Validating Certificates Stored in Active Directory
	Certificate Publishing to the Active Directory Enterprise Trust
	Publishing Certificates
	Viewing Certificates Published to Active Directory Enterprise Trust
	Creation of an Sterling External Authentication Server Certificate Profile to Validate Certificates in the AD Enterprise Trus
	Assigning Users to a Partner Certificate in the AD Enterprise Trust
	Creation of a Profile on Sterling External Authentication Server to Authenticate a User ID with Certificate in Enterprise Tru

	Validation of Certificates Issued by Windows Certificate Service Web Site
	Viewing Certificates Issued by Windows Certificate Service Web Site
	Creation of a Profile in Sterling External Authentication Server to Validate Certificates Issued by a Certificate Service Web
	Creation of a Profile in Sterling External Authentication Server to Authenticate a User ID with a Certificate in the AD User 

	Assurance that Only Authorized Users Can Access a Service
	Creating a Container for Service Groups
	Adding a User ID to a User Group for a Service in Active Directory
	Addition of a Query to an Sterling External Authentication Server Authentication Profile to Validate the User ID and Service

	Allowed IP Addresses Check
	Creating a Container for Allowed Hosts in AD
	Adding an IP Address to an Allowed Hosts Container in AD
	Addition of a Query to a Sterling External Authentication Server Profile to Check for Allowed IP Addresses
	Adding ipHost as an Auxiliary Class to the User Class
	Assigning an IP Address to a User
	Addition of a Query to the User Authentication Profile to Validate an IP Address and User ID

	Verification that a Certificate Is Associated with an IP Address
	Creating a Container for Host Groups in AD
	Adding an IP Address to a Host Group in Active Directory
	Addition of a Query to Validate an IP Address and Certificate

	Authentication to Check for a Valid IP Address and an Associated SSH Key
	Creating a Container for SSH Public Keys in AD
	Adding an ldapPublicKey to the groupOfUniqueNames Class as an Auxiliary Class
	Adding an IP Address and SSH Public Key to a Group in Active Directory
	Query to an SSH Key Authentication Profile to Validate the IP address and SSH Public Key

	Service Principal Definitions for a Change Password Definition
	About Changed Password
	Delegation of Control
	Creating a Service Account
	Delegating Control of the Sterling External Authentication Server Service Account

	Configuring a Password Policy in Active Directory 2003 and 2008
	Fine-Grained Password Policy Configuration in AD 2008
	Raising the Domain Controller Functional Level to Microsoft Windows 2008
	Creating a Fine-grained Password Policy

	Assigning a Password Policy to a User or Global Security Group

	Chapter 6. Tivoli Configuration to Allow a User to Change a Password in Sterling External Authentication Server
	Service Principal Definitions for a Change Password Definition
	IBM Tivoli 6.x Password Policy Configuration
	Enabling Group and Individual Password Policies in Tivoli Version 6.x
	Configuring the Global Password Policy in Tivoli Version 6.
	Giving Users Access to LDAP Attributes in Tivoli Version 6.x
	Creating a Group or Individual Password Policy in Tivoli Version 6.x
	Associating a Password Policy with a User
	Associating a Group Password Policy with a Group


	Chapter 7. Import of Sterling Connect:Enterprise Users into Microsoft Active Directory
	Sterling Connect:Enterprise for UNIX Import Tool Configuration

	Chapter 8. Import of Users from Sterling Connect:Enterprise for UNIX
	Adding Users from the Sterling Connect:Enterprise for UNIX Migration Tool
	Adding or Updating Users from a Spreadsheet
	Import of Users from Sterling Connect:Enterprise for UNIX

	Chapter 9. Sterling Connect:Enterprise for UNIX Data to Sterling B2B Integrator or Sterling File Gateway Migration
	Chapter 10. Creation and Management of Certificate Validation (CV) Definitions to Validate Certificates
	Creating a CV Definition
	Specifying Certificate Subject Verification for an Attribute Query
	Referencing a CRL Definition
	Configuring a Supported Extension for a CV Definition
	Custom Extension for a CV Definition Configuration
	Creating a Custom Extension
	Editing Custom Extensions in a CV Definition
	Deleting a Custom Extension in a CV Definition

	Editing or Copying a CV Definition
	Deleting a Certificate Validation Definition
	Managing Supported Extensions in a CV Definition
	Editing Supported Extensions in a CV Definition
	Deleting a Supported Extension in a CV Definition

	Configuration and Testing of a Custom Exit for a CV Definition
	Prerequisites for Using a Custom Exit
	Development and Deployment of a Custom Exit Class in Java
	Specifying Java Class in a CV Definition
	Specifying an Operating System Command for a CV Definition Custom Exit

	Create a Sterling External Authentication Server Certificate Validation Definition for Active Directory

	Chapter 11. RSA Authentication Definition Creation
	Configuring Sterling External Authentication Server Support for RSA SecurID
	Creating an RSA Authentication Definition
	Editing or Copying an Authentication Definition
	Deleting an Authentication Definition

	Chapter 12. Authentication Definition for Other 3rd Party Token Providers
	Chapter 13. Configure Sterling External Authentication Server for FIPS Mode
	Chapter 14. JAAS Authentication Definition Configuration
	JAAS Configuration File Modification for RSA SecurID
	JAAS Configuration File Modification for LDAP
	Implementing Your Own LDAP Module in Sterling External Authentication Server
	RSA SecurID Properties File Modifications
	Creating JAAS Authentication Definitions
	Editing or Copying a JAAS Authentication Definition
	Deleting an Authentication Definition

	Chapter 15. Sterling B2B Integrator User Authentication through an Sterling External Authentication Server Custom Exit
	Certificate Preparation for Authentication in the Sterling B2B Integrator User Store
	Configuring the HTTP Server Adapter Certificate
	Exporting the System Certificate from Sterling B2B Integrator
	HTTP Server Adapter System Certificate Import into the Sterling External Authentication Server Trust Store
	Sterling External Authentication Server Keystore Export
	Importing the Sterling External Authentication Server System Certificate into the Sterling B2B Integrator CA Certificate Stor

	Configuring a Sterling B2B Integrator HTTP Server Adapter for Sterling External Authentication Server Support
	Configuring an Sterling External Authentication Server User Authentication Profile
	Custom Exit Configuration Properties

	Log Messages
	Sterling Secure Proxy Messages
	Sterling External Authentication Server Messages
	Sterling B2B Integrator Authentication Log Messages


	Chapter 16. Creation and Management of SSH Key Authentication and Mapping Definitions
	OpenLDAP or IBM Tivoli Preparation to Store Keys, User IDs, and Passwords for an SSH User
	Implementing the SSH and SCI Schemas for Open LDAP
	Implementing the SSH and SCI Schemas for IBM Tivoli
	Entries for SSH Public Key in the LDAP Server
	Login Credential Creation in the LDAP Server
	LDIF Entry Example for SSH

	Creating an SSH Key Authentication Definition
	SSH Application Output Definition Creation
	Creating an Application Output Definition for the loginCredentials (sterling) Definition
	Creating an Application Output Definition for the loginCredentials (custom) Definition

	Editing or Copying an SSH Key Authentication Definition
	Deleting an SSH Key Authentication Definition

	Chapter 17. Generic Authentication Definitions
	Creating a Generic Authentication Definition
	Custom Exit Configuration and Test for a Generic Authentication
	Prerequisites for Using a Custom Exit

	Custom Exit Class Development and Deployment in Java
	Specifying a Java Class for a Custom Exit in a Generic Authentication Definition
	Specifying an Operating System Command for a Custom Exit

	Application Output Definition for a Generic Authentication Definition

	Chapter 18. Creation and Management of LDAP Authentication Definitions
	Creating an LDAP Authentication Definition
	User Authentication Profile Creation in Sterling External Authentication Server
	Application Outputs Definition Creation for an LDAP Authentication Definition
	Directory Preparation for Use with Lookup Login Credentials
	Extending the Schema for OpenLDAP
	Extending the Schema for IBM Tivoli Directory Server
	Entry Creation for Login Credentials
	LDIF Entry Example for LDAP

	Mapping Query Return Attributes to Application Output Names in an Application Outputs Definition
	Editing or Copying an LDAP Authentication Definition
	Deleting an Authentication Definition

	Chapter 19. Creation and Management of Tivoli Access Manager (TAM) Authentication Definitions
	Tivoli Access Manager Authentication
	Prerequisites for Tivoli Access Manager Authentication
	Log Information for Tivoli Access Manager Authentication

	Creating a Tivoli Access Manager Authentication Definition
	Creating an Application Output Definition for TAM
	Editing or Copying a TAM Authentication Definition
	Deleting an Authentication Definition

	Chapter 20. Creation and Management of Attribute Queries and Assertions
	Attribute Query Definition
	Creating an Attribute Query Definition
	Specifying Query Parameters
	Specifying Match Attributes
	Specifying JNDI Properties for a Connection
	Editing or Copying an Attribute Query Definition
	Deleting an Attribute Query Definition

	Query to Check for Allowed IP Addresses
	User Authentication Profile Query to Validate an IP Address and User ID
	Query to Validate an IP Address and Certificate
	Sterling External Authentication Server Authentication Profile Query to Validate the User ID and Service
	Attribute Assertion Definition
	Creating an Attribute Assertion Definition
	Editing an Attribute Assertion Definition
	Copying a CV Attribute Assertion Definition
	Deleting a CV Attribute Assertion Definition


	Chapter 21. CV and Authentication Definition Variables
	Syntax and Rules
	Cert Variable Reference in an Attribute Assertion
	Variables for Certificate Subject and Certificate Issuer
	Abbreviated Notation Usage for Subject
	Variables for Distinguished Name
	Reference to Distinguished Name Attributes with Multiple Occurrences
	Reference to a Relative Distinguished Name with a Multi-Valued Attribute


	Chapter 22. X.509 Extensions
	X.509 Extensions and RFC 3280
	Allow and Require Settings
	Boolean Expressions for Extension Properties
	Trivial Expressions: Keywords True and False
	Boolean Operators
	Extension Variables

	KeyUsage Extension
	BasicConstraints Extension
	CRLDistributionPoints Extension
	Properties
	Distribution Point Formats
	DirectoryName Distribution Points
	URI Distribution Points

	Conditions for Using Variables with the CRLDistributionsPoints Extension
	The CrlDistributionPoints Variable
	Example of Multiple CRL Definitions
	Example of Distribution Point Variables

	Custom Extensions

	Chapter 23. Management of Users and Roles
	User Management
	Creating a User Definition
	Changing a User Definition
	Deleting a User Definition

	Role Management
	Creating a Role Definition
	Changing a Role Definition
	Deleting a Role Definition


	Chapter 24. Customization of Layout Views
	Hiding Columns
	Restoring Columns
	Managing Columns
	Column Rearrangement and Resizing
	Saving a Column Layout
	Selecting a Column Layout View
	Column Layout View Management
	Renaming a Column Layout View
	Deleting a Column Layout View


	Notices
	Index
	Special characters
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X


